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CHAPTER 1

Introduction

Alink is a feature that points to additional information from a specific area in a topic. The link may
open information in the same topic, a different topic, or even a file outside of the project altogether.
With print-based output the link can electronically open the destination if the user is viewing the
manual online, depending on the type of output you create (e.g., PDF, Word). In addition, cross-
reference links can be customized to refer to specific content and page numbers in the printed
manual (e.g., See "My Topic" on page 32).

Types of Links

® "Bookmarks" on page 11

® "Concepts” on page 20

® "Cross-References" on page 55
® "Drop-Downs" on page 92

® "Expanding Text" on page 104

"External Links—HTML, PDF, Microsoft Office" on page 113

"Inserting Image Hyperlinks" on page 120

"Inserting Keyword Links" on page 149
® "l inks to Web Topics" on page 156

"Named Destinations" on page 161

"Related Topics Links" on page 172

"Relationship Tables and Links" on page 191

® ‘Inserting Shortcut Controls" on page 233
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"Text Hyperlinks" on page 236

® "Inserting Text Popups" on page 254
® "Togglers" on page 257

® "Toolbars" on page 265

® “Inserting Topic Popups" on page 363

(D WARNING It is recommended that you avoid creating links to snippets. This is primarily
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the

heading in that snippet. But which of those 12 topics is it supposed to point to in the

undesirable results. For this reason, it's a good idea not to link to any content in a snippet.

due to the nature of snippets, which are designed to be inserted into multiple files. Let's say

output? There is no way for Flare Desktop to know this, so you could end up with some very

CHAPTER1

10



CHAPTER 2

Bookmarks

A bookmark is a marker, or flag, that lets you create hyperlinks to specific locations within topics
(rather than to another topic file in general). You can insert a bookmark at a specific location in your
topic (e.g., at a subheading) and then insert a hyperlink that "connects" to that bookmark. This is a
useful feature, for example, if you have a somewhat lengthy topic and want the user to be able to
locate a specific place in the topic quickly.

This chapter discusses the following:

Inserting Bookmarks ... 12
Renaming Bookmarks ... 14
Deleting Bookmarks ... 15
Hiding and Showing Bookmark Names ... 16
Viewing Broken Bookmarks ... 17
Viewing Broken LinkKs ... 18
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I Inserting Bookmarks

Supported In:

HTML
M5
PDF ECLIPSE HTML
HELP HELP

The main task involved with bookmarks is inserting them.

How to Insert a Bookmark

WEB
HELP

PPTX

1. Click in the topic where you want to insert a bookmark (e.g., in front of a subheading or a

specific paragraph).

2. Select Insert > Bookmark.

3. Inthe New bookmark field, type a name for your bookmark (do not use spaces).

¢ EXAMPLE If the bookmark is being placed at the beginning of a bulleted list of
product features, you might type ProductFeatures as the bookmark name.

4. Click Add. A bookmark icon[Z] and the name of the bookmark are displayed at the
appropriate location in the topic (as long as your markers are turned on). You can hide the

bookmark name if you want.

5. CIicklE' to save your work.

6. Now you can insert a cross-reference or another kind of hyperlink elsewhere in this topic orin

another topic that links to this bookmark.

CHAPTER 2
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NOTE You can also move an existing bookmark to a new location in the topic. To do this,
place your cursor in the topic where you want the bookmark to be moved. Select Insert >
Bookmark. In the Manage Bookmarks dialog, select the existing bookmark that you want to
move (instead of typing the name of a new bookmark). Then click Move.

NOTE When you insert anchor tags (i.e., bookmarks) in your project, the name attribute is
used in those locations. There is an option in the Advanced tab of the Target Editor for
HTMLS5 to use IDs on anchor tags such as these. This option copies existing anchor name
attributes to ID attributes.

CHAPTER 2 13



| Renaming Bookmarks

If you want to rename one of the bookmarks that you have inserted in a content file (e.g., topic,
snippet), you can easily change the name.

How to Rename a Bookmark

1. Open the content file.

2. Right-click the bookmark, and from the context menu select Rename Bookmark. The Manage
Bookmarks dialog opens, with the bookmarks in that topic listed.

3. Select the bookmark that you want to rename.
4. In the New bookmark field, type a new name for the bookmark.

5. Click Rename. This changes the bookmark name in the topic.

6. Click [l to save your work.
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| Deleting Bookmarks

If you inserted a bookmark and no longer need it, you can permanently remove it.

How to Delete a Bookmark

1. Open the content file.

2. Right-click the bookmark to remove and select Delete from the context menu.

3. CIicklE' to save your work.

CHAPTER 2
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I Hiding and Showing Bookmark Names

When you insert a bookmark into a content file (e.g., topic, snippet), both the bookmark icon @ and
the bookmark name display on screen. You can show or hide the bookmark name from your screen
display. When hidden, the screen displays shows only the bookmark icon at the insertion point.

How to Hide or Show Bookmark Names

1. Open the content file.

2. Onthe local toolbar of the XML Editor, click the down arrow of the Show tags button .
Then select Show Bookmark Names to add or remove the check mark next to it.

CHAPTER 2 16



I Viewing Broken Bookmarks

You can view a list of files with broken bookmarks, including the bookmark destination that the link
is trying to find, the link text, the link tag, and other information. Also, you can open the file where
the broken link is located so that you can fix it.

How to View and Fix Broken Bookmarks

1. Open a content file (e.g., topic).
2. Select Analysis > Links > Broken Bookmarks.

The Broken Bookmarks window pane opens. The area at the bottom of the window pane
displays all files that contain bookmark links to the open file that are broken.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

® File Displays the name of the file where the broken link occurs.

® Folder Displays the folder where the file is found.

® | ink Displays the link that is broken (e.g., the path and name of the topic in question).
® Type Displays the type of broken link (e.g., missing file).

® Link Text Displays the text in the source topic that is being used as the link.

® Link Tag Displays the style used for the link. For example, if a regular text hyperlink is

(]

used, you will see "a" in this column.
® Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or
dialog. For example, if the link appears in a topic, the XML Editor opens with the broken link
highlighted.

6. Redirect the link as necessary (e.g., right-click on the link and select Edit Hyperlink or Edit
Cross-Reference).
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| Viewing Broken Links

You can view a list of files in your project where a broken link is located, including which file it is
trying to find, the link text, the link tag, and other information. Also, you can open the file where the
broken link is located. The broken link is highlighted so that you can easily fix it.

How to View and Fix Broken Links

1. From the Analysis ribbon, click the Summary button.

File Home  Insert  View
PES 5 2| R
J e In ¥ =
Summary Links Suggestions Undefined Used Mare File
@ o ltems *  ltems » Reports~  lssues
Dynamic Reports Analysis

If you see a row indicating broken links in red, double-click it.
In the grid listing all broken links, double-click one.

In the file that opens, the broken link is highlighted.

a N

Edit the broken link or remove it.

6. Click@ to save your work.
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How to Fix Links Directly in the Broken Links
Window Pane

1. Inthe Broken Links window pane, click the row that you want to correct, then CIick. The Fix
Broken Links dialog opens.

2. Inthe Fix Broken Links dialog, do one of the following.

u Click or right-click a file and from the context menu, select Select file for linking. This
option opens a dialog, from which you can select a new link.

= Click 5@l or right-click a file and from the context menu, select Scan for Potential Links.
This option scans the project for potential matches to the broken link. When this option
is selected, the Search for Similar Files dialog opens, which lists the similar files that
the analysis tool has found. You can then select a file from that list.

The name of the file you select to fix the broken link will be displayed in the File field at the
bottom of the Fix Broken Links dialog.

3. Click Apply.
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CHAPTER 3

Concepts

Supported In:

HTML
MS
ECLIPSE
E PDF WORD HALP EPUB II-II-E:‘}I'_

A concept is a marker that you can insert into related topic files in order to “tie them together.”

This chapter discusses the following:

CHAPTER 3

Concept Link Example ... 21
AddiNg CONCEPTS oo 26
Assigning Topics to Concepts ... 27
INSErting CONCEPTS .. 30
Inserting Concept LiNKS ... 36
Editing CONCEPTS oo 39
Editing Concept Links ... 41
Creating a List of CONCEPTS ... 48
Editing the Look of a List of Concepts ... 50
Deleting CONCEPTS .o 53
Deleting Concept Links ... 54
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| Concept Link Example

The following example is designed to help make the idea of concept links clearer and guide you
through the steps for creating your own concept links.

Scenario

Let's say we have a Flare project called "Pets." In this project, we have dozens of topics about all
kinds of animals (cats, dogs, parrots, hamsters, and so on). We have written five topics about dogs.

Choosing a Dog
Feeding a Dog
Training a Dog
Grooming a Dog

Walking a Dog

Because these five topics all have something in common (i.e., they're all about dogs), we want to
include a link at the bottom of each of those five topics that lets users quickly jump to any of the
other "dog" topics.
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Step 1—Create and Insert a Concept

First, we need to create a concept to tie these five topics together. We can create a concept with
any name that we want, but it helps to name the keyword something that is obvious and all topics

have in common. Therefore, we'll give our concept the name "dogs."

1. Open any of the five topics. In this example, we'll open the topic "Choosing a Dog."

2. Click in the location in the topic where you want to insert the concept. Typically, you'll insert

the concept somewhere near the top of the topic. In our example, we will click right before our

topic title "Choosing a Dog."

3. Select View > Concept Window or press SHIFT+F9 on your keyboard. The Concept window

pane opens.

4. The cursor should already be placed in the Terms cell. If not, click in that cell. Type Dogs and

press ENTER. A concept marker labeled "Dogs" is added before the topic title. If you cannot

see the marker, turn your markers on by clicking the down arrow next to the Show tags button
in the XML Editor. Then select Show Markers.

= Choosing_a Dog.htm LR B — Concepts v I x
B Choosing_a_Dog.htm = Start Page % "8 T

4 = | % Layout (Web) ~ Medium (default) ~ Pagel )
Here is the

concept
keyword marker.

h2

Dog Dogs Choosing a Dog

choosing a dog, some important this to consider

include:

animal-oriented websites provide dog breed

» [Use an Online Dog Breed Selectorj Many

This is where we explain how to choose a dog. When

Enter Concepts:

Terms

»

o8 Concepts
Cats
v Dogs

“* Animals/Dogs/Choosing_a_Dog.htm
o oa - v o

CHAPTER 3
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Step 2—Copy and Paste the Concept Marker
Into All Relevant Topics

Next, we need to place the same concept in our other four "dog" topics. We could repeat the same
steps above for each topic, but we'll copy and paste our first concept marker instead.

1. Inthe "Choosing a Dog" topic, right-click on the concept marker and choose Copy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Click in front of the topic
title (or somewhere near the top of the topic), and press CTRL+V on your keyboard.

Repeat this until you've pasted the concept marker into all five of the "dog" topics.

3. CIick to save all files.

CHAPTER 3

23



Step 3—Insert a Concept Link

Now that we have the concepts in place, we can insert a concept link into each of the five "dog"

topics. This is the link that users will see and click in the output. They will not see the concepts that
we created at the top of each topic (those are simply markers).

1. In one of the "dog" topics, place your cursor at the end of the last piece of content (e.g., after
the final paragraph). Then press ENTER to create a new paragraph.

2. Select Insert > Concept Link (A-link). The Insert Concept Link Control dialog opens. The
"Dogs" concept that we inserted is listed on the right side of the dialog.

3. Inthe All Concepts section, double-click Dogs. This concept is now listed in the "Selected

Concepts" section on the left.

4. Click OK. The concept link is added to the topic.

ha

= (Choosing_a_Dog.htm * 0 ox
‘| Choosing_a_Doghtm Start Page x '
g - § Layout (Web) - Medium (default) ~ Page Layout ?_:J = (=] - b8 -

41

Dog Dogs Choosing a Dog

This is where we explain how to choose a dog. When
choosing a dog, some important this to consider
include:

» [Use an Online Dog Breed Selectorj Many

animal-oriented websites provide dog breed
selectors where you can answer questions about
your lifgktyle. This is a good place to start.

See Also

= Concepts

Terms

Enter Concepts:

Terms

W

2@ Concepts

Cats

Dogs

“® Animals/Dags/Choosing_a_Daog.htm
@ Animals/Dogs/Dogs.htm

‘@ Animals/Degs/Grooming_a_Dog.htm
“® Animals/Dags/Training_a_Dag.htm
@ Animals/Dogs/Walking_a_Deg.htm
‘@ Animals/Degs/Feeding_a_Dog.htm
Harnsters
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Step 4—Copy and Paste the Concept Link Into
All Relevant Topics

Finally, we need to place the same concept link in our other four "dog" topics. We could repeat the
same steps above for each topic, but we'll copy and paste our first concept link instead.

1. Inthe topic where the first link has been inserted, right-click on the concept link and choose
Copy.

2. Open another "dog" topic ("Feeding a Dog," "Training a Dog," etc.). Place your cursor at the end
of the last piece of content (e.g., after the final paragraph). Then press ENTER to create a new
paragraph.

3. Press CTRL+V on your keyboard.

Repeat this until you've pasted the concept link into all five of the "dog" topics.

4. CIick to save all files.
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I Adding Concepts

You can use the bottom area of the Concept window pane to add concepts and assign topics to
them. The major benefit of this method is that it is an easy and quick way to place the same
concept marker at the beginning of multiple topics and maintain better consistency.

How to Add a Concept

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter|:| between them and drag it up or down.

2. Inthe explorer area at the bottom of the window pane, right-click on Concepts and from the
context menu select Add Concept.

3. Type the concept keyword and press ENTER.
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| Assigning Topics to Concepts

After you add concepts in the Concept window pane, you can assign topics to them. There are two
methods for doing this.

How to Assign Topics to a Concept—Context
Menu in Concept Window Pane

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.

® Keyboard Shortcut Press SHIFT+F9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.
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2. Right-click on the concept and from the context menu select Assign Topic.

Terms
*

o[@ Concepts After right-clicking on the
=L keyword, select Assign
b Rename Concep Topic from the context
...... menu.

- Assign Topic

3. Inthe dialog that opens, find and select the topic(s). If you want to select multiple items, click
the Show Files button then hold the SHIFT key to select a range or hold the CTRL key to
select individual items.

4. In the dialog, click Close.

Paths to the selected topics are displayed in the Concept window pane after the keyword.
And a concept marker is added at the beginning of each topic.
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How to Assign Topics to a Concept—Drag From
Content Explorer

1.
2.

CHAPTER 3

Open the Content Explorer.

Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.

In the local toolbar of the Content Explorer, click the Show Files button . The window
pane splits into left and right halves.

In the left half of the Content Explorer, click the folder holding the topics that you want to
assign to a concept.

In the right half of the Content Explorer, select the topics. You can hold the SHIFT key to
select a range, or you can hold the CTRL key to select individual items.

Drag the selected topics and drop them on the concept keyword that is displayed the bottom
(explorer) portion of the Concept window pane.

Paths to the selected topics are displayed in the Concept window pane after the keyword.
And a concept marker is added at the beginning of each topic.

29



I Inserting Concepts

You can open a topic and use the top area of the Concept window pane to insert concepts into that
file.

Drag-and-Drop Method
Use this method to quickly insert a concept that already exists in your project.

® Advantage It is extremely fast.

® Disadvantage The concept that you want to insert must already exist in the project. This
means you must first insert the concept into a topic using one of the other methods.
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How to Insert a Concept Using the Drag-and-Drop
Method

1. Open the content file.

2. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.

3. Inthe bottom (explorer) area of the Concept window pane, click the concept and drag it to the
location in the topic where you want to insert it. As you drag the concept into the topic, a
vertical red bar acts as a guide to help you place the concept in the topic. The concept is
displayed within a marker in front of the word where you added it (as long as markers are
turned on). A marker can hold multiple concepts, but most times you only need one concept

per marker.
hisisa t Concept Keywords
marker holding concep pLREYW
a concept At the top of this topic, a Concept keyword has been
keyword inserted in front of the title "Concept Keywords."

4. Click[&l to save your work.
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Concept Window Pane Method

Use this method to insert a concept in the Concept window pane.

® Advantage It lets you continue to perform other tasks in the topic without having to "switch
modes."

® Disadvantage It is not quite as fast as the other methods.

How to Insert a Concept Using the Concept Window
Pane Method
1. Open the content file.
2. Click at the location where you want to insert a concept.
3. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens.

This is the Concepts | Terms
window pane. Enter Concepts:
Terms
»
*

You can click and drag this
splitter up or down as

necessary to see more of
the terms in the upper >
portion or the explorer

section at the bottom of the
window pane. o Concepts
[ | Contacting

Procedures
F- | WhatsMew

4. Click in an empty field in the Terms column.
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5. Type the concept as you want it to appear.

Press ENTER. The concept is displayed within a marker in front of the word where you added

it (as long as markers are turned on). A marker can hold multiple concepts, but most times
you only need one keyword per topic.

mangt:glging concept Concept Keywords
a concept At the top of this topic, a Concept keyword has been
keyword inserted in front of the title "Concept Keywords."

7. Click[&ll to save your work.
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Concept Entry Mode Method

Use this method to accomplish the same thing as the Concept window pane method. The
difference is that, with this method, you do not need to move your cursor from the topic to the
Concept window pane. You simply click at the spot in the text where you want to insert the keyword
and start typing. The words you type are added directly into the Concept window pane. This is a
good method to use if you plan to create concepts in a lot of topics all at once, without performing
any other tasks in the topic.

® Advantage It is extremely fast.

® Disadvantage If you are adding a concept as you work on a topic, you need to remember to
switch off the Concept Entry Mode so that you can return to editing your topic.

How to Insert a Concept Using the Concept Entry Mode
Method
1. Open the content file.

2. Inthelocal toolbar of the XML Editor click.

This small "c" indicates
that you are in Concept
Entry Mode.

—_—

my concept Concept Keywor g

At the top of this topic, a Concept keyword has been
inserted in front of the title "Concept Keywords."

3. Click at the place in your topic where you want to add a concept.
4. Type the phrase that you want to add as the concept.

As you start typing, the Concept window pane opens (if it was not previously opened), and the
phrase is added to the first empty field under the Terms column.
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NOTE As you type in the Concept window pane, notice that the cursor does not lose
focus in the XML Editor. It merely turns gray so that you know for certain where you
are adding the concept. When you return to the XML Editor, the cursor returns to its

previous state.

5. Press ENTER. The concept is displayed within a marker in front of the word where you added
it (as long as markers are turned on). A marker can hold multiple concepts, but most times

you only need one keyword per topic.

mangt:glging concept Concept Keywords
a concept At the top of this topic, a Concept keyword has been
keyword inserted in front of the title "Concept Keywords."

6. If you want to add more concepts in the topic, repeat steps 3-5.

7. CIicklE' to save your work.
To turn off the Concept Entry Mode and return to regular editing, you can Click again.

What's Noteworthy?

NOTE If you want to see all of the concepts that you have inserted in your project, they are
displayed in the bottom portion of the Concept window pane.
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I Inserting Concept Links

After you create concepts keywords, you can insert concept (or See Also) links.

A concept link is a Help control that lets users open topics that you've determined are related to the
current topic. It is similar to the related topics link. However, whereas you associate a related topics
link with specific individual topics (usually for a one-time use), you associate a concept link with a
group of topics (to be reused in different topics). One great benefit of this type of link is that, if you
later want to add or delete topics from the group, you only need to do so in one place and the
changes are applied to every topic containing that concept link.

How to Insert a Concept Link

1.
2.
3.

Insert concepts into the appropriate topics.
Open the content file.

In the XML Editor, click in the topic where you want to insert the link (usually at the bottom of
the topic).

Select Insert > Concept Link (A-link). The Insert Concept Link Control dialog opens. The
concepts that you have inserted into topics are listed on the left side of the dialog.

Do one of the following:

® |nthe All Concepts section, double-click a concept that you want to add to the concept
link.

® |nthe All Concepts section, click on a concept that you want to add to the concept link.
Then click [#].

The concept is added to the "Selected Concepts" section on the right side of the dialog. Do
this for each concept that you want to add to the link. However, a concept link usually has
only one keyword associated with it (or just a few at the most). Remember, every topic
containing any of those concepts will show up in the concept link in the output. A good
practice is to limit the number of topics per concept link. Otherwise, the link tends to lose its
significance.
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7. (Optional) If you want to specify other options for the control, click and in the Concept

Link Options dialog select any of the following. Click OK to close the dialog when you are
finished.

® Style Class You can select the style class to be used for the control.
® | abel You can change the text shown on the control.

® Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

® Target Frame You can choose the type of frame used when a link is clicked.
» Page Default The destination file opens in the same window as the output window.

» Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

» New Window The destination file opens in a new browser window.
» Same Frame The destination file opens in the same frame as the current topic.

» Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

» Popup Window The destination file opens in a popup box on top of the current topic.
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8. Click OK. The concept link is added to the topic.

Concept Link

This topic contains a concept link below.
This is a concept link_ In the
output, users will be able to click
the link and open any of the
topics associated with it

ee Also

9. Click@ to save your work.

NOTE Another type of automated link that can be added to topics is a relationship link,
which has a similar result but works a bit differently than Help controls. One benefit of a
relationship link is that you can create all of your link information in one place, in a single
relationship table. Another benefit is that you can have multiple types of links at the bottom
of topics (e.g., one for "Related Information," one for "Related Tasks," and one for
"'Reference Materials"). See "Relationship Tables and Links" on page 191.

NOTE When people click a link like this in the output, the text shown for each of the topics
depends on whether the topic in question has a title or heading. The title set in the
Properties dialog has the highest level of precedence. If there is no topic title specified in
the Properties dialog, Flare Desktop uses text associated with h1 through h6 heading
styles. If there is no topic title or headings in a topic, Flare Desktop uses the topic file name.
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| Editing Concepts

After you insert a concept, you might decide later that the concept keyword needs to be altered.
You can modify a concept simultaneously for all topics where that keyword is located, or you can
modify it in a specific topic.

How to Edit a Concept in All Topics Where ltis
Located

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.

2. Inthe explorer area at the bottom of the window pane, right-click on the concept that you
want to rename. From the context menu select Rename Keyword. The concept is renamed in
all topics where it had been inserted
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How to Edit a Concept in a Specific Topic

1. Open the content file.

2. Inthe XML Editor, right-click on the marker holding the concept that you want to modify.
From the context menu, select Edit the Concept Association.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.

3. Inthe Terms column of the Concept window pane, click in the cell containing the keyword
that you want to change.

4. Type the concept and press ENTER. The concept is modified.

5. Click@ to save your work.

What's Noteworthy?

NOTE If you want to change how concepts look when they're inserted in the XML Editor,
you can change the MadCapl|concept style in the Stylesheet Editor. This does not affect the
output.
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| Editing Concept Links

You can edit a concept link that you have inserted into a topic.

How to Change the Concepts Associated With a
Concept Link

The first way to edit a concept link is to change the concepts associated with the link, as well as
specify various other optional settings.

ﬁ EXAMPLE You have a concept link that has two concepts ("Projects" and "Systems")
associated with it. You might want to remove the "Projects” keyword from the link so that it
only contains the "Systems" keyword. The steps below show you how to do this.

1. Open the content file.
2. Inthe XML Editor, right-click the concept link.
3. Inthe context menu, select Edit Concept Link. The Insert Concept Link Control dialog opens.

The concepts currently associated with the link are listed on the right side of the dialog. The
concepts that you have inserted into all other topics are listed on the left side of the dialog.

4. If you want to add a concept to the link, click on that keyword on the left (All Concepts) side of
the dialog. Then click [ if you want to remove a concept from the link, click on that keyword
on the right (Selected Concepts) side of the dialog. Then click [«]

Repeat this for each keyword that you want to add to or remove from the link. When you are
finished, the keywords associated with the link should be in the Selected Concepts section,
and the keywords not associated with the link should be in the All Concepts section. However,
a concept link usually has only one keyword associated with it (or just a few at the most).
Remember, every topic containing any of those concepts will show up in the concept link in
the output.
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5. (Optional) If you want to specify other options for the control, click and in the Concept

Link Options dialog select any of the following. Click OK to close the dialog when you are
finished.

® Style Class You can select the style class to be used for the control.
® | abel You can change the text shown on the control.

® Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

® Target Frame You can choose the type of frame used when a link is clicked.
» Page Default The destination file opens in the same window as the output window.

» Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

» New Window The destination file opens in a new browser window.
» Same Frame The destination file opens in the same frame as the current topic.

» Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

» Popup Window The destination file opens in a popup box on top of the current topic.

6. Click OK. The Insert Concept Link Control dialog closes, and the link is now changed.

7. CIicklE' to save your work.
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How to Edit the Style of a Concept Link

You can edit the style of a concept link. When you do this, the style changes for all concept links in
any topics in your project. Also, keep in mind the various rules that pertain to concept links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. In the upper-left corner of the editor, click in the Show Styles field [A1l Styles d
and select Show Link Styles or Show Dynamic Effects Styles. Different styles are displayed
with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "conceptLink") if you want to
modify only concept links in your project.

® MadCaplhelpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

® MadCap|helpControlListltem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

® MadCap|helpControlListltemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

® MadCapl|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

= MadCapl|helpControlMenultem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.

® MadCap|conceptLink Edit this style to change the look of the heading for concept links.
The following three concept link styles inherit properties from this style.
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5.

= MadCap|conceptLinkControlList Edit this style to change the look of the entire list (<ul>
element) when concept links are displayed in a list, rather than in a popup.

® MadCap|conceptLinkControlListltem Edit this style to change the look of individual
items in the list (<li> elements) when concept links are displayed in a list, rather than in
a popup.

® MadCap|conceptLinkControlListltemLink Edit this style to change the look of links in
the list (<a> elements) when concept links are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCap|conceptLink.focus or MadCap|conceptLink.hover) if you want to modify the
look of the concept link when it is in a certain state (e.g., when it has focus or when
the cursor is hovering over it).

From the Show drop-down list on the upper-right side of the editor, select
[Show: Assorted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

(Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

Locate the property you want to change.

The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it

directly. Otherwise, click the ellipsis button [] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or

popup). If you completed values in a popup, click OK at the bottom of the box.

CIicklE' to save your work.
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Rules

Keep in mind the following rules when working with these types of styles.

Font Color on Link Styles Only

You can set many different properties on Help controls. However, font color can be set only on
styles that deal specifically with links (e.g., a, helpControlListltemLink,
conceptLinkControlListitemLink).

Y% EXAMPLE You want to use red on concept links. You can set that color on
MadCap|conceptLinkControlListltemLink, because it controls the links specifically. But if
you set the color on MadCap|conceptLinkControlList or
MadCap|conceptLinkControlListltem, the color setting will have no effect because those

styles deal with lists and list items, not links.

Inheritance From Main List and Link Styles

Because these Help control styles are based on the main styles for unnumbered lists (ul), list items
(I)), and hyperlinks (a), they inherit properties from those standard styles.

% EXAMPLE You set a purple font on the "a" style. If you do not make any changes to your
Help control styles, all of the links will use a purple font. But suppose you want concept
links to use a green font instead. In that case, you can set the
MadCapl|conceptLinkControlListltemLink style to green. If you do that, regular text
hyperlinks, keyword links, and related topic links will all display in purple, but concept links
will display in green.

NOTE If setting a property on the "a" style does not seem to have an effect on the Help
control links, check the heading style. For example, if you set purple on the "a" style but
MadCaplconceptLink has blue, then MadCap|conceptLinkControlListitemLink will use blue.

That's because MadCapl|conceptlLink overrules "a."
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Inheritance From General Help Control Styles

Because the general "helpControl” styles (helpControlList, helpControlListltem,
helpControlListitemLink) are used to determine the look of all three types of Help control links, the
more specific styles (e.g., conceptLinkControl, keywordlinkControl, relatedTopicsConrol) inherit

properties from them.

ﬁ EXAMPLE You set a 12-pt font on the MadCaplhelpControlListltem style. If you do not
make changes to any of the more specific styles (MadCap|conceptLinkControlListltem,
MadCaplkeywordLinkControlListltem, MadCap|relatedTopicsControlListltem), all of them
will use a 12-pt font. But suppose you want concept links to use a 14-pt font instead. In
that case, you can set the MadCap|conceptLinkControlListltem style to 14 pt. If you do that,
keyword links and related topic links will display in 12 pt, but concept links will display in 14

pt.

No Inheritance Between Specific Styles

As shown, there is inheritance from main styles (e.g., a, li) and from the general "helpControl" styles.
That's because the main styles are at a higher level than all of the Help control link styles, and the
general "helpControl” styles are at a higher level than the more specific styles. But all of the specific
Help control styles are at the same level; therefore, none of them inherit properties from any of the

others.

% EXAMPLE You set a 10-pt font on the MadCap|keywordLinkControlList style (which
controls entire lists for keyword links). Neither the MadCap|keywordLinkControlListltem
style nor the MadCaplkeywordLinkControlListltemLink style will inherit that font size.
Instead, the MadCaplkeywordLinkControlListltem style (which controls list items for
keyword links) will either inherit from li or MadCapl|helpControlListitem. And
MadCaplkeywordLinkControlListltemLink (which controls the actual links for keywords) will
either inherit from "a" or MadCap|helpControlListitemLink. Or you can set different colors

on those styles specifically.
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The following diagram shows how inheritance and precedence works with Help control styles. In
this example, concept link styles are shown. But the same type of structure applies to keyword and
related topic links as well. The arrows show inheritance. The numbers show precedence; in other
words, if multiple styles have different settings for the same property, the style with a lower number
has precedence over those with higher numbers.

10. <ul> 4, <a>
9. helpControlList : : 3. helpControlListitemLink

8. ConceptLinkControlList 5. ConceptLinkControlListltem 1. ConceptLinkControlListltemLink

. FONT COLOR CAN ONLY BE CHANGED OM THESE STYLES
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| Creating a List of Concepts

You can use the Concepts proxy to generate a list of all of the concepts in your project, with links to

the corresponding content. When you generate the output, the proxy is replaced with a list of the
paragraph text found wherever a concept has been inserted.

This is what a topic with
a Concepts proxy might
look like in a project.

FictionSoft Manual

List of Concepts

CONCEpts prowy

List of Concepts

T o st i g e e e e S e 12 B e R T S S S e B e e S e S S e S g B g
B 05 om0 1 S S S S A 9
o 1 i s e e e 10
|Bile )7 - AT SR SO NI SN ST SRR SOOI S 11, 12, 15
EleRIEiEs! .o bt s it e e i b e s b e il i A oo S e 16

This is what a topic with a

Concepts proxy might look

like in the output.
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How to Create a List of Concepts

1.

a bk w N

6.

7.

Create concepts in the project. See "Adding Concepts"' on page 26 and "Inserting Concepts'

on page 30.

Add a new topic as you normally would.

At the top of the topic, enter a title for your list (e.g., "List of Concepts").

Select Insert > Proxy > Insert Concepts Proxy. The Concepts Proxy dialog opens.

(Optional) In the Stylesheet class for proxy field, you can select a class to affect the look of
the entire list.

You might create and use a proxy style class, for example, if you want to add a border around

the generated list. If you do not select a class from this field, the generated list will use the

style settings from the parent MadCap|conceptsProxy style. You have the option of creating a

class for this proxy style in the Stylesheet Editor. To do this, select the

MadCaplconceptsProxy style and in the local toolbar click Add Selector to create a class. The
class will then be available from this field. For more information see the Help system or the

Styles Guide.
Click OK. The proxy is added to the topic.

Click [l to save your work.
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| Editing the Look of a List of Concepts

After you use the Concepts proxy to create a list of concepts, you can change the look of that list by
using styles. You can modify the look of individual entries in the list, as well as the entire container.

How to Edit the Look of a List of Concepts
(Entire Container)

1.
2.

9.

From the Content Explorer, open the stylesheet that you want to modify.

In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

In the upper-left of the editor, make sure the drop-down field is set to
[All Styles |

On the left side of the editor, scroll down and select the MadCap|ConceptsProxy style or a
class that you have created under it (e.g., MadCap|ConceptsProxy.myclass).

From the Show drop-down list on the upper-right side of the editor, select | Show: Al Properties - |

(Optional) You can use the toggle button in the local toolbar to show properties below in a
group viewa or an alphabetical view .

Locate the property you want to change.

The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it

directly. Otherwise, click the ellipsis button =] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or

popup). If you completed values in a popup, click OK at the bottom of the box.

For example, if you want to change the width of the entire list of concepts, you would first
expand the Box property group. Then to the right of width, click -], and in the popup set the
value.

Another example would involve adding headings to a list of concepts. You would expand the
Unclassified property group and select an option next to the the mc-concepts-list-headings
property to enable or disable concept list headings.

CIicklE' to save your work.
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How to Edit the Look of a List of Concepts
(Individual Entries)

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays [ View: Advanced]. |f the button displays
instead, then click it.

3. Inthe upper-left of the editor, make sure the drop-down field is set to
[All Styles |

4. On the left side of the editor, select a style class, depending on what you want to change.

TO EDIT CONCEPT TERMS AND TEXT
Expand the p style, and select either of the following classes under it:

® Concept Select this class to control the look of the concept terms displayed in the
generated list.

® ConceptContext Select this class to control the look of the text associated with each
concept term in the generated list.

TO EDIT PAGE NUMBERS FOR PRINT OUTPUT

Expand MadCapixref and select the ConceptPageNumber style class.

5. From the Show drop-down list on the upper-right side of the editor, select | Show: Al Properties - |

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [ to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

Following are some of the more common properties that you might change for concept
terms and text. (If changing the look of the actual page numbers, you might use other
properties, such as font color.)
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Alignment of Page Number (Print Output) To change the alignment (left, right, center)
of the page number, expand the Unclassified property group. Then to the right of mc-
leader-align, click -], and select one of the alignment options.

Font Family To change the font family (e.g., Arial, Verdana), expand the Font property
group. To the right of font-family, click =], and select the font or a font set you want to
use.

Font Size To change the font size (e.g., 10 pt, 11 pt), expand the Font property group.
To the right of font-size, click [, and set the font size.

Leader Format (Print Output) To change the format of the area between the item in the
list and the page number, expand the Unclassified property group. To the right of mc-
leader-format, click [-], and type the character to use. For example, if you want a series
of dots, type a period. If you do not want to use a leader format, leave this field blank.

NOTE You can enter one character only (period, hyphen, or underscore).
Spaces are also supported, and if you use a character that is not supported, a
space will automatically be used.

Leader Space Before/After (Print Output) Expand the Unclassified property group. To
change the distance from the end of the list entry to the start of the leader, click =1 to
the right of mc-leader-indent, and set the margin value. To change the distance between
the end of the leader and the page number, click =] to the right of mc-leader-offset, and
set the margin value.

Padding Above To change the amount of empty space (padding) above the item in the
list, expand the Box property group. To the right of padding-top, click (=], and set the
padding value. You can also use the other cells in this property group to add padding
below, to the left, or to the right.

Space in Front (Indentation) To change the distance from the left page margin to the
beginning of the item in the list, expand the Box property group. To the right of margin-
left, click -], and set the margin value. You can specify additional indentation for
headings that wrap to more than one line. To do this, expand the Unclassified property
group. To the right of me-multiline-indent, click -], and set the margin value.

9. Click@ to save your work.
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| Deleting Concepts

If necessary, you can delete concepts that you have inserted into a content file (e.g., topic, snippet).
You can do this from the Concept window pane or from a specific file. The advantage of using the
Concept window pane is that you can delete concept keywords from all topics in one step.

How to Delete a Concept From the Concept
Window Pane

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select View > Concept Window.
® Keyboard Shortcut Press SHIFT+FO9.

The Concept window pane opens. The window pane is split into two sections—the Terms
area at the top and the Explorer area at the bottom. If you want to see more or less of either
section, you can click the splitter:| between them and drag it up or down.

2. Inthe explorer area at the bottom of the window pane, right-click on the concept keyword that
you want to delete. From the context menu select Remove Keyword.The keyword is removed
from all topics where it had been inserted.

NOTE If you want to delete a keyword from the Terms area of the Concept window pane,
click on the rectangular area to the left of the concept keyword (on the area with the arrow
El) and press Delete on your keyboard.

How to Delete a Concept From a Specific File

1. Open the content file.
2. Inthe editor right-click the concept marker that you want to delete.
3. From the context menu, select Delete. The concept marker is removed from the topic.

4. CIicklE' to save your work.
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| Deleting Concept Links

There are two parts to a concept link—(1) the concept link itself and (2) the concepts inserted into
topics that associate the topic with a particular concept link. The following steps show you how to
delete the concept link.

How to Delete a Concept Link

If you no longer need a concept link that you have previously inserted into a topic, you can easily
delete it from a topic.

1. Open the content file.
2. Right-click the concept link that you want to delete.

3. From the context menu, select Delete. The concept link is removed from the topic.

4. Click[wl to save your work.
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CHAPTER 4

Cross-References

Supported In:
ECLIPSE
HALP EPUB

HTML
M5
PPTX [ Wes
E POF |l WORD HTML HELP

A cross-reference is an automated link that is based on a format with commands. This method of
linking saves time because you don't have to type the link text each time, or manage it over time if
the destination content changes. Cross-references are recommended when you are linking from
one place in your project to another (as opposed to linking to external files or websites). The format
can be controlled in your stylesheet. This lets you keep links consistent and change them in just one
place by using the MadCap|xref style (or a class of it that you have created). Cross-references are
also useful for converting online links to page number references when you are producing printed
output (by having a separate format for the cross-reference style in the print medium of the
stylesheet).
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| MadCap:xnef |

Across-reference in
the XML Editor

Cross-References

These are best for linking to topics within the same project.

= Here is an example of a cross-reference| See Images.

Cross-References

These are best for linking to topics within the same project.

Here is an example of a cross-reference:|See Images™

How it looks in
online output

Cross-References

These are best for linking to topics within the same project. /

AN

How itlooks in
print-based

cutput

Here is an example of a cross-reference] See "Images” on page 22.

This chapter discusses the following:

General Information for Cross-References

Main Activities for Cross-References ...

Other Activities for Cross-References
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I General Information for Cross-
References

There are various pieces of general information you should know if you plan to use this feature.

Cross-References vs. Text Hyperlinks

Use the following to help determine when to use a cross-reference and when to use a hyperlink.

Cross-References

Use for linking to other topics within the
project, because the link text will
automatically update if changes are made to
the destination topic heading, file name, etc.

Not designed for linking to content outside of
the same project

Uses MadCap-specific style (MadCap|xref)

Can be context-sensitive in print output (e.g.,
displays "next page," "below," or specific page
number)

CHAPTER 4

Text Hyperlinks

Use for linking to websites and external files
(e.g., PDFs), as well as to content in other
projects (see "External Links—HTML, PDF,
Microsoft Office" on page 113)

Use for linking to other topics within the
project when you want specific link text that
doesn't necessarily match the destination
heading, file name, etc.

Uses standard CSS style (a), which is also
used for image hyperlinks and popup links

Not context-sensitive
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Automating Links Based on Commands

Cross-references are somewhat similar to text hyperlinks. However, cross-references differ from
hyperlinks in a few ways. (1) They are based on format commands that help you keep the look of
links consistent, using the MadCap|xref style. Commands are contained in brackets (e.g., {para}).
(2) They are especially useful for print output because they let you automatically refer to specific
areas and/or page numbers in the output. (3) Both the source and destination files must be part of
the same target output within the same project.

ﬁ EXAMPLE Here is the default format associated with the main MadCaplxref style (which
you can change in the stylesheet, if you want):

{para}

The format consists of a single command, with no extra text. This particular command is
designed to display the first paragraph that it comes across in the destination file, which is
usually a heading.

;ID . ® | ¥ & | F| Fiter _ <-'. Y| Festure3htm * 1 Start Page x
= Content (4~ % Layout (Web) = Medium (default) ~ Page Layout a By =l - b - x;' - [al - @
||| A-Intreduction-Topics
v B-Feature-Topics
G Featurel.htm
G Feature.htm
G Featured.htm =
G Features.htm Feature 3
v B C-Procedure-Topics
G Installing-Batteries.htm ( . . . .
@ [ ] Proceduret.htm Here is some content about Feature 3. Let's say it has something to do
@ [ Procedure2 htm with batteries. Here is some more content. See Installing Batteries.
G Procedure3.htm
G Procedures.htm A
||| D-Reference
| M E-Frontmatter-Topics
| Resources
G Homehtm

If the destination file starts with the heading Installing Batteries, the inserted cross-
reference link will simply display Installing Batteries in online output.
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@ YOUR LOGO

You are here: Features > Feature 3

Feature 3

some more content. See Installing Batteries.

Here is some content about Feature 3. Let's say it has something to do with batteries. Here is

A

style (because it is using the print medium in the CSS file):

{para}' {pageref}

the commands.

However, for print-based outputs, here is the default format associated with that same

This format uses two commands, with text (in this case, quotation marks) around one of

So in print-based outputs, the cross-reference link pointing to the Installing Batteries topic
might display something like "Installing Batteries" on page 183.

Feature 3

Here is some content about Feature 3. Let's say it has something to do with bat-

teries. Here is some more content. See "Installing Batteries" on page 13.

A

Later, if you decide to change the heading text of the destination topic from "Installing
Batteries" to "Installing Large Batteries," the cross-references will be updated automatically
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% when you generate the output. The new heading will automatically be reflected in all of the
links using that cross-reference style (e.g., See Installing Large Batteries). If you had used
text hyperlinks in a situation like this, you would need to find and replace the text in all of
the pertinent links manually.

ﬁ EXAMPLE Here is an example of a cross-reference format, using a combination of text and
commands:

See {b}"{paratext}'{/b} on page {page}.
A format such as this might be translated in the output as something like this:

See "Dogs and Cats" on page 93.

If you are using autonumbers in your content (e.g., for figure or table numbers), you can create
cross-reference formats that include the autonumbers.

% EXAMPLE You have created autonumbers in order to number all of your figures. Perhaps
your autonumber format is set up to show the word "Figure" followed by an incremented
number and a colon (e.g., Figure 4, Figure 5;, Figure 6:). In addition, wherever you apply
autonumbering in a topic, you might manually type a short description of the image (e.g.,
Properties Dialog). So in the output under the graphic, the user might see something like
this:

Figure 4: Properties Dialog
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% Now let's say that you want to insert a cross-reference in another topic that points the user
to the Figure 4 graphic. To do this, first of all you would probably want to insert a bookmark
at that autonumber location so that you can point directly to that paragraph when you
insert the cross-reference. Then you can create a special cross-reference format that
includes the autonumber portion of that paragraph. The following two autonumber
commands can be used:

{paranum} This command displays all of the content in the autonumber format, including

any text before an autonumber, the autonumber itself, and any text after the autonumber.

Using the example provided above, this command would display something like this in the
cross-reference:

Figure 4.

{paranumonly} This command displays any text before an autonumber and the
autonumber itself. However, it does not show any text after the autonumber (such as a
colon). Using the example provided above, this command would display something like this
in the cross-reference:

Figure 4

In addition, if you want to include any text that you manually add in the topic after the
autonumber format, you can add the {paratext} command to the cross-reference format.
Using the example provided above, this command would display something like this in the
cross-reference:

Properties Dialog
Therefore, suppose your entire cross-reference format is this:
See "{paranum} {paratext}"
In that case, the output would display something like this:
See "Figure 4: Properties Dialog"
On the other hand, suppose your entire cross-reference format is this:
See "{paranumonly} {paratext}"
In that case, the output would display something like this (without the colon):

See Figure 4 Properties Dialog
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% Again, when you insert the cross-reference in a topic, make sure you select the format that
you created, and also remember to link to the bookmarked paragraph where the
autonumber appears.

TIP If you insert a cross-reference into a topic and it initially does not look the way you
expected, try updating the cross-references in the topic. See "Updating Cross-References"
on page 86.
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Cross-Reference Commands

Following is a list of the available cross-reference commands in Flare Desktop.

Command Description

b Start bold text

/b End bold text

bg Start new background color
/bg End background color

color Start new text color

/color End text color

default Reset all font changes

ext File extension

family Start new font family

/family End font family

file File name, including extension
filename File name, without extension
h1 Text of first heading 1 paragraph
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Command Description
h2 Text of first heading 2 paragraph
h3 Text of first heading 3 paragraph
h4 Text of first heading 4 paragraph
hS Text of first heading 5 paragraph
hé Text of first heading 6 paragraph
Start italic text
/i End italic text
page Page number
pagecount Page count
pageref Context-sensitive page reference
paranum The autonumber text of bookmarked paragraph.
paranumonly The autonumber only of bookmarked paragraph
paratext Text of bookmarked paragraph
paraxml Text and markup of bookmarked paragraph
path File path
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Command

Description

size Start new font size

/size End font size

sub Start subscript text

/sub End subscript text

sup Start superscript text

/sup End superscript text

title Title of document

u Start underlined text

/u End underlined text

url File path, URL syntax

[variable] Available variables can be entered in the cross-reference format.
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I Main Activities for Cross-References

Some activities are particularly common and important when it comes to this feature.

Inserting Cross-References

The following steps show you how to insert cross-references into content files.

How to Insert a Cross-Reference—Standard Method

1. Open the content file.

2. Inthe XML Editor place your cursor where you want to insert the cross-reference.

3. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select the Insert > Cross-Reference.

® Keyboard Shortcut Press CTRL+SHIFT+R.
® | ocal Toolbar In the local toolbar of the XML Editor, click .

® Right-Click Right-click in the editor and select Insert > Cross-Reference. This context
menu option is available only when your cursor is located in certain places in the editor
(e.g., not in a drop-down effect).

The Insert Cross-Reference dialog opens.

4. From the Link to drop-down field, select a way to identify the topic or bookmark to which you
want to link. Based on the option you choose, the section below gives you a list of selections
or additional fields to complete.
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TOPIC IN PROJECT

This option lets you search for a topic within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that

destination in the file.

Use the "Link to" drop-down
field to select a way to find
the target file: "Topic in
Project” (as seen here) or
"Place in this document.”

Shows or

/ hides files
Link to: /ﬂ_

Showsallfilesin

project in a list, [Topien P;ed// *)
Type Path -
@ Introduction htm | htm i
Shows or " | Bookmarks htm /Contert/Feature...
hides folders € | Browse Sequenc... [htm /Content/Feature... il

Click this button to L’
select a bookmark Cross-Reference Properties
in the selected file. XRef Class: [ Edit... ] [ New... #Ref Format (Preview below):
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5.

In the Cross-Reference Properties section, select the MadCaplxref style that you want to use
for the cross-reference.

Initially, you may see only the parent MadCaplxref style in the list. In the XRef Format area to
the right, you can see the current format associated with that tag. Initially this format is as
follows for the different mediums:

® Default Medium {paratext}
® Print Medium "{paratext}" {pageref}

The command {paratext} means that the text of the paragraphed bookmark—or the text of
the first paragraph found in the topic—will be displayed at that spot. The {pageref} command
in the print medium format allows for context-sensitivity (see "Creating Context-Sensitive
Cross-References" on page 77).

You can: (1) use the parent MadCap|xref style with its current format, (2) use the parent
MadCap|xref style and change the format to something else, (3) create a new class of the
MadCaplxref style and provide a custom format for it, or (4) use a class that you have already
created previously.

It is a good idea to create classes because you may eventually want to use multiple kinds of
cross-references in your project. Each class that you create can be used to display cross-
references in a different format. For more information about using styles, including steps, see
the Help system or the Styles Guide.

If you want to use the parent MadCap|xref style with its current format, or a class that you
have created previously, click MadCap:xref or the name of the class, respectively. Then
continue with Step 13.

If you want to use the parent MadCap|xref style but change the format, click MadCap:xref and
then Edit. The Edit Cross-Reference Style Class dialog opens. Continue with Step 10.

If you want to create a new class of the parent MadCap|xref style, click New. The New Cross-
Reference Style Class dialog opens.

In the XRef Class field, give your new class a name.

. Inthe Stylesheet to modify field, select the appropriate stylesheet (if different from the one

shown). If you are using a primary stylesheet (recommended), only that stylesheet is shown
in this field. If you are not using a primary stylesheet, the stylesheet that you select needs to
be applied to the topic in which you are inserting the cross-reference.
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11. Inthe Enter format field, provide the format for the style. This format can be a combination of
text that you type and automated commands that you select. You can select commands from

the list by double-clicking them. They are then added to the "Enter format" field.

Command Description

b Start bold text

/b End bold text

bg Start new background color

/bg End background color

color Start new text color

/color End text color

default Reset all font changes

ext File extension

family Start new font family

/family End font family

file File name, including extension

filename File name, without extension
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Command Description

h1 Text of first heading 1 paragraph

h2 Text of first heading 2 paragraph

h3 Text of first heading 3 paragraph

h4 Text of first heading 4 paragraph

h5 Text of first heading 5 paragraph

hé Text of first heading 6 paragraph
Start italic text

/i End italic text

page Page number

pagecount Page count

pageref Context-sensitive page reference

paranum The autonumber text of bookmarked paragraph.

paranumonly

The autonumber only of bookmarked paragraph

paratext

Text of bookmarked paragraph
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Command

Description

paraxml Text and markup of bookmarked paragraph

path File path

size Start new font size

/size End font size

sub Start subscript text

/sub End subscript text

sup Start superscript text

/sup End superscript text

title Title of document

u Start underlined text

/u End underlined text

url File path, URL syntax

[variable] Available variables can be entered in the cross-reference format.
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¥

EXAMPLE If you want the cross-reference to include text (such as "For more
information see"), simply type it in this field. You can also double-click any of the
commands to add them to this field. For example, you might want to add the text of
the first paragraph in the destination file to the cross-reference format. The
command for this is {paratext}. Descriptions for each command are displayed in the
list.

Some commands include a start tag and an end tag. For example, if you want a
portion of the cross-reference to be displayed in bold, you would place your cursor in
the "Enter format" field where want to start the bold font and double-click b in the list
below. Then place your cursor where you want the bold font to end and double-click
/b from the list.

So in the end, your cross-reference format might include a combination of text and
multiple commands, such as:

For more information see {b}{paratext}{/b}
A format such as this one might display a link in the output like this:

For more information see My Destination Topic

CHAPTER 4

/3



12.
13.

14.

15.

16.

17.

Click OK.

(Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down
arrow to select the way the linked destination will open. This option can be used to open the
destination topic or file in a popup.

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

(Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the cross-reference in the output. When you enter a screen tip, it is added as a
<title> tag in the markup.

For more information see the Help system.

(Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element.

Click OK. The cross-reference is added to the topic. You can change the appearance of the
link (e.g., color, underline) by modifying the style (e.g., MadCap|xref or MadCap|xref.MyStyle)
in the Stylesheet Editor.

Click [l to save your work.
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How to Insert a Cross-Reference—Drag-and-drop
Method
1. Open the content file.

2. Open the Content Explorer, File List window pane, or TOC Editor. If necessary, float and
position the window pane or editor so you can see both it and the XML Editor at the same
time.

3. From the Content Explorer, File List window pane, or TOC Editor, click and drag the topic you
want to link. The cross-reference is added to the topic.

4. CIicklE' to save your work.

NOTE You can change the default drag-and-drop behavior to insert a hyperlink rather than
a cross-reference.
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How to Insert a Cross-Reference—Quick Cross-

Reference Method

1. Open the content file.

In the XML Editor right-click at the location where you want to insert the cross-reference.

2
3. From the context menu select Insert > Quick Cross-Reference.
4

Select the appropriate submenu, depending on the option that helps you find the destination
the fastest.

® Bookmarks Lets you select any bookmarks that you have already inserted into the

current file.

® Same Folder Lets you select any files that are contained in the same folder in the

Content Explorer.

® Open Documents Lets you select any other files that are also currently open in the

workspace.
Introduct \Welcome
Hereis g o : e is with your own content. Here is some general text for a topic. Replace this with your own conte
u ri+ A
some ge Copy ChrleC our own content. Here is sonf  pic example shows place this with your own content. Herg
general L Paste Cirl+V wn content. Here is some gery how you can create a |this with your own content.
— quick cross-reference
» g Inset =l Image.. that points to a file in
» N Create Auto Suggestion B Multtimedia.. the same folder.
% Conditions... Crl+Shift+C il Hyperlink.. Ctrl+K
L Quick Link »
|=| Paragraph... Ctrl+Alt+B
A Font.. Ctrl+ShiftsB & Cross-Reference.,  Ctrl+Shift+R
ick Cross-Ref 3
L Topic Properties..  Ctrl+Shift+P AT S ‘ Ewkma}\‘ 4
%4 Snippet.. Ctrl+R ‘ Same Folder r | DropDowns.htm
=] Variable... Ctrl+ Shift+V Open Documents ¢ Headings.htm

5. From the next submenu choose the bookmark or file. The cross-reference is added to the

topic. You can change the appearance of the link (e.g., color, underline) by modifying the style
(e.g., MadCaplxref or MadCap|xref.MyStyle) in the Stylesheet Editor.

6. Click[wl to save your work.
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Creating Context-Sensitive Cross-References

Supported In:

For print-based and EPUB output you can create context-sensitive cross-references, which
automatically change the text in the link based on the relationship of the cross-reference and the
target location.

Using context-sensitive cross-references is simply a matter of using the correct command. In other
words, instead of using the simple {page} command, you can use the {pageref} command.

ﬁ EXAMPLE You use the plain {page} command. Perhaps the complete format that you
create for a cross-reference style is this:

See "{paratext}" on page {page}.

When you generate the output, this cross-reference will be converted to something like the
following, regardless of where the link falls in relation to its destination:

See "My Information" on page 42.
However, let's say that you use a slightly different format, something like this:
See "{paratext}" {pageref}.

When you generate the output, what you see in place of {pageref} depends on the relative
closeness of the link and the destination. It might be translated as any of these:

See "My Information" below.
See "My Information" above.
See "My Information” on previous page.

See "My Information" on page 42.
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How to Create Context-Sensitive Cross-References

1. Go through the process of inserting or editing a cross-reference. See "Inserting Cross-
References" on page 66.

2. Inthe Insert Cross-Reference dialog, select either New or Edit, depending on whether you
want to create a new cross-reference style or edit an existing one.

3. Provide a format in the Enter format field. This format can be a combination of text and
automated commands.

When creating this format, make sure you include the {pageref} command in it. You can find
the command by selecting either Show All or Show Page Commands. When you find the
{pageref} command in the list, double-click it to add it to the format. Here is an example of a
format that contains a context-sensitive cross-reference command: See "{paratext}"

{pageref}.
*Ref Class: WMy FEFClass =
Here is an example
Stylesheet to modify: styles
of a cross-reference
format with a context-
Erter format (preview below): sensitive page
See "{paratext}” {pagerefi command.

See "Bookmarked paragraph.” on page 1| Yo can usethis
area to select
commands for

Available commands:

inclusion in a format.

Command Description
page Page number
pagecount Page count Pl
pagensf Context sensitive page reference L4
paranum The auto-number text of bookmarked paragraph
naranumanty | The avtn-numher anbe of bonkmadied namoanh i

(Double-click command to insert)

4. Click OK.
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Editing Cross-References

After you insert cross-references into topics, you can edit them in the following ways.

Editing Cross-Reference Destinations

After you insert cross-references into topics, you can change the file to which the cross-reference is
pointing.

How to Edit a Cross-Reference Destination

1. Open the content file.

2. Inthe XML Editor, right-click on the cross-reference and select Edit Cross-Reference. The
Insert Cross-Reference dialog opens.

3. From the Link to drop-down field, select a way to identify the topic or bookmark to which you
want to link. Based on the option you choose, the section below gives you a list of selections
or additional fields to complete.

TOPIC IN PROJECT

This option lets you search for a topic within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use

other options.
Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

=] Shows or hides the folders that the files are stored in.
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Option

E

Description

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click Il to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the

bottom of the dialog.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.

Use the "Link to" drop-down
field to select a way to find
the target file: "Topic in
Project” (as seen here) or
"Place in this document.”

Shows or
hides files
Showsallfiles in Link to: Y \_

projectin a list, [Topicn Project 7~ -
as you seein . B/ I
this example ) htm;”htm| N
e Type s

@ | Introduction.htm htm /Content/

Shows or & | Bookmarks htm htm /Content/Feature. ..
hides folders & | Browse Sequenc... [htm /Contert/Feature .. A

]
Click this button to L-——

select a bookmark Cross-Reference Properties

in the selected file. XRef Class: XRef Format (Preview below):

4. (Optional) In the Target Frame field of the Insert Cross-Reference dialog, click the drop-down
arrow to select the way the linked destination will open. This option can be used to open the
destination topic or file in a popup.

CHAPTER 4

Page Default The destination file opens in the same window as the output window.

Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

New Window The destination file opens in a new browser window.
Same Frame The destination file opens in the same frame as the current topic.

Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

Popup Window The destination file opens in a popup box on top of the current topic.
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5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the cross-reference in the output.

When you enter a screen tip, it is added as a <title> tag in the markup.
For more information see the Help system.

6. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an
element.

7. Click OK.

8. Click[l to save your work.
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Editing Cross-Reference Style Formats

You can change the style format used for cross-references. For example, instead of "See My Topic,"
you might want cross-references to display "For more information see My Topic." You can edit
cross-reference style formats at the point where a cross-reference is inserted, or from a stylesheet.

How to Edit a Cross-Reference Style Format at the Point of Insertion

1. Open the content file.
2. Inthe XML Editor, click inside the link.
3. At the top of the XML Editor, right-click the span bar representing the link. For example,

hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned

on, click [=lin the local toolbar of the XML Editor.
4. Select Edit Cross-Reference. The Insert Cross-Reference dialog opens.
5. Inthe Cross-Reference Properties section, select the MadCap:xref style you want to edit.

MadCap:xref is the parent style and default selection, but in the Stylesheet Editor you can
create classes under that style if you want a variety of looks for cross-references.

6. Click Edit. The Edit Cross-Reference Style Class dialog opens.

7. (Optional) In the Stylesheet to modify field, you can select the appropriate stylesheet (if
different from the one shown). If you are using a primary stylesheet (recommended), only
that stylesheet is shown in this field. If you are not using a primary stylesheet, the stylesheet
that you select needs to be applied to the topic in which you are inserting the cross-reference.
For more information see the Help system or the Styles Guide.

8. In the Enter format field, provide the format for the class. This format can be a combination
of text that you type and automated commands that you select. You can select commands
from the list by double-clicking them. They are then added to the "Enter format" field.

9. Click OK.

10. CIicklE' to save your work.
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11.

(Optional) To make sure other cross-references display the new format, you can update the
cross-references in a topic (Tools > Update Cross-References). However, all of the cross-
references will be updated automatically when you generate the output, so this is not a
mandatory task.

How to Edit a Cross-Reference Style Format From a Stylesheet

10.

11.
12.

CHAPTER 4

. From the Content Explorer, open the stylesheet that you want to modify.

In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

In the upper-left corner of the editor, click in the drop-down field and select
[ Link Styles -]

On the left side of the Stylesheet Editor, select the MadCaplxref tag (or a class of it) that you
want to edit.

From the Show drop-down list on the upper-right side of the editor, select
|Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

(Optional) You can use the toggle button in the local toolbar to show properties below in a
group vievv or an alphabetical view .

If you are using the group view, expand the Unclassified group.

To the right of me-format, click =1 The Cross-Reference Format dialog opens.

In the Enter format field, provide the format for the class. This format can be a combination
of text that you type and automated commands that you select. You can select commands
from the list by double-clicking them. They are then added to the "Enter format" field.

Click OK.

Click [l to save your work.

(Optional) To make sure other cross-references display the new format, you can update the
cross-references in a topic (Tools > Update Cross-References). However, all of the cross-
references will be updated automatically when you generate the output, so this is not a
mandatory task.
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Editing Text for Context-Sensitive Cross-References

You can use language skins to localize the text used in your cross-references. In addition, even if
you plan to create output in only one language, you can use a language skin to change the autotext
that is displayed for context-sensitive cross-references. For example, instead of the text displaying
‘on next page," it can be customized to display "on the following page." See "Creating Context-
Sensitive Cross-References" on page 77.

Flare Desktop provides skins for many different languages. If Flare Desktop does not provide a skin
for a language that you would like to use, or if you want to edit the default translation, you can
create a user-defined language skin.

How to Edit Text for Context-Sensitive Cross-References

1. Open the Project Organizer.

Double-click the Advanced folder.

Double-click a language skin to open it.

From the list, select a language in bold or italic font.
On the right side of the editor, select Print and Online.

If necessary, on the left side of the editor, expand the Print and Online group.

N g~ W N

Scroll down to the Formats rows and locate the cross-reference properties. These are the
translations you will want to edit.

8. Double-click in any of the Value fields and change the text as necessary.

NOTE The Value fields not only contain text, but they also contain format commands
in brackets—for example, {paratext} and {page}. For a list of commands that you can
use, see "Editing Cross-Reference Style Formats" on page 83.

0. CIicklE' to save your work.
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I Other Activities for Cross-References

In addition to the main activities, there are some other tasks you might perform regarding this
feature.

Updating Cross-References

If you insert cross-references and then later make changes (e.g., rename the destination heading,
edit the cross-reference format), you can update (i.e., refresh) the cross-references in the open
content file.

Updating cross-references is not mandatory. When you generate output, all of the cross-references
will be updated automatically in the output. However, the cross-references in the source files will
remain as they were. You can update the cross-references in a source file as reassurance that the
links are correct.

How to Update Cross-References

1. Open a content file (e.g., topic).

2. Select Tools > Update Cross-References. The Update Cross-Reference dialog opens,
displaying the destination topics of your cross-references.

3. Click Update.

CHAPTER 4 86



Viewing Cross-Reference Suggestions

The Cross-Reference Suggestions window pane displays links in a project that you might want to
convert to cross-references. This window pane also provides you with the option to convert the
selected links to cross-references.

For example, if you have regular text hyperlinks (<a> tags), you might want to convert them,
because cross-references change dynamically and are therefore usually preferred over text
hyperlinks.

How to View Cross-Reference Suggestions

1. Open a project.
2. Select Analysis > Suggestions > Cross-Reference Suggestions.
The Cross-Reference Suggestions window pane opens.

3. Double-click a file to open it in the XML Editor. The file opens and highlights the cross-
reference suggestion.

How to Convert Cross-Reference Suggestions

1. Open a project.
2. Select Analysis > Suggestions > Cross-Reference Suggestions.
The Cross-Reference Suggestions window pane opens.
3. Do one of the following:
® Click the Convert to Cross-References button [=]in the local toolbar.
OR

® Right-click any file in the Cross-References Suggestions window pane and from the
context menu, select Convert to Cross-References.

The Convert to Cross-Reference dialog opens.

4. Inthe Convert to Cross-References dialog, you can make selections from the following
options.
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TARGET OPTIONS

In the Target Option field, select one of the following to indicate how you want the destination
file to open when the link is clicked.

® |ink Target This uses the target that is set in the original link.

® Target Frame This enables the Target Frame field (immediately below), which you can
use to select one of the following target frame options.

CHAPTER 4

Page Default The destination file opens in the same window as the output window.

Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

New Window The destination file opens in a new browser window.
Same Frame The destination file opens in the same frame as the current topic.

Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

Popup Window The destination file opens in a popup box on top of the current topic.
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SCREEN TIP OPTIONS

In the Screen Tip Option field, select one of the following to add a screen tip to the link. This is
useful when it comes to accessibility.

® Link Alt Text This uses the screen tip text that is set in the original link.

You can selectthe orignal screen tip
or provide a new one. Selecting Link
Alt Text insers the original screen
tip into the cross-reference.
N\ /
Cross-Reference Properties
Target Option: Target Frame - Screen Tip Option: Link: &t Tt -
Link Alt Text
Target Frame: new frame - Screen Tip: Sereen Tip
¥Ref Class: [ Edit .. ] [ Mew. . ] ¥Ref Format (Preview below):
MadCaplxref. ContinueFrom |:| paral
MadCaplxref. ContinueTo T
MadCaplxref tiptext {para} I
| oK || Ccancel

® Screen Tip This uses the screen tip text that you enter in the Screen Tip field
(immediately below).
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CROSS-REFERENCE STYLE CLASS

In the XRef Class field, you can set the cross-reference's style class and format . The style
class is previewed to the right.

Cross-Reference Properties

Target Option: Screen Tip Option: Link Alt Text -

Inthe XRefClass Target Frame Popup Window - Screen Tip:
section, youcan K
select and edit style > XRef Class: ¥Ref Format (Preview below): The cross-
T reference format is

classes forthe
cross-reference.

MadCaplsref tiptext For more information, see {paratest].

fam] »

then previewed for
you in this section.

MadCaplxref seepara

H MadCaplxref page | For more information, see {paratext}.

[ ok |[ canea |

® Edit You can click Edit to change the selected cross-reference style class. This opens
the Edit Cross-Reference Style Class Dialog.

Enter the name for the
new cross-reference

/I classin this field.

XRef Class: f -
Stylesheet to modfy: Styles T'_J You can selectwhich stylesheet

will be modified as a result of
Enter format (preview below): \I your new style class in this field.

\\J You can enter your

- own cross-reference
= formatin this field.

Available commands: [Show Al \\'L
—— I You can filter the types

Command ___Description Ii of available commands
S‘tart bold text -— in this drop-down menu.
/b End bold text
bg Start new background color I
/bg End background color You can selectthe

command for the cross-

color Start new text color § T fetEh
(Double-click command to insert) relerenceintnis neld.

[ ok [ cance |

® New You can click New to create a new cross-reference style. This opens the New
Cross-Reference Style Class Dialog.

5. Click OK. A message indicates how many files have been updated.
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How to Include Cross-Reference Suggestionsin a
Report

1. Openareport.

2. Inthe Report Editor, click the General tab.

3. Inthe Tables field, scroll down to the Links section.

4. Click the Cross-Reference Suggestions check box.

5. Click Generate. The generated report will include cross-reference suggestions.

Report Editor

&

General Title: -
Styles Tables: = TOC [ ] select all | -
T |:| Duplicate TOC Items |:| TOC - Primary Target
| [] Topics Not In Any TOC
2 Topics [] selectall |
Clickthe (_Imss-Referen ces [ Accessibility Suggestions || Broken Bookmarks
Ifggggﬂg&ﬁ ﬁqﬁg:gg;rﬁo Cross-Reference Suggestions |:| Markup Suggestions |_
be generated.... [] Mon-%ML Topics || Topics Linked By Map ID
[] Topics Not In Any TOC [] Topics Mot In Index
[] Topics Not Linked [] Topics Mot Linke . .
[] Topics With Concept Links [] Topics with Con y;z?gtgglrssré:ggﬁgﬁs
[F] select al and click Generate .
[ skip empty reports
|:| Print report after generation \/
Repart: l Add To Archive... l l Open in Browser ] [ Generate

The generated report
Project: C:\DocumentationBible\Dod contains information on the
Generated: 2/23/2012 12:42:17 PM| cross-reference suggestions
By: rmartinez in your project.

Cross-Reference Suggestions N\ /

Count: 4 \/

File: Content/Resources/Snippets/EnhanceMovies/Actions/ActionDefinitions flsnp
Link Target: ../_/_/Text/Adding_Text_Mimic_htm
Link Target: ../_./../Objects/Buttons/Adding_Buttons_htm
Link Target: ../ /. /Objects/Cursors/Selecting_an_End_Action_for_a_Cursor_htm
Link Target: ../../../Frames/Pausing_Frames_htm
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CHAPTER 5

Drop-Downs

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

A drop-down is a feature that lets you click a hotspot to expand and collapse specified content

(paragraphs, lists, images, tables, videos, etc.) below it.

This chapter discusses the following:

CHAPTER &

Inserting Drop-DOWNS ... 93

Creating Drop-Down Effects in FrameMaker Source Documents ... 96

Editing Drop-Down Effects ... 97
Removing/Unbinding Drop-DOWNS ... 103
Deleting Drop-DOWNS ... 103
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I Inserting Drop-Downs

The following steps show you how to create a new drop-down effect.

How to Insert a Drop-Down

1. Open the content file.

2. Inthe XML Editor type and format the content that will become the drop-down hotspot and
the drop-down body.

3. Highlight all of the paragraphs that you want to be part of the drop-down effect, including the

first paragraph, which will contain the hotspot.

Drop-Downs

Here is some text for a topic.

ext that will become the hotspot in a drop-down effect

Here is text that will become the body in a drop-down effect.

Here is more text that will become the body in a drop-down effect.

CHAPTER 5
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4. Select Insert > Drop-Down Text.

The selected content is converted to a drop-down effect, and it now has brackets around it in
the XML Editor (if markers are turned on). The hotspot has a blue down arrow to the left of it.

Drop-Downs

Here is some text for a topic Drop-down hotspot

This braqket_ and the down
Erovi e + =t Text that will become the hotspot in a drop-down effecti

paragraphs next to it are part
Here is text that will become the body in a drop-down effect
Drop-down body
Here is more text that will become the body in a drop-down effect

of a drop-down effect.

NOTE If you only selected one paragraph when creating a drop-down, Flare Desktop
adds some generic text after the heading for you to replace.

This is the text where
the cursor was located
when we created the
drop-down.

i [My Drop-Down Headingy

(This is the Drop-down text) =

This is genernc text
provided by Flare
Desktop.

5. (Optional) If you want to designate a specific portion of the first paragraph to serve as the
hotspot, first highlight that text.

Drop-Downs

Here is some text for a topic. v

=t Text that will become the [T 9e in a drop-down effect:

Here is text that will become the body in a drop-down effect

Here is more text that will become the body in a drop-down effect.
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Then in the Insert ribbon, click the down arrow in the Drop-Down Text field and select Drop-
Down Hotspot. (Alternatively you can select the same option from the right-click menu.)

Analysis Review Tools Table eleaming Window Help 2_Click this

9 2‘-&}' H ﬂ Named Destination r,\.;ﬁ é [i[JToggler . drop-down. :s._f‘
== EGIossaryTerm Link : = =
Hyperlink Cross-Reference Bookmark Snippet Variable Related Topi
< 4 Keyword note Control

Links Single Source Z| Drop-Dgwn Hotspot

= Drop-Downs.htm*
) Drop-Downs.htm* = Start Page X .
Page Layout B R El by -

@-%

3. Select this
option.

1. Select the text you want
to tum into a hotspot.

Drop-Downs

Here is some text for a topic.

: | =itText that will become the

=

' in a drop-down effecti

Here is text that will become the body in a drop-down effect.

Here is more text that will become the body in a drop-down effect.

Drop-Downs

The hotspot

Here is some text for a topic. changes.

= Text that will become the BN OtS POt in a drop-down effect

Here is text that will become the body in a drop-down effect.

Here is more text that will become the body in a drop-down effect.

6. CIicklE' to save your work.
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| Creating Drop-Down Effects in
FrameMaker Source Documents

The following steps show you how to create a new drop-down effect in a FrameMaker source
document (if you plan to import that document into Flare Desktop). After you import the document,
the drop-down effect will automatically be created in the XML Editor.

How to Create a Drop-Down Effect in a
FrameMaker Source Document

The following steps may vary in different versions of FrameMaker.

1. Open the FrameMaker document.

2. In FrameMaker, create the two drop-down paragraph styles that are required for producing
this effect. This is a one-time step in the document. Afterwards, you can simply select the
newly created styles when specifying drop-down text. To create the two styles, do the
following.

a.

f.

g.
h.

In FrameMaker, select Format > Paragraphs > Designer. The Paragraph Designer
opens.

From the Commands field, click the down arrow and select New Format. The New
Format dialog opens.

In the Tag field, type PullDownButton.
Make sure that the Store in Catalog check box has a check mark.

Make sure that the Apply to Selection check box does NOT have a check mark in it
(unless you want the style to immediately be applied to the paragraph where your
cursor is placed).

Click Create.
Follow these same steps to create a paragraph style called Pul1DownBody.

Close the Paragraph Designer.

3. Inthe FrameMaker document, place your cursor in the paragraph that you want to serve as
the drop-down hotspot in the online output (i.e., when the user clicks that hotspot, the text
below that is identified as the drop-down body will be shown or hidden).
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From the styles drop-down menu or from the paragraph catalog, select PullDownButton.
Highlight the paragraph(s) that you want to serve as the drop-down body in the online output.

From the styles drop-down menu or from the paragraph catalog, select PullDownBody.

N g A

Save the FrameMaker document.

| Editing Drop-Down Effects

You can edit drop-down text that you have inserted into a topic in at least three different ways: (1)
Edit the content in the drop-down text, (2) edit the style of drop-down text, and (3) unbind (or
remove) the drop-down effect. Following are steps to edit drop-down content and styles.

How to Edit Drop-Down Content

1. Inthe XML Editor, click in the area containing the drop-down hotspot or drop-down body.
Then add, remove, or replace the content as necessary.

2. Click[&l to save your work.
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% EXAMPLE You have drop-down text in a topic that contains the words "click here" as the
hotspot, then one paragraph and an image in the drop-down body.

Drop-down hotspot

kY y i

[ This is the first paragraph of the drop-down effect (also\évn as
the "drop-down head"}. In this paragraph, the words }p"click here" 3
are designated as the drop-down hotspot.

This is the second paragraph of the drop-down effect. It is
the first paragraph ofthe drop-down body.

This is the third paragraph of the drop-down effect. It is

the second paragraph of the drop-down body.

Drop-down body r -

If you want to change the text of the hotspot to "see this," you would simply replace the
hotspot text between the small brackets in the topic.

If you want to add another paragraph in the drop-down body, you would simply click
somewhere in the drop-down body, press ENTER, and type the additional paragraph.

And if you want to edit an image in the drop-down body, you would simply edit the image
just as you would if it were not contained in a drop-down (e.g., right-click the image and
select Edit With MadCap Capture.
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How to Edit the Style of a Drop-Down Effect

You can edit the style (e.g., font, color) of a drop-down hotspot or body. When you do this, the style
changes for all drop-down text in any topics in your project.

ﬁ EXAMPLE You want to change the font for your drop-down hotspots to red and italic. The
following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Complete one of the following sets of steps, depending on whether you want to use the
Simplified view or Advanced view in the Stylesheet Editor.

Simplified The Simplified view displays styles in a grid view and is often best for brand
new users.

This view provides an easy way to apply properties to styles, with format options
available from a toolbar and dialogs (similar to the way one would use an interface
such as Microsoft Word). In some cases, only the most common property options are
available in the Simplified view (e.g., font, letter/word spacing, paragraph
alignment/indentation, autonumbering format, borders, background). One advantage of
the Simplified view is that you can apply a property to multiple styles at the same time.
You can also click a check box to hide the properties in the editor, allowing you to see
only the styles.

Advanced The Advanced view displays styles in a tree structure, and despite the name,
is user friendly for authors of all levels.

For the properties, you can toggle between a grouped display and an alphabetical
display. The Advanced view of the Stylesheet Editor lets you edit more settings than are
available in the Simplified view. In addition, the Advanced view lets you see and apply
settings to multiple mediums and media queries at the same time.

IF USING SIMPLIFIED VIEW

a.

b.

CHAPTER 5

In the local toolbar, make sure the first button displays (which means

that the Simplified view is currently shown in the editor). If the button displays

instead, then click it.

In the upper-left corner of the editor, click in the drop-down field and select
|D}fnamic Effects Styles - |
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C.

d.

CHAPTER &

From the grid in the bottom portion of the editor, find and select the appropriate style,
depending on what you want to change.

® MadCap|dropDown This style affects the entire container holding a drop-down
effect, including the image that is shown when a drop-down effect is open or
closed.

® MadCap|dropDownBody This style affects the content that is shown when users
open the drop-down effect.

® MadCap|dropDownHead This style affects the entire container holding a drop-
down hotspot (i.e., the paragraph where the drop-down link is located).

® MadCap|dropDownHotSpot This style affects the text in the first paragraph of a
drop-down effect that serves as the link for opening the drop-down body.

In the local toolbar of the editor, click [2]. The Properties dialog opens.

Click this button to edit
properties for the selected style.

This is the selected
style name.

Stylesheet Editor w: Simplified = % Add Selector Manage Font Sets  Options +

T
DynamicEffecl % v [ Hide Inherited  [] Hide Properties Medium: (default) v @B 77U
Mame I / « Tag Class 1M Pseudo Class Preview
MadCap | drogf fwn MadCap | drop... MadCap Softy
MadCap | drgfDownBody MadCap | drop... MadCap Softy

MadCap | dropDownHead MadCap | drop...
MadCap | dropDownHotspot MadCap | drop... MadCap Soffti
MadCap | dropDownHetspot:focus MadCap | drop... focus MadCap Soffti
MadCap | dropDownHetspothever MadCap | drop... hover MadCap Soffti
MadCap | expanding MadCap | expa.. MadCap Softy
MadCap | expandingBody MadCap | expa... MadCap Soffi
MadCap | expandingHead MadCap | expa... MadCap Soffti
MadCap | expandingHead:focus MadCap | expa... focus MadCap Soffti
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e. Use the tabs and fields in the Properties dialog to change values for any of the style's
properties.

f. Inthe Properties dialog, click OK.

IF USING ADVANCED VIEW

a. Inthelocal toolbar, make sure the first button displays 4 If the button
displays instead, then click it.

b. Inthe upper-left corner of the editor, click in the drop-down field and select
|Dynamic Effects Styles = |

c. Onthe left side of the editor, find and select the appropriate style, depending on what
you want to change.

® MadCap|dropDown This style affects the entire container holding a drop-down
effect, including the image that is shown when a drop-down effect is open or
closed.

® MadCap|dropDownBody This style affects the content that is shown when users
open the drop-down effect.

® MadCap|dropDownHead This style affects the entire container holding a drop-
down hotspot (i.e., the paragraph where the drop-down link is located).

® MadCap|dropDownHotSpot This style affects the text in the first paragraph of a
drop-down effect that serves as the link for opening the drop-down body.
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o

From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on
the right side of the editor.

(Optional) You can use the toggle button in the local toolbar to show properties below
inagroup vievv or an alphabetical view .

Locate the property you want to change.

The area to the right of the property is used for selecting and entering values. If you
know how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button =] to the right of the property. Depending on
the type of property, the appropriate controls and options display, allowing you to
choose or enter values (e.g., select from a drop-down list, click a button, complete
fields in a dialog or popup). If you completed values in a popup, click OK at the bottom
of the box.

Following are some of the more common properties that you might change:

" mc-closed-image This style, located in the Unclassified property group, lets you
select an image to be shown next to the drop-down effect when it is in a closed
state. To use this property, first select the MadCap|dropDown style.

" mc-closed-image-alt-text This style, located in the Unclassified property group,
lets you set alternate text for the drop-down effect when it is in a closed state.

® mc-open-image This style, located in the Unclassified property group, lets you
select an image to be shown next to the drop-down effect when it is in an open
state. To use this property, first select the MadCap|dropDown style.

® mc-open-image-alt-text This style, located in the Unclassified property group, lets
you set alternate text for the drop-down effect when it is in an open state.

® mc-image-spacing This style, located in the Unclassified property group, lets you
set the spacing around the image next to the drop-down.

3. CIicklE' to save your work.

CHAPTER 5
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I Removing/Unbinding Drop-Downs

If you have inserted drop-down text into a topic and want to keep the text but remove (or "unbind")
the drop-down effect so that it is displayed as normal text, use the following steps. If you want to

delete the drop-down text, therefore removing all of its text from the topic, see "Deleting Drop-
Downs" below.

How to Remove/Unbind a Drop-Down

1. Open the content file.
2. Right-click the down arrow [ at the beginning of the drop-down text.

3. From the drop-down menu, select Unbind Drop-Down Text. The drop-down effect is removed,
converting the section to normal text.

4. CIicklE' to save your work.

| Deleting Drop-Downs

If you have inserted drop-down text into a content file (e.g., topic, snippet) and want to delete it,
therefore removing all of its text from the topic, use the following steps. If you want to keep the text

but remove the drop-down effect so that it is displayed as normal text, see "Removing/Unbinding
Drop-Downs" above.

How to Delete a Drop-Down

1. Open the content file.
2. Right-click the down arrow [=l at the beginning of the drop-down text.
3. From the drop-down menu, select Delete. The drop-down text is removed from the topic.

4. CIicklE' to save your work.
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CHAPTER 6

Expanding Text

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

Expanding text is a feature that lets you click a hotspot to expand and collapse content that
appears after it in the same paragraph or other block element.

This chapter discusses the following:

Inserting Expanding Text ... 105
Editing Expanding TeXt ... 108
Removing/Unbinding Expanding Text ... 112
Deleting Expanding Text ... 112
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I Inserting Expanding Text

Creating an expanding text feature requires only a few simple steps.

How to Insert Expanding Text

1. Open the content file.
2. Inthe XML Editor type and format the content that will become the expanding text.

3. Highlight the portion of the paragraph that you want to be used as the hotspot. If you do not
select any text in the paragraph, it will all become the hotspot.

Expanding Text

Here is the beginning of a paragraph. Here is the end of a paragraph.

NOTE Although this feature is called "expanding text," the content does not have to
be strictly text only. For example, you can use a small image for the hotspot.
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4. Select Insert > Expanding Text.

The selection is now surrounded by brackets in the XML Editor (if markers are turned on). The

hotspot appears with an icon next to it. A second set of empty brackets follows the
hotspot.

Hotspot text Empty bracket

\ T V.

Expanding Text

Here is the beginning of a paragraph. pClick this|Tjy; 4 Here is the end of a paragraph.

NOTE The font used in the expanding text depends on the settings specified for the
MadCaplexpandingHead and MadCap|expandingBody styles in your stylesheet.

5. Inthe empty bracket, type the body text for the expanding effect.

In this example, we
copied the text that was at
the end of the paragraph
and pasted it into the
empty bracket.

Expanding Text

Here is the beginning of a paragraph. jClick thisTigzHere is the end of a paragraph. 3
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NOTE If you do not have markers enabled, you will not see the empty bracket. To

enable markers, click the down arrow next to in the local toolbar of the
XML Editor, then select Show Markers.

6. (Optional) If you want to adjust the text that serves as the hotspot, you can highlight the text
in the current hotspot area. Then in the Insert ribbon, click the down arrow in the Expanding
Text field and select Expanding Hotspot. This pushes any text after your selecting into the
second set of brackets.

7. CIicklE' to save your work.
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| Editing Expanding Text
You can edit expanding text that you have inserted into a topic in at least three different ways: (1)

edit the content in the expanding text, (2) edit the style of expanding text, and (3) unbind (or
remove) the expanding text effect. Following are steps to edit expanding text content and styles.
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How to Edit the Content in Expanding Text

The first way to edit expanding text is to change the actual content in the expanding text heading
(or hotspot) or in the expanding text body.

1. Open the content file.

2. Inthe XML Editor, click in the area containing the expanding text hotspot or body. Then add,
remove, or replace the content as necessary.

This is the expanding text
hotspot. The hotspot is any text
within the first set of brackets.

P —

Expa ext

[FThisTl4y is an example of expanding text. In this example, the
word "This" at the beginning of the paragraph is the hotspot, but you
can change it if you want. 4

VAN

This is the expanding text You canchangethe
body. The hotspot is any font for the hotspot or
text within the second set the body in the

of brackets. Stylesheet Editor

3. CIicklE' to save your work.

ﬁ EXAMPLE You have expanding text in a topic that contains the words "click here" as the
hotspot, and the rest of the sentence after the hotspot is the expanding text body. If you
want to change the text of the hotspot to "see this," you would simply replace the hotspot
text (which is the text between the first set of brackets). And if you want to add another
sentence to the expanding text body, you would simply click at the end of the current
expanding text body (within the second set of brackets) and type the additional sentence.
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How to Edit the Style in Expanding Text

You can edit the style (e.g., font, color) of an expanding text hotspot or body. When you do this, the
style changes for all expanding text in any topics in your project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
|D}rnamic Effects Styles - |

4. On the left side of the editor, find and select one of the expanding text styles:

® MadCaplexpanding This style affects the entire container holding an expanding text
effect, including the image that is shown when an expanding text effect is open or
closed.

® MadCaplexpandingBody This style affects the expanded text portion of an expanding
text effect (i.e., the area that is displayed or hidden when users click the hotspot link).

® MadCaplexpandingHead This style affects the hotspot portion of an expanding text
effect.

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assorted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [ to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.
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Following are some of the more common properties that you might change:

mc-closed-image This style, located in the Unclassified property group, lets you select
an image to be shown next to the expanding text effect when it is in a closed state. To
use this property, first select the MadCaplexpanding style mentioned above.

mc-closed-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the expanding text effect when it is in a closed state.

mc-open-image This style, located in the Unclassified property group, lets you select an
image to be shown next to the expanding text effect when it is in an open state. To use
this property, first select the MadCap|expanding style mentioned above.

mc-open-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the expanding text effect when it is in an open state.

mc-image-spacing This style, located in the Unclassified property group, lets you set
the spacing around the image next to the expanding text effect.

9. CIicklE' to save your work.
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I Removing/Unbinding Expanding Text

If you have inserted expanding text into a topic and want to keep the text but remove (or "unbind")
the expanding text effect so that it is displayed as normal text, use the following steps. If you want
to delete the expanding text, therefore removing all of its text from the topic, see "Deleting
Expanding Text" below.

How to Remove/Unbind Expanding Text

1. Open the content file.

2. Hover over the expanding text icon until the cursor becomes an arrow, then right-click it.

3. From the drop-down menu, select Unbind Expanding Text. The expanding text effect is
removed, converting the section to normal text.

4. Click[&l to save your work.

| Deleting Expanding Text

If you have inserted expanding text into a topic and want to delete it, therefore removing all of its
text from the topic, use the following steps. If you want to keep the text but remove the expanding

text effect so that it is displayed as normal text, see "Removing/Unbinding Drop-Downs" on page
103.

How to Delete Expanding Text

1. Open the content file.

2. Hover over the expanding text icon until the cursor becomes an arrow, then right-click it.
3. From the drop-down menu, select Delete. The expanding text is removed from the topic.

4. CIicklE' to save your work.
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CHAPTER 7

External Links—HTML, PDF,
Microsoft Office

Supported In:

HTML
PDF WORD St H!:"flL PPTX WEB
HELP HELP HELP

An external link is an "a" link (not a cross-reference) that lets you connect to another file (e.g., HTM,
HTML, XML, PDF, Microsoft Office files) outside of your output. These steps involve a little planning
ahead. You need to know the location where your files will be published, as well as the names of
your output files.
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I How to Insert a Link to an External File

1. (Optional) If you need to link to a specific place in the destination file that you are creating
(e.g., a subheading in a PDF file), insert a named destination or a bookmark at that location.
Named destinations are used in PDFs.

2. Inthe source topic where you want to insert the link, use the normal steps for inserting the
type of link that you want to create (text hyperlinks, topic popups, image hyperlinks).

® ‘Inserting Text Hyperlinks" on page 237
® ‘Inserting Topic Popups" on page 363
® "Inserting Image Hyperlinks" on page 120

3. From the Link to drop-down field, select External File.

NOTE If you want to link to a file that you've placed on a web server, instead of
selecting "External File," you can select "Website" instead, and then enter the URL
pointing to that file.

4. Inthe External File field, enter the path for the link, depending on the output type you are
using.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the External File field.

MOST OUTPUT TYPES (E.G., PDF, HTML)

Enter the relative path from the source output topic to the destination topic, using a pair of
periods to represent each folder level.
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¥ EXAMPLE — PDF Outputs

From your project you are creating one PDF file called "Main-PDF" and another called
"Second-PDF." Suppose that you plan to publish these outputs in the same folder on
a server.

Main-PDF.pdf
Secend-PDF.pdf

In the Main PDF, you want to create a link that opens the second PDF, and
immediately goes to a specific heading within it (where a topic from your project
begins).

First of all, you open the destination topic (the one that will be in the Second PDF) in
your project and add a named destination before the first heading. Let's say you call
it "TopicSecondDestination."

[ | % Layout (Web) = Medium {default) - Page Layout - | ] & = - b4 - |[d] - [2] - | GD T & =]

\4

'» TopicSecondDestination Topic for PDF Second Output

Here is some text.

In that case, when you create the link in the other topic (the one that will be in the
Main PDF), you would enter the following in the External File field:

../../Second-PDF.pdf

And in the Named Destination field, you enter the following:

TopicSecond Destination
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¥% EXAMPLE — HTMLS5 Outputs

From your project you are creating one HTML5 output called "Main" and another
HTMLS output called "Second.” Suppose that you plan to publish these outputs in
adjacent folders on a server. The first output will be stored in a folder named "Main,"
and the other output will be placed in a folder named "Second.”

Main

Second

In the Main output, you want to create a link in a topic that opens a different topic in
the Second output. The destination topic is located within that HTML5 output in a
folder named "C-Second-Outputs” and it is named "Topic-Online-Second-Output.htm."

Content
| | A-Intreduction-Topics
v B-Main-Outputs
¢ Feature3.htm
€ | | Features.htm - Youwantalinkin this
€ | | Topic-Online-Main-Output.htm -r...-':____ topic (which will be part
€ | | Topic-PDF-Main-Output.htm of the Main output).
v C-Second-Cutputs
€ [ | Procedured.htm : - -
€ [ | Procedures.htm The link will point to
¢ Tepic-Online-3econd-Output.htm-- this topic (which will be
¢ Topic-PDF-5econd-Cutput.htm part of the Second
== D-Reference DUtDUt:I.
| M E-Frontmatter-Topics
1[ | Resources

¢ Home.htrn

In that case, you would enter the following in the External File field:

./../../Second/Content/C-Second-Outputs/Topic-Online-Second-
Output.htm
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HTML HELP (CHM FILES)
Use one of the following:
B NameOfOutput.chm::/NameOfTopic.htm
B mk:@MSITStore:PathToOutput\NameOfOutput.chm: :/NameOfTopic.htm

Use the first method if you plan to publish your CHM files to the same folder (recommended).
Use the second method if you plan to publish your CHM files in different folders.

7 EXAMPLE — CHM Outputs

You have a project called "FirstHelp" and another called "SecondHelp." Also, let's
assume that the first project will generate a CHM file named "First.chm," and the
second will generate a CHM file named "Second.chm." (The names of the CHM files
can be specified on the General tab of the Target Editor. Enter the desired name in
the Output File field. If you plan to publish the files to the same folder, they need to
have different names.)

Suppose you want to create a text hyperlink in a topic called "Welcome," which is
located within the FirstHelp project. When a user clicks on this link, you want it to
open a topic called "About the Company," which is located within the SecondHelp
project. Therefore, you open the Welcome topic in the FirstHelp project. Then you
highlight the text to be used in the hyperlink, and you select Insert > Hyperlink. The
Insert Hyperlink dialog opens. Next, from the drop-down field you select External File.
What do you enter in the External File field?

We will take a look at two different situations. First, let's say that you plan to publish
both CHM files to the same folder (perhaps on your company's intranet). In that case,
you would enter the following:

SecondHelp.chm::/About the Company.htm

On the other hand, let's say that you plan to publish First.chm to one folder, and you
plan to publish Second.chm to a separate folder, such as the following:
C:\Documentation\More Help. In that case, you would enter the following:

mk:@MSITStore:C:\Documentation\More
Help\SecondHelp.chm::/About the Company.htm
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NOTE If you want to link content to an external CHM file, an alternative is to use the
"HTML Help File" option from the "Link to" field, instead of the "External File" option.

5. (Optional) You can click [ to select any bookmarks within the destination file, or["al if you
need to select a named destination in a PDF file. See "Inserting Bookmarks" on page 12 and
"Named Destinations" on page 161.

6. Inthe link dialog, click OK.
7. CIicklE'to save your work.

8. Generate the output for the projects and publish the files to the appropriate location(s).

NOTE The Eclipse Viewer cannot display PDFs opened from links.
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CHAPTER 8

Image Hyperlinks

MS
HTML WEB
ELP HELP

Supported In:

HTML

5|

ECLIPSE

After you insert an image, you can turn that picture into a hyperlink, connecting it to another topic, a

topic in an imported HTML Help file, an external file (such as a website), or an email.

This chapter discusses the following:

Inserting Image Hyperlinks ... 120
Editing Image Hyperlinks ... 126
Creating Image Maps ..o 133
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I Inserting Image Hyperlinks

Use the following steps to create an image hyperlink.

How to Insert an Image Hyperlink

1. Open the content file.
2. Inthe XML Editor, right-click the image that you want to use as a hyperlink.
3. Inthe context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based on the option you choose, the section below gives you a list of
selections or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.
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Option Description

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

*x - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.
PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.
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EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [l to display and select any bookmarks within the destination file, or [2&] i
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click [Z] The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

below).

ﬁ EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list

Link to:
| Email -
Email address:

techsupport @mycompany com;bob@mycompany .com
Subject:
Meed Tech Support

Recent Email Addresses

sally@mycompary.com
bob@mycompany .com

Use semi-colons to
separate multiple
email addresses.

You can select
recent email
addresses.

lam,|
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only a "title" attribute, but as an "alt"
(alternate text) attribute as well.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare Desktop uses the

parent "a" style.)
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7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of 1 will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTMLS5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is added to the image in the topic. When a user hovers the cursor over
the image in the output, the cursor changes to a hand.

10. CIicklE' to save your work.

(D WARNING It is recommended that you avoid creating links to snippets. This is primarily
due to the nature of snippets, which are designed to be inserted into multiple files. Let's say
you have a heading style in a snippet and that snippet is then inserted into 12 different
topics. In another topic, you might decide to create a cross-reference that points to the
heading in that snippet. But which of those 12 topics is it supposed to point to in the
output? There is no way for Flare Desktop to know this, so you could end up with some very
undesirable results. For this reason, it's a good idea not to link to any content in a snippet.

CHAPTER 8 125



| Editing Image Hyperlinks

You can edit image hyperlinks that you have inserted into a topic in the following ways: (1) edit the
destination and properties of the hyperlink, and (2) remove the hyperlink from the image.

The first way to edit image hyperlinks is to change the destination and other properties (target
frame, screen tip).

% EXAMPLE You test the topic containing the image hyperlink and you notice that the wrong

destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

How to Edit the Destination and Properties of an
Image Hyperlink

1.

Open the content file.

2. Inthe XML Editor, right-click the image.
3.
4

In the context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which

you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.
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FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [l to display and select any bookmarks within the destination file, or [2&] if
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

below).

ﬁ EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list

Link to:
| Email -
Email address:

techsupport @mycompany com;bob@mycompany .com
Subject:
Meed Tech Support

Recent Email Addresses

sally@mycompary.com
bob@mycompany .com

Use semi-colons to
separate multiple
email addresses.

You can select
recent email
addresses.

lam,|
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

6. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare Desktop uses the
parent "a" style.)

7. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open. This option can be used to open the destination topic or file in a popup.
The other options are typically used by advanced users.
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® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

8. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through links. So when a user presses the TAB key the first time, the hyperlink with an
index value of T will be selected first, the link with a value of 2 will be selected next, and so on.
If you want to skip a link, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTMLS5, Clean XHTML,
WebHelp, WebHelp Plus.

9. Click OK. The hyperlink is changed in the topic.

10. Click [l to save your work.
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How to Remove the Hyperlink From the Image

Another way to edit an image hyperlink is to remove the hyperlink effect. If you decide that you no
longer want the image to serve as a hyperlink, you can use the steps below to remove the hyperlink.
When you are finished, the image will remain in the topic, but the hyperlink effect will be removed.

1. Open the content file.
2. Inthe XML Editor, right-click the image.
3. Inthe context menu, select Hyperlink Image. The Insert Hyperlink dialog opens.

4. In the bottom-left section of the dialog, click the Remove Link button. The hyperlink effect is
removed.

5. CIicklE' to save your work.
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| Creating Image Maps

After you insert an image, you can create multiple hyperlinks for specific sections of the image.
This is called an "image map." Image maps engage online users to click linked parts of an image
that reveal more information.

The image map contains a “hotspot,” which is the part of the image that contains the link as you
hover the mouse on it (e.g., text, icon). It also contains a target frame property that determines how
the link opens (e.g., popup, tab, window).

The foundation of an image map can take on several forms, such as a graphic, photo, or map. The
image map is anything with identifiable clickable areas.
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How to Create an Image Map

1. Open the topic.
2. Inthe XML Editor, right-click the image on which you want to create an image map.

3. Inthe context menu, select Image Map. The Image Map Editor opens, with the image
displayed.

0 Image Map Editor ? %
Edit

DEAR = hMetae B . %G

SUNSET-CLIEES)

ROINT LOMAMN

Link Properties
Link: ‘Zoo.htm |

Screen Tip ‘ |

Tab Index: 1 |

4. Inthe Standard toolbar of the Image Map Editor, click one of the shape drawing buttons,
depending on the area of the image that you want to use as a hyperlink.

Option Description

Click this button if you want to draw an odd shape over a section of the
image.

@ Click this button if you want to draw a rectangle over a section of the image.

Click this button if you want to draw a circle over a section of the image.
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5. Intheimage, click and drag your mouse over the area to be used as a hyperlink. Release the
mouse button when you are satisfied with the size and location of the shape. You should now

see the shape on top of the image, connected by a series of points.

DES R = x|zt

SUNSETSCLIEES|S

LR TR

Example of clickable
hyperlink area drawn
on image.

AL

LITTLE(IT

The Image Map Editor only draws clickable areas for the hyperlink (or hotspot). It does not
draw shapes and objects on the image. You will have to use another tool, such as MadCap
Capture, if you want to annotate the image itself.
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6. Inthe toolbar, click . The Area Properties displays.

0 Area Properties *
Link to:
File in Project w
== m o .
[ | Content A
» || | Resources
hd _1 San Diego Map
& [ ] cabrilo.htm
¢ SD-map.htm
¢ Seaport.htm
& [ ] Zoo.htm
¢ Beaches.htm hd
L] |
Link Properties
Link Text: X
Screen Tip: | X
Alternate text: | X
Style Class: Style ID:
Target Frame: |F‘n|:u..||:| Windaow w |
Tab Index:
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7. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
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does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.

PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click Il to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

below).

ﬁ EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list

Link to:
| Email -
Email address:

techsupport @mycompany com;bob@mycompany .com
Subject:
Meed Tech Support

Recent Email Addresses

sally@mycompary.com
bob@mycompany .com

Use semi-colons to
separate multiple
email addresses.

You can select
recent email
addresses.

lam,|
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

8. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. This is added not only as a "title" attribute, but as an
"alt" (alternate text) attribute as well.
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9.

10.

11.
12.

13.

14.

(Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

NOTE The Popup Window option is not supported in HTML5 online output formats
with Side Navigation and Top Navigation skin types. Either select an output format
that supports it, or in the Target Editor's Skin tab, set the skin type to none.

(Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in the image. So when a user presses the TAB key the first time in a
topic, the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of
2 will be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTMLS5, Clean XHTML,
WebHelp, WebHelp Plus.

Click OK.

If you want to add more hyperlinks to the image, select a shape button again and repeat the
steps above.

When you are finished creating hyperlinks on the image, click OK in the Image Map Editor.

Notice that when the object is selected in the Image Map Editor, the link property fields at the
bottom are populated with the information you provided.

Click [l to save your work.
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How to Make Image Maps Responsive

Image maps are not natively responsive; meaning the image and its clickable area do not
automatically adjust depending on the user’s device and screen size. Because of this, it is a best
practice to set the image max width style property to 100%.

1. From the Content Explorer, open the stylesheet that you want to modify.
Using the Advanced view, select the img style.

From the local toolbar, select Show: All Properties.

> N

Expand Unclassified, and set the max-width property to 100%.

Stylesheet Editor %“1 View: Advanced | % Add Selector =0 Renarme  CSS Variable - Medium ~ Options -

All Styles ~ Hide Inherited =) +| Medium: (default) *| Show: All Properties =

hi -
h2

h3 4 |nclassified
hd box-shadow:
h%
hé box-sizing
head
header content
hr counter-increment
= html
i counter-reset:
direction:
Pu empty-cells:
ins
kbd marker-offset:
label )
legend max-height
bl max-width: 100%
MadCap | annotation
MadCap | bodyProxy mec-breadcrumbs-count:

5. CIicklE' to save your work.

NOTE This process makes the image itself responsive in the output. If you want the
clickable areas of the map to be responsive as well, you'll have to download a Responsive
Image Maps jQuery Plugin from a GitHub repository.

If you would rather not download the jQuery plugin, you can remove the max-width
property. This would keep the image map and clickable areas in sync as users adjust the
output, but the image map and the clickables areas would not be responsive.
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Buttons and Sections in the Image Map Editor

Following are descriptions of buttons and sections found in the Image Map Editor.

Option

Edit

e N

L]

EiEEd

o]

CHAPTER 8

Description

Use this menu to select basic editing options (such as undo, redo, cut, copy, and
paste). You can also open the properties for an object or apply conditions to it.

Click this button to toggle between seeing a clear image of the picture and a faded
image. This is only for your internal use; it will not affect the output.

Click this button to hide the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to fill the shapes that you draw over areas of the image. This is
only for your internal use; it will not affect the output.

Click this button to open the Area Properties dialog, which lets you find and select
a destination file to link to a shape that you've drawn. You must select a shape
before this button is enabled.

Click this button to delete a selected point in the editor.

Click this button to enable "Select” mode so that you can click on shapes that you
have drawn in the editor.

Click this button to draw a polygon shape over an area of the image. You can then
select the shape and link it to a destination file.

Click this button to draw a rectangle shape over an area of the image. You can
then select the shape and link it to a destination file.

143



Option

Description

Click this button to draw a circle shape over an area of the image. You can then
select the shape and link it to a destination file.

Click this button to bring a shape up one layer (if it is overlapped by one or more
other shapes).

Click this button to bring a shape up to the top layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down one layer (if it is overlapped by one or
more other shapes).

Click this button to move a shape down to the bottom layer (if it is overlapped by
one or more other shapes).

Opens a dialog that lets you apply conditions to content.

Link Displays the path to the linked destination file for the selected object. This field is
automatically populated after you click [%] to find and select a destination file.
Screen Displays the screen tip (or "alt" text) for the selected object. An alt tag provides a
Tip textual equivalent for the image. This code allows the page to be usable by
persons with graphics turned off or who are blind and using a screen reader. This
field is automatically populated after you cIick and enter the screen tip text.
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Option Description

TabIndex  Displays the tab index value that you entered in the Area Properties dialog for the
selected object. The tab index is a value to specify the order in which users can tab
through links on an image. So when a user presses the TAB key the first time, the
link with an index value of T will be selected first, the link with a value of 2 will be
selected next, and so on. If you want to skip a link, enter -1 in that field. This
feature is supported only in web outputs—HTML5, Clean XHTML, WebHelp,
WebHelp Plus.
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Overlapping Objects and PDF Output

PDFs are limited to rectangular-shaped image map objects. Therefore, if you have an image map
with circle or polygon objects, those will be redrawn as rectangles in the PDF output. If this occurs,
Flare Desktop will include a compile warning. Also, keep in mind that if objects overlap one another,
the one on the top layer (usually the last one drawn) takes precedence.

ﬁ EXAMPLE You have an image of the Olympic circles inserted into a topic:

You create an image map, drawing round objects around each of the five circles, and you
link each of these objects to a different website. For the purposes of this example, we're
showing dark green circles to represent each image map object:

Notice that the circles overlap in some places. In those locations, the circle object that is on
the top layer will win. Therefore, if the user clicks in that area, the website linked to the

object on top will be opened.
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ﬁ Now, if you generate online output, such as HTMLS5, the circle shapes on the image map
will be retained, just as you see them above. But if you generate PDF output, each of the
circle objects will be converted to a rectangle, like this:

Therefore, the link areas (as well as the overlapping areas) are adjusted accordingly.
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CHAPTER 9

Keyword Links

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

A keyword link is a Help control that lets you open topics related to the current topic based on index
keywords that they share.

This chapter discusses the following:

Inserting Keyword LinKS ... 149
Editing Keyword Links ... 151
Deleting Keyword LINKS ... 155
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I Inserting Keyword Links

Supported In:

HTML
MS
ECLIPSE ] WEB
HELP HELP HELP

Inserting keyword links requires only a few simple steps.

How to Insert a Keyword Link

1. Insert index keywords into the appropriate files.
2. Open the content file.

3. Inthe XML Editor, click in the topic where you want to insert the link (usually at the bottom of
the topic).

4. Select Insert > Keyword Link Control (K-link).

The Insert Keyword Link Control dialog opens. The index keywords that you have inserted into
topics are listed on the left side of the dialog.

Do one of the following:

® |n the All Keywords section, double-click an index keyword that you want to add to the
keyword link.

® |nthe All Keywords section, click on an index keyword that you want to add to the
keyword link. Then click .

The index keyword is added to the "All Keywords" section on the right side of the dialog.
Do this for each index keyword that you want to add to the link.
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6. (Optional) If you want to specify other options for the control, click and make your
selections. Click OK to close the dialog when you are finished.

® Style Class You can select the style class to be used for the control.
® |abel You can change the text shown on the control.

® Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

® Target Frame You can choose the type of frame used when a link is clicked.
» Page Default The destination file opens in the same window as the output window.

» Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

» New Window The destination file opens in a new browser window.
» Same Frame The destination file opens in the same frame as the current topic.

» Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

» Popup Window The destination file opens in a popup box on top of the current topic.

7. Click OK. The keyword link is added to the topic.

Keyword Links

This topic contains a [Keyword link Keyword link below.

search Index This is a keyword link. In the
- output, users will be able to click

T, thelink and select one ofthe

topics associated with it.

8. Click[&l to save your work.
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| Editing Keyword Links

You can edit a keyword link that you have inserted into a topic.

How to Change the Keywords Associated With a
Keyword Link

The first way to edit a keyword link is to change the keyword(s) associated with the link, as well as
specify various other optional settings.

ﬁ EXAMPLE You have a keyword link that has two keywords ("Projects" and "Systems")
associated with it. You might want to remove the "Projects” keyword from the link so that it
only contains the "Systems" keyword. The steps below show you how to do this.

1. Open the content file.
2. Inthe XML Editor, right-click the keyword link.

3. Inthe context menu, select Edit Keyword Link. The Insert Keyword Link Control dialog opens.
The keywords currently associated with the link are listed on the right side of the dialog. The
keywords that you have inserted into all other topics are listed on the left side of the dialog.

4. If you want to add a keyword to the link, click on that keyword on the left (All Keywords) side
of the dialog. Then click [2] 1f you want to remove a keyword from the link, click on that
keyword on the right (Selected Keywords) side of the dialog. Then click [«]

Repeat this for each keyword that you want to add to or remove from the link. When you are
finished, the keywords associated with the link should be in the Selected Keywords section,
and the keywords not associated with the link should be in the All Keywords section.
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5. (Optional) If you want to specify other options for the control, click and in the dialog
select any of the following. Click OK to close the dialog when you are finished:

® Style Class You can select the style class to be used for the control.
® |abel You can change the text shown on the control.

® Display topics in You can specify that the links should be displayed in a popup menu
(same as default) or as a simple list.

NOTE For projects that are merged, the list option is supported for standard
merging (e.g., linking to an FLPRJ file in the table of contents). However, it is
not supported for automerging in WebHelp Plus output.

® Target Frame You can choose the type of frame used when a link is clicked:
» Page Default The destination file opens in the same window as the output window.

» Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

» New Window The destination file opens in a new browser window.
» Same Frame The destination file opens in the same frame as the current topic.

» Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its
own frameset.

» Popup Window The destination file opens in a popup box on top of the current topic.

6. Click OK. The Insert Keyword Link Control dialog closes, and the link is now changed.

7. Click[&ll to save your work.
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How to Edit the Style of a Keyword Link

You can edit the style of a keyword link. When you do this, the style changes for all keyword links in
any topics in your project. Also, keep in mind the various rules that pertain to keyword links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the Show Styles field and select Show Link Styles
or Show Dynamic Effects Styles. Different styles are displayed with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "keywordLink") if you want to
modify only concept links in your project.

CHAPTER 9

MadCap|helpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

MadCap|helpControlListltem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

MadCaplhelpControlListitemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

MadCap|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

MadCap|helpControlMenultem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.

MadCaplkeywordLink Edit this style to change the look of the heading for keyword
links. The following three keyword link styles inherit properties from this style.

MadCapl|keywordLinkControlList Edit this style to change the look of the entire list (<ul>
element) when keyword links are displayed in a list, rather than in a popup.
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= MadCap|keywordLinkControlListltem Edit this style to change the look of individual
items in the list (<li> elements) when keyword links are displayed in a list, rather than in

a popup.

® MadCapl|keywordLinkControlListltemLink Edit this style to change the look of links in
the list (<a> elements) when keyword links are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCaplkeywordLink.focus or MadCap|keywordLink.hover) if you want to modify the
look of the keyword link when it is in a certain state (e.g., when it has focus or when
the cursor is hovering over it).

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assorted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button =] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

For example, to change the link label, you would edit the mc-label property.

9. CIicklE' to save your work.
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| Deleting Keyword Links

There are two parts to a keyword link—(1) the keyword link itself and (2) the index markers inserted
into topics that associate the topic with a particular keyword link. The following steps show you
how to delete both.

How to Delete a Keyword Link

If you no longer need a keyword link that you have previously inserted into a topic, you can delete it
from a topic.

1. Open the content file.
2. Right-click the keyword link that you want to delete.

3. From the context menu, select Delete. The keyword link is removed from the topic.

4. CIicklE' to save your work.

How to Delete an Index Marker

The following steps show you how to delete an index marker that you have previously inserted into
a topic so that the topic is no longer associated with a particular keyword link.

1. Open the content file.
2. Right-click the index marker that you want to delete.

3. From the context menu, select Delete. The index marker and its keywords are removed from
the topic.

4. CIicklE' to save your work.
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CHAPTER 10

Links to Web Topics

If you generate HTMLS or WebHelp, WebHelp Plus targets, you can create links to specific topics in
the output.

This chapter discusses the following:

Creating Links to HTMLS TOPICS ....oooiiiii e 157
Creating Links to WebHelp and WebHelp Plus Topics .................... 159
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| Creating Links to HTMLS Topics

You can create links to specific topics in HTML5 output. You can also create links that incorporate
search strings and skin references.

How to Create Links to HTMLS Topics

1. Perform the steps for creating one of the following kinds of links:
® "Creating Image Maps" on page 133
® "Inserting Image Hyperlinks" on page 120
® "Inserting Text Hyperlinks" on page 237
® ‘Inserting Topic Popups" on page 363
2. Inthe dialog that opens for creating the link, click the Link to field and select Website.
3. Enter the path to the website. You can also include a specific topic, a search string, and/or

skin. When inserting the link, you can use the following structure.

http://[website]/[main entry file].htm#[path/name of topic]&searchQuery=[search
string]&firstPick=true&skinName=[skin name]

After the hash mark (#), you can specify any combination of the parameters (cshid,
searchQuery, firstPick, skinName), separated by ampersands (&). The order of the
parameters does not matter:

® Main entry file Provide the path to the main entry file for your output. The file name is
determined by whatever you enter into the Output File field in the General tab of the
Target Editor. If you do not provide a name in this field, the name "Default” will be used.

® searchQuery This is an optional element that automatically performs a search for a
specific string.

® firstPick This element can be used in conjunction with the search string. If you include
the first pick option, the first topic found with the specified search string will be opened
automatically. If you do not include this element, the search results will simply be
displayed; the first topic will not be opened automatically.

® skinName You can specify a skin directly in the link, which will override the skin
associated with that topic in the CSH alias file.
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ﬁ EXAMPLES In the following examples, these values are used:
® Default.htm = main entry file name
® Soccer.htm = topic in the project, located in subfolder called "Sports"
® World Cup Standings = search term

B Green = skin name

<a href="http://my.mycompany.com/Default.htm#Sports/Soccer.htm">Click here to
open</a>

<a href="http://my.mycompany.com/Default.htm#searchQuery=World Cup
Standings&firstPick=true">Click here to open</a>

<a
href="http://my.mycompany.com/Default.htm#Sports/Soccer.htm&skinName=Green">
Click here to open</a>
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| Creating Links to WebHelp and
WebHelp Plus Topics

(D IMPORTANT WebHelp and WebHelp Plus are deprecated in Flare Desktop, which means
that they are slated to be removed in a future version.

You can create links to specific topics in WebHelp and WebHelp Plus output. You can also create
links that incorporate search strings and skin references.

How to Create Links to WebHelp and WebHelp
Plus Topics

1. Perform the steps for creating one of the following kinds of links:
® "Creating Image Maps" on page 133
® “Inserting Image Hyperlinks" on page 120
® "Inserting Text Hyperlinks" on page 237
® ‘Inserting Topic Popups" on page 363
2. Inthe dialog that opens for creating the link, click the Link to field and select Website.
3. Enter the path to the website. You can also include a specific topic, a search string, and/or

skin. When inserting the link, you can use the following structure.

http://[website]/[main entry file] CSH.htm?[search string]|FirstPick#[path/name
of topic]|[skin name]

® Main entry file_CSH.htm This is the main entry file for your output. The file name is
determined by whatever you enter into the Output File field in the General tab of the
Target Editor. If you do not provide a name in this field, the name "Default” will be used.
After the file name, it is important that you add an underscore followed by "CSH."
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NOTE You do not need to include the "_CSH" portion in the file name of the
topic in Flare Desktop. You only need to add " _CSH" to the web page hyperlink
connecting to that topic.

® Search string This is an optional element that automatically performs a search for a
specific string.

® First pick This element can be used in conjunction with the search string. If you include
the first pick option, the first topic found with the specified search string will be opened
automatically. If you do not include this element, the search results will simply be
displayed; the first topic will not be opened automatically.

® Skin name You can specify a skin directly in the link, which will override the skin
associated with that topic in the CSH alias file.

In the following examples, these values are used:
® Default.htm = main entry file name
® Soccer.htm = topic in the project, located in subfolder called "Sports’
® World Cup Standings = search term

B Green = skin name

<a href="http://my.mycompany.com/Default_CSH.htm#Sports/Soccer.htm|Green">Click here to
open</a>

<a href="http://my.mycompany.com/Default_CSH.htm?World Cup Standings|FirstPick">Click
here to open</a>

NOTE You can complete similar URL link steps with context-sensitive Help (CSH)
identifiers.
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CHAPTER 11

Named Destinations

Supported In:

A named destination lets you point to a specific place in a PDF. In the Insert Hyperlink dialog, you
can create links to named destinations when using the "File in Project" option (if the PDF has been
added to your project) or "External File" option (if the PDF file exists outside of your project).

This process involves the following:

® Generate/Insert Named Destinations You can generate named destinations automatically in
a PDF everywhere a bookmark exists. Alternatively, you can insert named destinations into
content files manually.

® Create Links to Named Destinations You can insert hyperlinks to named destinations in a
PDF.

This chapter discusses the following:

How to Generate Named Destinations Automatically ...................... 167
How to Generate a Named Destination Manually ........................... 168
How to Create a Link to a Named Destination ............................... 169
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% EXAMPLE You plan to generate a PDF file from Flare Project A. Once that is done, you plan
to add the PDF to Flare Project B. And in one of the topics of Flare Project B, you create a
hyperlink that points to a specific paragraph in the PDF.

First, you open the topic or snippet in Flare Project A where the destination paragraph will
eventually exist in the PDF, and you insert a named destination at that location:

— Content Explorer L — More-Headings.htm

=3 - & & _ B Maore-Headings.htm Start Page = 2

5] - g Layout (Web) - Mediumn (default) ~ Page Layout % [ - b o

— Content
v || | A-Introduction-Topics
¢ Basic-Steps.htm
¢ Getting-Started.htm

¢ Headings.htm

Headings
In this example, we will

insert a named
N\

Lorem ipsum dolor rif amet, consecteftr adipiscing elit. Eul

| destination where we

| have placed the cursor, (\ mauris. Dondc sagiftis elemensum arcu, at gravida puam
-{ before this subheading.

ampaca = Subheading 1

Loremipsum dolor rit amet, consectettr adipiscing elit. Eul
mauris. Dondc sagittis elemensum arcu, at grayida puam

Subheading 2

Lorem ipsum dolor rif amet, consecteftr adipiscing elit. Eul

mauris. Dondc sagittis elemensum arcu, at grayida puam
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File Home Project Analysis Table
B E = - o
uttmedia | Clickingthis B .
- option._.. - -
Multimedia Links Single Source Text
= Content Explorer AL — More-Headings.htm
- | @ = |EE & _| /| More-Headingshtm x tart Page %
= & E o a3 | More-Headings.h L. Start Pag )
z Content Layout (Web) = Medium (default) ~ Page Layout - E-p~E-E-
v A-Introduction-T )
@ [ | Basic-Steps.h| - OpeHSthls
¢ Getting-Start dialog.
¢ Headings.hti -
¢ More-Headings.htm He g S
€ [ | Whats-New.htm
_|[] B-Feature-Topics . . o . .
=[] C-Procedure-Topics Lorem jpsum do f amet, consectettr adipiscing elit. Eusce blandit 5
= D-Reference - e
= Wl E-Frontmatter-Topics mauris. Dondg sagittis 9 MNamed Destination | =
] Resources i Name:
€ [ Homehtm We have provided i
the name Subheading1
"Subheading1 = ! Named destinations are used in PDF output to label certain
olor m locations in the document. These locations can then be linked to 5
= | directly from another|PDF document.
mauris. Dondc sagittis
Subheading 2
oK Cancel
Lorem ipsum dolor rit amet, consectefir adipiscing elif. Eusce blandif 5
mauris. Dondc sagiftis elemensum arcu, at gravida puam mollis id.
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ﬁ = Content Explorer AL — More-Headings.htm*
;ID M & & *| More-Headingshtm* = Start Page %
- =

[&] = | % Layout (Web) = Medium (default) ~ Page Layout = -~ |-~ |G

Content

v | | A-Introduction-Topics
€ [ | Basic-Steps.htm
¢ Getting-Started.htm
¢ Headings.htm

¢ More-l_—|eadings.htm Headings

Lorem ipsum dolor rit amet, consectettr adipiscing elit. Eusce blandit s

Anameddestination
marker is added where
the cursor was placed.

//

mauris. Dondc sagittis elemensum arcu, at gravida puam mollis id.

TToTre Fiern = u Subheadi... Subheading 1

Lorem ipsum dolor rit amet, consectettr adipiscing elit. Eusce blandit s

mauris. Dondc sagittis elemensum arcu, at gravida puam mollis id.

Subheading 2

Lorem ipsum dolor rit amet, consectettr adipiscing elit. Eusce blandit s
mauris. Dondc sagittis elemensum arcu, at gravida puam mollis id.

Next, you generate the output for the PDF.

Now you open Flare Project B. You could use a feature such as External Resources to add
the PDF to that project, or you could just copy and paste it in Windows.

Content Explorer

A-Introduction-Topics
B-Feature-Topics
C-Procedure-Topics

] D-Reference

= Resources

€ [ | Home.htm Hereis the
PDF.pdf generated PDF

from Project A.
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= Content Explorer

=k & PR

v

=]

Content
A-Intreduction-Topics
B-Feature-Topics

¢ Featurel.htm

¢ Feature.htm

¢ Feature3.htm

€ [ | Features.htm
C-Procedure-Topics
D-Reference
Resources
Homehtm
PDF.pdf

Feature 2

Lorem ipsum dolor rit amet, consectettr adipiél\

maurs.

Here is the link to the named destinationin the PDF:

Start Page =

RRE-R-E-

In this example, we
willinserta hyperlink
where this textis
highlighted.

it. Eusce bland

% Now you open a topic in Flare Project B, and you create a hyperlink that points to the
named destination in the PDF. You follow the steps for inserting a link into a file, and you

select the PDF file. Then you click &l and select the named destination that you created:

R = e

| FeatureZhtm x

g~ i Layout (Web) » Medium (default) = Page Layout

-l
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ﬁ Insert Hyperlink
In the Insert Hyperlink dialog, we

Link to: falas N
| selected File in Project.
File in Project e I
I
el All Files (%) [
| C””f';tt —— It might also be necessary to
. -Introduction-Topics = -
|| B-Feature Topics change the filter to All Files (*.7).
|| C-Procedure-Topics
|| p-Reference
| ] Resources
¢ Home.htm
PDF. pdf We selected the PDF.
I
|
ey d Because we selected a PDF, this
icon is shown. So we click it to
Link Properties selectthe named destination.
L"‘lk TEXt: |d":kk hEFE _
Screen Tip: |
Destination Mame Page
nSubh ding1 7

And here isthe
named
destination.

Cancel

Now when you generate the output from Project B, you can click on the hyperlink in that
output, and the PDF will open to the specified paragraph.
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I How to Generate Named Destinations
Automatically

1. Open the PDF target that will contain the named destinations (i.e., hyperlinks in another file
will point to these destinations).

2. Select the PDF Options tab.

3. Inthe Document Properties area, click Create named destinations for bookmarks.

NOTE This does not remove bookmarks. It simply creates named destinations next
to other bookmarks in the generated PDF if they exist.

4. Click[&l to save your work.
5. Generate and publish the PDF.
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I How to Generate a Named Destination
Manually

. Open the topic where you want insert a named destination (i.e., hyperlinks in another file will
point to the PDF holding this destination).

2. Click in the topic where you want to insert a named destination (e.g., in front of a subheading
or a specific paragraph).

3. Select Insert > Named Destination.
The Named Destination dialog opens.

4. In the Name field, type a name for destination (do not use spaces).

5. Click OK. Anicon is displayed at the appropriate location in the document (as long as your
markers are turned on).

6. CIicklE' to save your work.

7. Generate and publish the PDF containing that topic.
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I How to Create a Link to a Named
Destination

1. Open the topic where you want the link to exist.
2. Highlight the text that you want to use as the link (or "hotspot").
3. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Insert > Hyperlink.
" Local Toolbar In the local toolbar of the XML Editor click [£]
® Keyboard Shortcut Press CTRL+K on your keyboard.
® Right-Click In the XML Editor, right-click and select Hyperlink.

4. From the Link to drop-down field select one of the following. Based on the option you choose,
the section below the field gives you a list of selections or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the PDF file that you want to link to and select it. By using the
buttons in the local toolbar, you can view all files in a list, view files in their folder structure,
and use other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

= Shows or hides the folders that the files are stored in.
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Option Description

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx = Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

EXTERNAL FILE

This option lets you search for a file outside your project. After you select this option, enter
the path to the PDF file in the field next to the External File button.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

5. After selecting the PDF, click (g
6. Inthe dialog that opens, select the named destination and click OK.

7. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previously
selected text in the topic.

8. (Optional) In the Screen Tip field you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.
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When you enter a screen tip, it is added as a <title> tag in the markup. In addition, an <alt>
(alternate text) tag is added with the same text. This is useful when it comes to accessibility.

For more information see the Help system.

9. (Optional) Next to the Style Class field click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles from your stylesheet to the
link. You can change the appearance of the link in the Stylesheet Editor. After you select a
style class in the dialog, click OK. The Style Class field displays the selected style. (If you do
not specify a style class, Flare Desktop uses the parent "a" style.)

10. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open (e.g., in another window, in a popup).

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

11. Click OK. The hyperlink is added to the topic.

12. CIicklE' to save your work.
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CHAPTER 12

Related Topics Links

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

A related topics link is a Help control that provides users with list of links to topics that you've
specified as being related to the current topic. This is similar to a concept link. You might use a
related topics link if you are applying it to a topic that you want to associate with specific topics but
you do not plan to reuse the same link in other topics.

This chapter discusses the following:

Inserting Related Topics LINKS ... 173
Editing Related Topics LiNKS ... ... 183
Deleting Related Topics LiNKS ... ... 190
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I Inserting Related Topics Links

There are a couple of methods to use for inserting related topics links. You can use the "drag-and-
drop” method or the "Insert ribbon" method.

How to Insert a Related Topics Link Using Drag-
and-Drop

1. Open the content file.

2. You can drag files from the Content Explorer or File List window pane:

® Content Explorer If you are using the Content Explorer, click the Show Files button ()
The Content Explorer splits into two halves. Then on the left half of the Content
Explorer, locate and select the folder containing the topics to be included in the related
topics link.

® File List Window Pane If you want to choose files from the File List window pane, make
sure you float and position it so that you can see both the File List window pane and
XML Editor.

3. Inthe File List window pane or on the right half of the Content Explorer, select the topics to be
included in the link. You can hold down the CTRL or SHIFT key and click the topic file names
to select individual topics or a range of topics.

4. Drag the selected files to the appropriate location in the topic in the XML Editor. As you drag
the files, a colored vertical bar shows you where the link will be inserted when you release
mouse button.

5. Release the mouse button. The Insert Related Topics Control dialog opens. The folders and
topic files available in the project are shown on the left. The files that you selected are
automatically added to the section on the right.
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6. (Optional) You can customize the related topics link in any of the following ways.

BOOKMARK

If you want a link to point to a particular bookmark within a topic, do the following.
a. Inthe Selected Topics area on the right of the dialog, click on the relevant topic.
b. At the bottom of the dialog click [}

c. Inthe Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.

STYLE CLASS
If you want to select the style class to be used for the control, do the following.
a. At the bottom of the dialog click =l

b. Inthe dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

LABEL

If you want to change the text shown on the control, do the following.
a. At the bottom of the dialog click =,
b. Inthe dialog, enter text in the Label field.
c. Click OK.
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POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. At the bottom of the dialog click =,

b. Inthe dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the table of contents). However, it is not supported for
automerging in WebHelp Plus output.

TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.
a. Atthe bottom of the dialog click ,

b. Inthe dialog, click the down arrow in the Target Frame field and select any of the
following.

® Page Default The destination file opens in the same window as the output
window.

® Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

® Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.
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CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than

alphabetically), do the following.

a.

b.

C.

move up or down.

At the bottom of the dialog click [l or [

7. Click OK. The related topics control is added to the topic.

Welcome

FictionSoff This is a related topics control in
, the output. In this example, a
Most onlinl bo01,0 menu s being usedwhen
informatiof e jink is clicked. Also the control
Is not using custom ordering;
therefore, the links are displayed
in alphabetical order in the popup.

ome page for

. Who is the Ty ser

1
2
3. Many also use
4
5

pics, such as "What'

(%]
Getting Started

Copyright © 201

Procedure 1

Procedure 2
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Click in the Use Custom Ordering field and select Yes.

In the Selected Topics area on the right of the dialog, click on a topic that you want to
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Welcome

FictionSoft, the best fictional software eve

Most online| Inthis example, a simple list is
information} being used for the related topics
your users. | control. Alsothe control is using
custom ordering; therefore, the
An ovel |inks are displayed in a specific
Featurd order, ratherthan alphabetically.

e page for d

WoRoW N

Links to other s, such as "What's
%l Related Topics

e Procedure 1

* Procedure 2
e Getting Started

8. CIicklE' to save your work.
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How to Insert a Related Topics Link Using the

Insert Ribbon

1.
2.

Open the content file.

In the XML Editor, click in the topic where you want to insert the link (usually at the bottom of

the topic).

Select Insert > Related Topics Control.

The Insert Related Topics Control dialog opens. The folders and topic files available in the

project are shown on the left.

On the left side of the dialog, either double-click a topic that you want to add to the related
topics control, or select the topic and click . After doing this, the topic is added to the

Selected Topics area on the right side of the dialog.

You can use the "multi-view" to locate topics.

Options

Use these buttons to
Al Topice change the view for [pd Topics
BE the topics. Bookmark Path
_,‘ Content Procedure 1htm
7| | [ | Contacting Procedure 2 htm

—[ ][ | Getting_Started -

S Dt s

] Resources

-2 [ ] Using

-@

@ ‘whats new. htm

Use Custom Ordering:

=] Ealr—
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Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

[

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder
is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

*x - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).
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5. (Optional) You can customize the related topics link in any of the following ways.

BOOKMARK

If you want a link to point to a particular bookmark within a topic, do the following.
a. Inthe Selected Topics area on the right of the dialog, click on the relevant topic.
b. At the bottom of the dialog click [}

c. Inthe Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.

STYLE CLASS
If you want to select the style class to be used for the control, do the following.
a. At the bottom of the dialog click =l

b. Inthe dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

LABEL

If you want to change the text shown on the control, do the following.
a. At the bottom of the dialog click =,
b. Inthe dialog, enter text in the Label field.
c. Click OK.
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POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. At the bottom of the dialog click =,

b. Inthe dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the TOC). However, it is not supported for
automerging in WebHelp Plus output.
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TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click =1

b. Inthe dialog, click the down arrow in the Target Frame field and select any of the
following.

® Page Default The destination file opens in the same window as the output
window.

® Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

® Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.

CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than
alphabetically), do the following.

a. Inthe Selected Topics area on the right of the dialog, click on a topic that you want to
move up or down.

b. Atthe bottom of the dialog click [ or [#.

c. Clickin the Use Custom Ordering field and select Yes.

6. Click OK. The related topics control is added to the topic.

7. Click@ to save your work.
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| Editing Related Topics Links

You can edit a related topics link that you have inserted into a topic.

How to Change the Topics Associated With a
Related Topics Control

The first way to edit a related topics control is to change the topics associated with it.

Y% EXAMPLE You have a related topics link that has five topics associated with it. You might
then create a new topic, which you decide should be included in the link as well. The steps
below show you how to edit the related topics link to add that new topic to the link.

1. Open the content file.
2. Inthe XML Editor, right-click the related topics link.

3. Inthe context menu, select Edit Related Topics Control. The Insert Related Topics Control
dialog opens. The topics currently associated with the link are listed on the right side of the
dialog. All of the content files and folders in your project can be viewed on the left side of the
dialog.
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4. On the left side of the dialog, either double-click a topic that you want to add to the related
topics control, or select the topic and click . After doing this, the topic is added to the
Selected Topics area on the right side of the dialog.

You can use the "'multi-view" to locate topics.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

5. If you want to remove a topic from the link, click on that topic on the right side of the dialog.

Then click .

6. Click OK. The Insert Related Topics Control dialog closes, and the link is now changed.

7. Click@ to save your work.
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How to Change the Options for a Related Topics
Control

You can change the options for a related topics control, modifying elements such as the control
label or the way the links are presented (e.g., popup menu or list).

1. Open the content file.
2. Inthe XML Editor, right-click the related topics link.

3. Inthe context menu, select Edit Related Topics Control. The Insert Related Topics Control
dialog opens. The topics currently associated with the link are listed on the right side of the
dialog. All of the content files and folders in your project can be viewed on the left side of the
dialog.

4. You can customize the related topics link in any of the following ways.

ADD BOOKMARK
If you want a link to point to a particular bookmark within a topic, do the following.

a. Inthe Selected Topics area on the right of the dialog, click on the relevant topic.
b. Atthe bottom of the dialog click .

c. Inthe Select Bookmark dialog, click on a heading or bookmark within the topic. If you
select a heading, a bookmark will be created at that spot in the topic.

NOTE If you want to remove a bookmark from the link, you can select the
bookmark in this dialog and click . This removes the bookmark from the link
only; it does not remove the bookmark from the destination topic.

d. Click OK.
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STYLE CLASS
If you want to select the style class to be used for the control, do the following.
a. At the bottom of the dialog click =1

b. Inthe dialog, click on the style class you want to use. The main style is
"MadCap:relatedTopics," but if you create a class under that style in your stylesheet, it
will be available for selection as well.

c. Click OK.

If you want to edit the actual style in the stylesheet, see the set of steps below.

LABEL
If you want to change the text shown on the control, do the following.
a. At the bottom of the dialog click =,

b. Inthe dialog, enter text in the Label field.
c. Click OK.

POPUP MENU OR LIST

If you want to specify that the links should be displayed in a popup menu (default) or as a
simple list, do the following.

a. Atthe bottom of the dialog click ,

b. Inthe dialog, click the down arrow in the Display topics in field and select Popup Menu
or List.

c. Click OK.

NOTE For projects that are merged, the list option is supported for standard merging
(e.g., linking to an FLPRJ file in the table of contents). However, it is not supported for
automerging in WebHelp Plus output.
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TARGET FRAME

If you want to choose the type of frame used when the link is clicked, do the following.

a. At the bottom of the dialog click =1

b. Inthe Related Topics Link Options dialog, click the down arrow in the Target Frame
field and select any of the following.

Page Default The destination file opens in the same window as the output
window.

Parent Frame The destination file opens in the parent frame of the current topic
while hiding that topic.

New Window The destination file opens in a new browser window.
Same Frame The destination file opens in the same frame as the current topic.

Top Frame The destination file opens in the same output window, removing all
other framesets. You might use this option, for example, if the destination topic
has its own frameset.

Popup Window The destination file opens in a popup box on top of the current
topic.

c. Click OK.

CUSTOM ORDER

If you want to specify that the links should be displayed in a custom order (rather than
alphabetically), do the following.

a. Inthe Selected Topics area on the right of the dialog, click on a topic that you want to
move up or down.

b. Atthe bottom of the dialog click [ or [#.

c. Clickin the Use Custom Ordering field and select Yes.

5. Click OK.

6. Click@ to save your work.
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How to Edit the Style of a Related Topics
Control

You can edit the style of a related topics link. When you do this, the style changes for all related
topics links in any topics in your project. Also, keep in mind the various rules that pertain to related
topic links.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the Show Styles field and select Show Link Styles
or Show Dynamic Effects Styles. Different styles are displayed with each filter.

4. On the left side of the editor, find and select one of the following styles, depending on what
you want to accomplish. You can use a general style (which starts with "helpControl") if you
want to modify all types of Help control links (concept, keyword, and related topic links).
Alternatively, you can use a specific style (which starts with "relatedTopics") if you want to
modify only concept links in your project.

® MadCaplhelpControlList Edit this style to change the look of the entire list (<ul>
element) when links are displayed in a list, rather than in a popup.

® MadCap|helpControlListltem Edit this style to change the look of individual items in the
list (<li> elements) when links are displayed in a list, rather than in a popup.

® MadCap|helpControlListltemLink Edit this style to change the look of links in the list
(<a> elements) when links are displayed in a list, rather than in a popup.

® MadCapl|helpControlMenu Edit this style to change the look of links (i.e., menu items)
when links are displayed in a popup, rather than in a list. This particular style controls
the entire list.

® MadCapl|helpControlMenultem Edit this style to change the look of links (i.e., menu
items) when links are displayed in a popup, rather than in a list. This particular style
controls the individual list items.
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® MadCap|relatedTopics Edit this style to change the look of the heading for related topic
links. The following three related topic link styles inherit properties from this style.

® MadCap|relatedTopicsControlList Edit this style to change the look of the entire list
(<ul> element) when related topics are displayed in a list, rather than in a popup.

® MadCap|relatedTopicsControlListltem Edit this style to change the look of individual
items in the list (<li> elements) when related topics are displayed in a list, rather than in

a popup.
® MadCaplrelatedTopicsControlListltemLink Edit this style to change the look of links in
the list (<a> elements) when related topics are displayed in a list, rather than in a popup.

NOTE You can also change a pseudo class of a link style (e.g.,
MadCap|relatedTopics.focus or MadCap|relatedTopics.hover) if you want to modify
the look of the related topic link when it is in a certain state (e.g., when it has focus or
when the cursor is hovering over it).

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [ to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click@ to save your work.
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| Deleting Related Topics Links

If you no longer need a related topics link that you have previously inserted into a topic, you can
delete it from a topic.

How to Delete a Related Topics Control

1. Open the content file.
2. Right-click the related topics link that you want to delete.
3. From the context menu, select Delete. The related topics link is removed from the topic.

4. Click[&l to save your work.
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CHAPTER 13

Relationship Tables and Links

Supported In:
HTML
PDF WORD ECLIPSE B FpyB u':fu PPTX WEB
HELP HELP HELP

A relationship table is an element used to link related topics together. It is similar to concept links or
related topics links. Although a relationship table is a common feature in DITA, you do not need to
be using DITA or know anything about DITA in order to take advantage of relationship tables.

If you import content from DITA files that already contain relationship tables, those tables are
retained in Flare Desktop. You can also create new relationship tables in a Flare project and insert
relationship proxies into individual topics. In online output, the end result is one or more hyperlinks
that let users quickly open related topics. In print-based output, the end result is one or more
references to related topics with the appropriate page number(s).

This chapter discusses the following:

General Information for Relationship Links .................................... 192

Process for Relationship LiNKS ... 204
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I General Information for Relationship
Links

There are various pieces of general information you should know if you plan to use this feature.

Benefits of Relationship Tables

Following are some of the primary benefits of using relationship links, as opposed to related topic
links or concept links:

® You can create all of your link information in one place, in a single relationship table.

® You can have multiple types of links at the bottom of topics (e.g., one for "Related
Information," one for "Related Tasks," and one for "Reference Materials").

® |nonline output, the links are automatically represented as hyperlinks. In print-based output,
the links are automatically represented as a list of related topics with page number
references.
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Relationship Table Components

Following are the basic components of a relationship table.

Columns

By default, a relationship table has three columns, each named after three basic topic types—
Concept, Task, and Reference.

® Concept Topics that contain basic information and descriptions about a subject.

® Task Topics that provide step-by-step procedures for accomplishing something.

m Reference Topics that provide detailed reference material.

If necessary, you can add more columns to a relationship table, naming the other columns anything

you want.

Here is a relationship table with
the three defaultcolumns
(concept, task, reference).

You can click this button to
add anothercolumn.

[
Relationship Table £ [ & [ B = jﬁd Warnings
Row Mame cencept task reference
4 Birds Birds/Concepts/About B... Birds/Tasks/Choosing_a... Birds/References/List of ...
Cats & Cats/Concepts/About Cats/References/List of ...
Dogs e Dogs/Concepts/Ab Dogs/Tasks/Choosing_ Dogs/References/List of ...

Here is the first
column heading.

Here is the second
column heading.

CHAPTER 13

Here is the third
column heading.
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Rows

You can have many rows in a relationship table, with each cell containing one or more topic names,
placed in the appropriate column. The relationships between the different topics are defined across

each row.

This relationship table has three
rows (Birds, Cats, Dogs).

You can click this button
to add another row.

Relationship Table £ = & R E{:-':i-:, Warnings
Row Mame concept task reference

4 Birds |G Birds_r'C@cepts_f'About E... ‘ © Birds/Tasks/Choosing_a... © Birds/References/List of ...
Cats & Cats/Concigts/About C. e Cats/References/List of ...
Dogs € Degs/Concept\M\bout ... © Dogs/Tasks/Choesing_a... Lo Dogs/References/List of ...

These cells are
optional. You are not
required to name
each row.

This is a link to a topic called "About
Birds " It has relationships with the other
topic links in the same row, not with any

of the topics in the Cats or Dogs rows.
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Relationship Links

When you insert topic references into a row in a relationship table, those topics will link to the other
topics in the row in some way.

Following are the types of links that you can create.

® Normal (default) This is a two-way link. In other words, a link will be displayed in each topic
involved, and that link will open the other topic.

® Source Only This is a link where the topic in question will have a link to other topics, but other
topics will not have a link back to it.

® Target Only This is a link where the topic in question will not have a link to other topics, but
other topics will have a link back to it.

® Use CONREF Target This uses the conref attribute to pull content. The conref attribute
references an ID on content that can be reused. For Flare outputs other than DITA, this option
is not supported. For more detailed information about DITA and the conref attribute, please
refer to: www.oasis-open.org/committees/dita/

Unless you leave the default link setting, relationship links are identified by a blue background when
you set them. To identify the exact kind of relationship link applied to an item, you can select the
item and then click the appropriate Properties button in the local toolbar.

You can specify links on individual topic items, on cells (which can contain multiple items), or on
entire columns.

® Links on Items Each topic item in a relationship table can use a different kind of link.

® Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use that
same setting (unless you later override the setting on individual items).

® |inks on Columns If you apply a link type to a column, all of the topic items in all cells will use
that same setting (unless you later override the setting on individual items or cells).
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This tapic is defined as a "Source Only" link.
This means that when you open this topicin
the output, it will contain a link to the other
cat topic in this row. However, the other
topic will not contain a link to this topic.

/ 7

Relaticnship Table
Row Marme concept task
4 Birds e Bi oncepts/About B... ©
Cats & ats/Concepts/About C...
Dogs @ Dogs/Concepts/About ... | &

Birds/Tasks/Choosing_a...

Dogs/Tasks/Choosing_a...

This topic is defined as a "Target Only"
link. This means that when you open
this topic in the output, it will not
contain a link to the other dog topics in
this row. However, the other dog topics
will contain a link to this topic.

Here is another way to look at it.
The arrows show the direction of
the links from one topic to another.
Notice that for the "blue” topics, the
lines point only one way.

Warnings
reference

G Birds/References/List of ...
& Cats/References/List of ...

o Dogs/References/List of ...

Row concept task

reference

Birds About Birds <

» Choosing a Bird €————p» List of E'.*d Breeds

Cats About Cats

—— P Choosing a Cat —————» List of Cat Breeds

Dogs

About Dogs €———

—» Choosing a Dog

—J» List of Dog Breeds
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Groups

You can group topics in the same cell so that they function as a unit or are related to one another.
When you group items together, you can choose a collection type to specify how the items within
the group behave.

Following are the collection types that you can use:

® Unordered (default) This displays the grouped links in the output, but the order in which they
are displayed is not important.

® Family This lets you display links not only to adjacent topics in the row, but to other topics
grouped within the same cell as well.

ﬁ EXAMPLE You have a row that is populated like this:
Topic A is in the "concept" cell.
Topics B, C, and D are contained in a group in the "task” cell.
Topic Eis in the "reference" cell.

Suppose you do not use the Family collection type. In that case, when a user opens
Topic A, he will see links to Topics B, C, D, and E. However, when the user opens
Topic C, he will see links to Topic A and Topic E, but not to Topics B and D.

Now suppose you do use the Family collection type. In that case, when a user opens
Topic C, he will see links not only to Topics A and E, but to Topics B and D as well.

® Sequence This displays links with significance given to how the links are ordered in the
output. For Flare outputs other than DITA, this option is not supported. For more detailed
information about DITA and the sequence option, please refer to:

WWW.0asis-open.org/committees/dita/
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® Choice This lets you specify which link should be "selected" or "highlighted" from the group of

links. For Flare outputs other than DITA, this option is not supported. For more detailed
information about DITA and the choice option, please refer to:

WWW.0asis-open.org/committees/dita/

® Use CONREF Target This uses the conref attribute to pull content. The conref attribute

references an ID on content that can be reused. For Flare outputs other than DITA, this option
is not supported. For more detailed information about DITA and the conref attribute, please

refert

O:

WWW.0asis-open.org/committees/dita/

Unless you leave the default link setting, collection types are identified by a green background when
you set them. To identify the exact kind of group applied, you can select the item and then click the
appropriate Properties button in the local toolbar.

You can specify collection types on individual items in a group or on entire columns:

® Collection Types on Items in Groups Each group item in a relationship table can use a

different kind of collection type.

® Collection Types on Columns If you apply a collection type to a column, all of the groups in

that column will use that same setting (unless you later override the setting on individual

groups).

"About Dogs" topic on the left and the "List
of Dog Breeds" topic on the right. B\\ &=

This cell has three task topics. By default,
each of these three topics will link to the

[l

Warnings

Cats

reference

e Birds/References/List of .

Row Name concept
W e Birds/Concepts/About B... ENirds/Tasksthoosing_a_Eird....

© Cats/Concepts/About C...

e Cats/References/List of ...

E‘ it

epts/About ... & D}gs.fTasksthoosing_a_Dog .

Dogs

However these
topics will not link to
each other.

& Dogs/Tasks/Feeding_a_Dog.h...
[ Dogs/Tasks/Grooming_a_Do...
]

© Dogs/References/List of ...
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v
About Dng{(

e Feeding a Dog/

Grooming a Dog

Row concept task reference
Bird) Here is the way it would work Choosing a Bird List of Bird Breeds
for that row.
Cats About Cats Choosing a Cat List of Cat Breeds
Dogs P Choosing a Dog ——————

%st of Dog Breeds

Now the topics in this cell
have been placedin a
group usingthe "Family"

Relationship Table collection type E = Warnings
Row MNarme concept reference
b Birds & Birds/Concepts/Abo & Birds/Tasks/Choosing_a... & Birds/References/List of ...
Cats e Cats/Concepts/About C... (o) Cats/References/List of ...
e Degs/Concepts/About ... [J] [GROUP] & Dogs/References/List of ...
® Deogs/Tasks/Cheoosin...
Dogs
& Dogs/Tasks/Feeding_...
® Deogs/Tasks/Groemin...
CHAPTER 13
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reference

List of Bird Breeds

Row concept task
By creating the group, the
Bird] links work this way for the Choosing a Bird
Dogs row.
Cats About Cats Choosing a Cat

List of Cat Breeds

Dogs About Dot

» Choosing a Dog {—%st of Dog Breeds

e Feediphg %og/

Grooming a Dog

Conditions

Like most everything else in Flare Desktop, you can apply condition tags to the elements within a
relationship table. That is why you see squares next to the elements. If you apply a condition tag to

something (e.g., topic reference, group), the square will display the color associated with that

condition tag. You can show or hide the condition tags if you want.

CHAPTER 13

Relationship Table

You can click this How Name concept
buﬁp” to hide the 3 Birds ® Birds/Concepts/About B...
condition tag squares.
Cats (o Cats/Concepts/About C...

© Dogs/Concepts/About ...

Dogs

Warnings
task reference
G Birds/Tasks/Choosing_a... @ Birds/References/List of ...
(o) Cats/References/List of ...

[z] [GROUP] (o) Dogs/References/List of ...

© -

Acondition tag
e associated with the color
® Dogs/Tasks/Groomin... red has been app"ed to

this topic reference.
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Rules for Relationship Tables

Following are some basic rules when it comes to creating relationship tables:

Relationships are expressed within individual rows only. Relationships do not exist between

rows in a table.
Not every cell in a row needs to have a topic link.
Multiple topic links can be added to a single cell.

You can add the same topic link in many different rows.

Relationships Proxy

After you create at least one relationship table, you can insert a Relationships proxy into the topics
where you want the links to appear in the output. When you build the output, the proxy is replaced
by the generated links.

Thisis a
Relationships proxy
inserted into a topic.

= About Dogs

According to Webst
carnivore bred in

,adogis "a domesticated

eat many varieties."

Dogs are very pgbular as family pets. You can do

many things dogs.

relations hips proo;
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Hereisthe online
output for a topic that
includes relationship

links atthe bottom |
(replacing the proxy).

You are here: Dogs = About Dogs

About Dogs

According to Webster's, a dog is "a domesticated carnivore
bred in a great many varieties."”

Dogs are very popular as family pet Notice that the

things with dogs. relationship links are
separated based on

their categories in the
Related Tasks relationship table (i.e.,
Choosing a Doag task, reference).

Feeding a Dog

Grooming a Dog

Reference Materials

List of Dog Breeds
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Here is the print-based output for a
topicthatincludes relationship links
at the bottom (replacing the proxy). About Dogs
MNotice that, instead of hyperlinks,
page numbers are shown.

About Dogs

According to Webster's, a dog is "a domesticated camivore bred in a great
many varieties."

Dogs are very popular as family pets. You can do tons of things with dogs.

Related Tasks

Choosing a Dog. . 4

Feeding a DoOO. . i8S

Grooming @ DOQ.. ..o B
Reference Materials

Listof Dog Breeds ... 9

CHAPTER 13 203



| Process for Relationship Links

Certain tasks must be completed in order when using this feature.

Adding Relationship Table Files

The first step in using a relationship table is to add a new file to the Advanced folder in the Project
Organizer. You can add as many relationship table files as you need. Depending on your project, you
may need just one relationship table or many. For example, you might want to use Relationship
Tables 1 and 2 when generating Target A, but you might want to use Relationship Table 3 when
generating Target B.

How to Add a Relationship Table File

1. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Project > New > Advanced > Relationship Table.

® Right-Click In the Project Organizer, right-click on the Advanced folder and from the
context menu select Add Relationship Table.

The Add File dialog opens.
2. Inthe File Type field at the top, make sure Relationship Table is selected.
3. Inthe Source area, choose to create the new file based on a template or an existing file.

® New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

® New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click =], use the Open File dialog to find a file, and
double-click it.
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4. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click 2] and select the subfolder. Otherwise,
keep the default location.

5. In the File Name field, type a new name for the relationship table file.

6. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click [z] and select the conditions you
want to apply. Click OK.

7. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click ] and select the file tags you want to apply. Click OK.

8. Click Add. The relationship table file is added to the Advanced folder in the Project Organizer.
The Relationship Table Editor opens to the right.
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Creating Relationship Tables

After adding a relationship table file, you can create the actual content for it, adding relationships
between the topic links in a row.

How to Create a Relationship Table

1. Open the relationship table that you want to work on. The Relationship Table Editor opens to
the right. If you do not yet have a relationship table, see "Adding Relationship Table Files" on
page 204.

2. Use the editor to perform any of the following tasks. Keep the following in mind as you work:

® Relationships are expressed within individual rows only. Relationships do not exist
between rows in a table.

® Not every cell in a row needs to have a topic link.
® Multiple topic links can be added to a single cell.

® You can add the same topic link in many different rows.

TO GIVE A ROW A NAME

This simply helps you distinguish one row from another.
a. Highlight a row.
b. In the local toolbar click [E].
c. Inthe Row Type field, enter a name.

d. Click OK.
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TO INSERT A ROW
B |nthe Iocaltoolbarclick.

This relationship table has three
rows (Birds, Cats, Dogs).

You can click this button
to add another row.

These cells are
optional. You are not
required to name
each row.

This is a link to a topic called "About
Birds " It has relationships with the other
topic links in the same row, not with any

of the topics in the Cats or Dogs rows.

Relationship Table £ B B B E{_:’:——L._L Warnings
Row Mame concept task reference
3 Birds ‘G Birds_a'Co{ueptE_fAbc-ut B... | © Birds/Tasks/Choosing_a... © Birds/References/List of ...
Cats © Cats/Concigts/About C... © Cats/References/List of ...
Dogs © Dogs/Conceptybout ... © Dogs/Tasks/Choosing_a... © Dogs/References/List of ...

TO RENAME A COLUMN

a. Highlight any cell in the column you wan

t to rename.

b. Inthe local toolbar click to run the Column Properties dialog.

c. Inthe Column Type field, enter a name.

d. Click OK.
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TO INSERT A COLUMN

In addition to the Row Name, a relationship table has three additional columns, each named
after three basic topic types—Concept, Task, and Reference. You can add more columns if
you want.

® |nthe local toolbar click .

Here is a relationship table with
the three default columns
(concept, task, reference).

You can click this button to
add anothercolumn.

S
-

Relationship Table £ B B E = | Warnings
Row Name cpncept task reference

€

Birds/References/List of ...

» Birds Birds/Concepts/About B...

& Cats/Concepts/About
® Dogs/Concepts/Ab

Birds/Tasks/Cheoosing_a...

Cats Cats/References/List of ...

Dogs & Dogs/Tasks/Choosing_ Dogs/References/List of ...
Here is the first Here is the second Here is the third
column heading. column heading. column heading.

TO ADD ATOPICITEM TO A CELL

a. Click a cell where you want to insert a topic reference.
b. Inthe local toolbar click.

c. Inthe Open dialog, locate and double-click the topic. The topic file name is added to
that cell. The square next to the file name is used to show any condition tags applied to
the link.

TO SELECT THE LINK TYPE FOR A TOPIC ITEM, CELL, OR COLUMN

When you insert topic items into a row in a relationship table, those topics will link to the
other topics in the row in some way. If you do not want to use the default type of link, you can
select another kind. You can do this for individual topic items, entire cells, or entire columns.

® Links on Iltems Each topic item in a relationship table can use a different kind of link.

® Links on Cells If you apply a link type to a cell, all of the topic items in that cell will use
that same setting (unless you later override the setting on individual items).
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® Links on Columns If you apply a link type to a column, all of the topic items in all cells
will use that same setting (unless you later override the setting on individual items or

cells).

Following are the steps for selecting link types.

a. Do one of the following:

For Columns Click in a column. In the local toolbar click [E]
OR

For Cells Click in a cell. In the local toolbar click [Z]

OR

For Topic Link Items Click a topic link item in a cell. In the local toolbar Click.

b. Click in the Linking field and select one of the following.

CHAPTER 13

Source Only This is a link where the topic in question will have a link to other
topics, but other topics will not have a link back to it.

Target Only This is a link where the topic in question will not have a link to other
topics, but other topics will have a link back to it.

Normal (default) This is a two-way link. In other words, a link will be displayed in
each topic involved, and that link will open the other topic.

None This option indicates that the topic reference does not have a link.

Use CONREF Target This uses the conref attribute to pull content. The conref
attribute references an ID on content that can be reused. For Flare outputs other
than DITA, this option is not supported. For more detailed information about DITA
and the conref attribute, please refer to www.oasis-open.org/committees/dita/.

Unless you leave the default link setting, relationship links are identified by a blue
background when you set them. To identify the exact kind of relationship link applied to
an item, you can select the item and then click the appropriate Properties button in the
local toolbar.
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This topic is defined as a "Source Only" link.
This means thatwhen you open this topicin
the output, it will contain a link to the other
cat topic in this row. However, the other
topic will not contain a link to this topic.

]

Relaticnship Table Warnings
Row Mame concept task reference
» Birds © Bi oncepts/About B... © Birds/Tasks/Choosing_a... © Birds/References/List of ...
Cats (o ts/Concepts/About C... © Cats/References/List of ...
Dogs © Dogs/Cencepts/About ... © Dogs/Tasks/Choosing_a... (o Dogs/References/List of ...
This topic is defined as a "Target Only"
link. This means that when you open
this topic in the output, it will not
contain a link to the other dog topics in
this row. However, the other dog topics
will contain a link fo this topic.
Here is another way to look at it.
The arrows show the direction of
the links from one topic to another.
MNotice that for the "blue” topics, the
lines pointonly one way.
Row concept task reference
Birds About Birds €———9» Choosing a Bird €————» List of Bird Breeds
I
Cats About Cats ————— > Choosing a Cat €————» List of Cat BEreeds
Dogs About Dogs €———— Choosing a Dog > List of Dog Breeds
c. Click OK.
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TO GROUP SELECTED ITEMS

You can group topics in the same cell so that they function as a unit or are related to one

another. When you group items together, you can choose a collection type to specify how the

items within the group behave.

a. Inacell containing multiple items (topic references), hold your CTRL key and click the

items that you want to group.

b. In the local toolbar click [&l. The word "Group" is added to the cell.

each of these three topics will link to the

of Dog Breeds” topic on the right.

This cell has three task topics. By default,

\

"About Dogs" topic on the left and the "List

FMow Mame conce-pt

» ® Birds/Concepts/About B...

Birds/Tasks/Choosing_a_Bird....

E = Warnings

reference

© Birds/References/List of ...

Bird Here is the way it would work

Cats © Cats/Concepts/About C... © Cats/References/List of ...
f L “ epts/About ... G s/Tasks/Choosing_a_Dog... G' Dogs/References/List of ...
Dogs Howe?err these Dogs/Tasks/Feeding_a_Dog.h...
topics will notlink to ) ]
each other. Dogs/Tasks/Grooming_a_Do...
Row concept task reference

Choosing a Bird

List of Bird Breeds

for that row.
Cats About Cats Choosing a Cat List of Cat Breeds
Dogs About Dog{q‘) Choosing a Dog 1_yst of Dog Breeds
e Feeding a Dog(///’
Grooming a Dog
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have been p

Relationship Table

Row Name concept

Now the topics in this cell

group usingthe"Family”
collection type.

lacedina

=]

= Warnings

Birds/Concepts/Abo

task reference

Birds/Tasks/Choosing_a... © Birds/References/List of ...

Cats © Cats/Concepts/About C... © Cats/References/List of ...
G Dogs/Concepts/About ... [J] [GROUP] G Dogs/References/List of ...
© Dogs/Tasks/Choosin...
Dogs
© Dogs/Tasks/Feeding_...
© Dogs/Tasks/Groomin...
Row concept task reference
By creating the group, the
Bird] links work this way forthe Choosing a Bird List of Bird Breeds
Dogs row.
Cats About Cats Choosing a Cat List of Cat Breeds
Dogs About Dog{q‘) ChoosingéDog 1_yst of Dog Breeds
e Feedihg &Dog/
Grooming a Dog
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TO SELECT THE COLLECTION TYPE FOR A COLUMN OR TOPIC LINK ITEM

When you put items into a group, you can specify how that group will function as a collection
(e.g., in the images above the group is using the "Family" collection type, which means that
those topic items will reference each other in the output). You can do this for entire columns
or for individual topic items in a cell that have been grouped. If you set a particular collection
type on a column, all groups in that column will use that collection type.

a. Do one of the following:
® For Columns Click in a column. In the local toolbar click .

® For Topic Link Items Click a topic link item in a cell. In the local toolbar cIick.
b. Clickin the Collection Type field and select one of the following:

® Unordered (default) This displays the grouped links in the output, but the order in
which they are displayed is not important.

® Family This lets you display links not only to adjacent topics in the row, but to
other topics grouped within the same cell as well.

¢ EXAMPLE You have a row that is populated like this:
Topic A is in the "concept” cell.
Topics, B, C, and D are contained in a group in the "task” cell.
Topic Eis in the "reference" cell.

Suppose you DO NOT use the Family collection type. In that case, when a
user opens Topic A, he will see links to Topics B, C, D, and E. However,
when the user opens Topic C, he will see links to Topic A and Topic E, but
not to Topics B and D.

Now suppose you DO use the Family collection type. In that case, when a
user opens Topic C, he will see links not only to Topics A and E, but to
Topics B and D as well.

® Sequence This displays links with significance given to how the links are ordered
in the output. For Flare outputs other than DITA, this option is not supported.
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® Choice This lets you specify which link should be "selected" or "highlighted" from
the group of links. For Flare outputs other than DITA, this option is not supported.

® Use CONREF Target This uses the conref attribute to pull content. The conref
attribute references an ID on content that can be reused. For Flare outputs other
than DITA, this option is not supported.

NOTE For more detailed information about DITA and these options, please
refer to www.oasis-open.org/committees/dita/.

c. Click OK.

TO NEST ITEMS

After you add items to a cell, you can nest them by using the left and right arrows. If an item
is above and to the left of other items, it becomes the parent; the child items are below and to
the right of the parent. When this occurs, the child items inherit the settings from the parent
item (e.g., link type).

a. Click on atopic link in a cell that you want to move.

b. Inthe local toolbar, Click to move it to the left, or click %] to move it to the right.

TO MOVE ITEMS UP OR DOWN

If you have multiple topic items in a cell, they are displayed in the output in the order they are
shown. You can use the up and down buttons to change the order.

a. Click the topic item that you want to move.

b. Inthe local toolbar cliok to move the item up or to move the item down.

TO DELETE A ROW

a. Click in the row you want to delete.

b. Inthe local toolbar click E
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TO DELETE A COLUMN

a. Click in the column you want to delete.

b. Inthe local toolbar click .

TO SHOW OR HIDE CONDITIONAL INDICATORS

In a relationship table, condition tags are shown in the small squares next to topic file names.
This feature can be used to show or hide those squares.

® |nthe local toolbar click .

Warnings

You can click this concept task reference

buthm to hide the » m G Birds/Concepts/About B... G Birds/Tasks/Choosing_a... F Birds/References/List of ...
condition tag squares.

Cats [ Cats/Concepts/About C... ® Cats/References/List of ...
[ Dogs/Concepts/About ... | [2] [GROUP] ® Dogs/References/List of ...
[ asks/Choosin.. .
Dogs Acondition tag
€ Dogs/Tas associated with the color
(o Dogs/Tasks/Groomin... red hBS D?Eﬂ appliedto
this topic reference.

3. CIicklE' to save your work.

NOTE If there are any broken links in a relationship table, they will be identified by this icon:
4L You can then open the properties for that item and fix the link.

NOTE The three relationship link style classes in your stylesheet are designed to work in
sync with the column headings in the Relationship Table Editor. Therefore, if you rename a
column or create a custom column, make sure that you create a corresponding style class
in the stylesheet to control that column. For example, if you create a custom column with a
link type called "other," you should create a style class in the stylesheet named
"MadCap|relationshipsHeading.other." If you do not create a unique style class for the
custom column, it will use the settings from the parent MadCaplrelationshipsHeading style.
Therefore, the heading label will say "Related Information," instead of what you want it to
say.
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Opening Relationship Tables

After a relationship table file is added, you can open it at any time to work on it.

How to Open a Relationship Table From the Quick

Launch Bar

The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the

upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the

Quick Launch bar so you can begin typing.

= | | # Quick
el e _': quic

Attributes Find and )
Window Replace in Files ~ @ Fin
Attributes Find and Repl Properties

The Quick Launch bar
appears in the upper-right
comer of the interface.

1. Inthe Quick Launch bar, type a few letters of the name of the file you want to open. Any

available results appear in a drop-down list.

2. From the list, click the name of the file.

How to Open a Relationship Table From the Project

Organizer

1. Open the Project Organizer.

2. Double-click the Advanced folder.

3. Double-click the relationship table file. The Relationship Table Editor opens to the right.
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Inserting Relationship Links

You can insert a Relationships proxy in the topics where you want links to appear in the output,
using the information contained in your relationship table(s).

How to Insert a Relationship Link

1. Open the content file.

2. Place your cursor where you want to insert the link (usually at the bottom of the topic).
3. Select Insert > Proxy > Relationships Proxy.
The Relationships Proxy dialog opens.

4. (Optional) In the field labeled Stylesheet class for proxy, you can select a class to affect the
look of the relationship link.

You might create and use a proxy style class, for example, if you want to use a border special
border above the relationship links in the output. If you do not select a class from this field,
the generated link will use the style settings from the parent MadCap|relationshipsProxy
style. You have the option of creating a class for this proxy style in the Stylesheet Editor. To
do this, select the MadCap]relationshipsProxy style and in the local toolbar click Add Selector
to create a class. The class will then be available from this field.

5. Click OK. The proxy is added to the topic.

6. Click [l to save your work.
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Editing Relationship Link Styles

You can edit the look of relationship links by adjusting the appropriate styles in your stylesheet.
This might involve changing the look of any of the following: the container holding the links, the
heading(s) above the links, the link items themselves. The Simplified view of the Stylesheet Editor

lets you edit only some of the necessary styles; for the rest of the styles, you need to use the

Advanced view.

You are here: Dogs > About Dogs

About Dogs

According to Webster's, a dog i
bred in a great many varieties./

container, you can modify

By editing the style

the border on top of the

Feeding a Dog
Grooming a Dog

Reference Materials

List of Dog Breeds

links ar perhaps change
Dogs are very popular as fa the margin.
things with dogs.
Related Tasks LEEndn
headingthat you
Choosing a Dog can change.

You can also change the
look of the link items (e g,
choose another color,
reduce the font size).

About Dogs

many varieties."

Dogs are very popular as family pets. Yo

Related Tasks

Reference Materials

ChoosingaDog... = ... ...
Feeding @ Dog . oo
Grooming @ DOQ. ..« oo o

Listof Dog Breeds. ... ...

About Dogs

According to Webster's, a dog is "a domesg

For print-based output, you
can make different kinds of
modifications tothe link
items (e.g., change the
leader from dots to dashes).
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How to Edit the Container

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE Some of the necessary style properties can also be changed in the Simplified
view in the Stylesheet Editor.

w

In the upper-left corner of the editor, click in the drop-down field and select
|Reusable Content Styles *|'

4. On the left side of the editor, select the MadCaplrelationshipsProxy style.

5. From the Show drop-down list on the upper-right side of the editor, select
|Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

o

(Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .
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7. Following are some of the more common tasks that you may want to perform:

BORDER PROPERTIES

By default, a 1-pixel black border is already set, which separates the relationship links from
the topic content above.

a. If you are using the grouped view, expand the Border group.

b. Locate and select the border property you want to change. Each side (bottom, left, right,
top) has separate properties that you can set for the color, style, and width (e.g., border-
bottom-style). You can set these properties individually, or you can set the primary
property for each side (e.g., border-bottom), which lets you specify the color, style, and
width in one place. If you plan to have the same settings for all sides, you can use the
main border property to set the color, style, and width the same. The border-radius
properties let you create curved edges on the border by providing horizontal and
vertical values.

When you click ] next to a border property, a popup appears. Use the fields in the
popup to define additional properties such as color, width, style, and thickness, then

click OK.
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MARGIN PROPERTIES

By default, a 10-pixel top margin is already set. The margin is the space around the outside of
the container.

a. If you are using the group view, expand the Box group.

b. Locate and select the margin property that you want to change. Each side (bottom, left,
right, top) has separate properties that you can set (e.g., margin-bottom, margin-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main margin property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., margin, margin-bottom), a small popup displays.

i. Next to a margin property, click [=-1.
ii. Use the left side of the popup to enter a number for the amount of margin.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.

PADDING PROPERTIES

By default, 20 pixels of padding are set on the left side of the container, and 10 pixels of
padding are set on the top side. The padding is the space between the content inside the
container and its outer edges.

a. If you are using the group view, expand the Box group.

b. Locate and select the padding property that you want to change. Each side (bottom,
left, right, top) has separate properties that you can set (e.g., padding-top, padding-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main padding property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., padding, padding-bottom), a small popup
displays.

i. Next to a padding property, click [=-].
ii. Use the left side of the popup to enter a number for the amount of padding.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.
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8. Click[&l to save your work.
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How to Edit a Heading

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the Stylesheet Editor, click in the drop-down field and select
|Paragraph Styles - |

4. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

5. In the Styles section of the editor, expand the MadCap|relationshipsHeading style. Then
select the appropriate style class under it:

® concept This class lets you change the look of the heading that is displayed above any
concept links (i.e., any topics found in the "concept" column of the relationships table).

® reference This class lets you change the look of the heading that is displayed above
any reference links (i.e., any topics found in the "reference" column of the relationships
table).

® task This class lets you change the look of the heading that is displayed above any task
links (i.e., any topics found in the "task" column of the relationships table).

NOTE If you want to apply a setting that is used for all three of the classes, you can
select the parent MadCaplrelationshipsHeading style. Whatever you set for that style
will trickle down to the three classes, unless a different value is already specified on
that class.
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NOTE The three style classes mentioned above are designed to work in sync with
the column headings in the Relationship Table Editor. You can change the column
heading (i.e., link type) for any of these in the editor via the column properties dialog.
You can also create a custom column. But if you do this, make sure that you create a
corresponding style class in the stylesheet to control that column. For example, if
you create a custom column with a link type called "other," you should create a style
class in the stylesheet named "MadCap|relationshipsHeading.other." If you do not
create a unique style class for the custom column, it will use the settings from the
parent MadCaplrelationshipsHeading style. Therefore, the heading label will say
"Related Information," instead of what you want it to say.

6. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

7. Following are some of the more common tasks that you may want to perform.

HEADING TEXT (LABEL)

For the "concept" links, the default text is "Related Information." For the "reference" links, the
default text is "Reference Materials." For the "task" links, the default text is "Related Tasks."

To the right of mc-label, replace the default text.

FONT COLOR
The default color is black.

a. If you are using the grouped view, expand the Font group.

b. To the right of color, click =], and select a color. For advanced color options, C|iCk|;|

and use the fields in the Color Picker dialog, or click L= t0 select a color already used
elsewhere on your screen. You can use the Color Picker to select a CSS variable.
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FONT SIZE
The default size is 14 points.
a. If you are using the grouped view, expand the Font group.

b. To the right of font-size, click -], and complete the fields in the popup. Enter a number

in the field and use the down arrow in the lower-right corner to select a unit of
measurement.

c. Click OK.

NOTE You can also specify other style settings that can normally be done for fonts
or paragraphs.

8. Click[&l to save your work.
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How to Edit Link Items

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
|Character Styles - |

4. In the Styles section of the editor, select the MadCap|relationshipsltem style.

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assorted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group viewﬁ or an alphabetical view .
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7. Following are some of the more common tasks that you may want to perform.

LEADER ALIGNMENT (PRINT-BASED OUTPUT)

This determines how the page numbers are aligned at the end of the leader. The default
setting is right alignment.

To the right of mc-leader-align, click [, and select an alignment setting (center, left, right).

LEADER FORMAT (PRINT-BASED OUTPUT)

This is the material that is shown between a topic name and the page number where it can be
found. The default setting is a series of dots.

To the right of mc-leader-format, type whatever you want to be shown as the leader (e.g.,
dash, underline). Whatever you type will be repeated until the end of the leader.

LEADER INDENT (PRINT-BASED OUTPUT)

This is the amount of space from the end of the list entry to the start of the leader.
a. Totheright of mc-leader-indent, click [=1.
b. Use the lower-left area of the popup to enter a number.

c. Use the lower-right area to select a unit of measurement.

d. Click OK.

LEADER OFFSET (PRINT-BASED OUTPUT)

This is the amount of space from the end of the leader to the page number following it.
a. To the right of mc-leader-offset, click [=-].
b. Use the lower-left area of the popup to enter a number.
c. Usethe lower-right area to select a unit of measurement.

d. Click OK.
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MARGIN
This the amount of space around each item. The default setting is a left margin of 24 points.
a. If you are using the group view, expand the Box group.

b. Locate and select the margin property that you want to change. Each side (bottom, left,
right, top) has separate properties that you can set (e.g., margin-bottom, margin-left).
However, if you plan to have the same settings for all four sides, you can simply use the
main margin property to set the values all the way around. When you click in the cell to
the right of one of the properties (e.g., margin, margin-bottom), a small popup displays.

i. Totheright of a margin property, click [=].
ii. Use the left side of the popup to enter a number for the amount of margin.

iii. Use the right side of the popup to select a unit of measurement (e.g., point, pixel,
centimeter) for the number you entered.

iv. Click OK.

FONT COLOR

The default color is black. The following instructions show you how to change the font color
for print-based output. For online output, the color is based on the settings on the "a" style,
which controls the look of all text hyperlinks in your output. To change this, see "Editing Text
Hyperlinks" on page 244.

a. If you are using the grouped view, expand the Font group.

b. To the right of color, click =], and select a color. For advanced color options, C|iCk|;|

and use the fields in the Color Picker dialog, or click L= t0 select a color already used
elsewhere on your screen. You can use the Color Picker to select a CSS variable.
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FONT SIZE
The default size is 14 points.
a. If you are using the grouped view, expand the Font group.

b. To the right of font-size, click -], and complete the fields in the popup. Enter a number

in the field and use the down arrow in the lower-right corner to select a unit of
measurement.

c. Click OK.

NOTE You can also specify other style settings that can normally be done for fonts
or paragraphs.

8. Click[&l to save your work.
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How to Edit Page Numbers for Print Output

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

w

In the upper-left corner of the editor, click in the drop-down field and select
[ Link Styles -|

4. In the Styles section of the editor, expand MadCap|xref and select the RelLinkPageNumber
style class.

5. From the Show drop-down list on the upper-right side of the editor, select
|Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Use the properties area to the right to make changes (e.g., font color).

8. CIicklE' to save your work.

What's Noteworthy?

NOTE Different browsers may treat margin and padding settings differently. For example,
Firefox honors padding settings more than it honors margin settings.
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Associating Relationship Tables With Targets

If you have created relationship tables in your project, you need to tell Flare Desktop which tables to
use for which targets.

How to Associate Relationship Tables With Targets

1. Open the target from the Project Organizer.
2. Inthe Target Editor, click the Relationship Table tab.

3. Click next to each relationship table that you want to use for that target so that it has a check
mark.

4. CIicklE' to save your work.
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CHAPTER 14

Shortcut Controls

Supported In:

A shortcut control in Microsoft HTML Help launches a program or window in an application by
passing Windows-based messages and parameters. For example, if a topic discusses a procedure
that involves a specific dialog window, you can provide a link that a user can click in the topic to
open the dialog in the program. Shortcut controls can make tasks easier for new users, and they
can speed up complex procedures for experienced users.

This chapter discusses the following:

Inserting Shortcut Controls ... 233
Editing Shortcut Controls ... 234
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I Inserting Shortcut Controls

Inserting shortcut controls requires only a few simple steps.

Following are limitations of shortcut controls:

® A shortcut control can be used only with Microsoft HTML Help.

B The CHM file must be located on a local or network drive. The file cannot be accessed
through HTTP.

® The CHM file must be displayed in the Help Viewer. A shortcut control does not work in a file
that is displayed in an internet browser window.

How to Insert a Shortcut Control

1. Open the content file.

> W™

In the XML Editor, click in the topic where you want to insert the shortcut control.
Select Insert > Shortcut Control.

Enter the appropriate information in each of the fields. You may need to consult with your

developer for help on completing these fields.

File path to the executable file... Enter the path and name of the program that (EXE file)
you are calling.

Parameters to be sent... Enter any parameters you would like to send the program (e.g.,
the name of a file to open). Separate the parameters with commas.

A message ID of a standard Windows message Select a standard Windows message
from the drop-down menu.

WPARAM value Enter the WPARAM value.
LPARAM value Enter the LPARAM value.

5. Click OK. The shortcut control is added to the topic.

6. Click[wl to save your work.
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| Editing Shortcut Controls

You can edit a shortcut control that you have inserted into a topic in a couple of different ways.

How to Change the Settings Associated With a
Shortcut Control

The first way to edit a shortcut control is to change the settings (e.g., executable file path,
parameters, message ID) associated with the control.

1. Open the content file.

2. Inthe XML Editor, right-click the shortcut control icon @ (if "markers" are set to be shown).

3. Inthe context menu, select Edit Shortcut Control. The Insert Shortcut Control dialog opens.

4. Adjust the settings in the fields as necessary. You may need to consult with your developer
for help on completing these fields:

File path to the executable file... Enter the path and name of the program (EXE file) you
are calling.

Parameters to be sent... Enter any parameters you would like to send the program (e.g.,
the name of a file to open). Separate the parameters with commas.

A message ID of a standard Windows message Select a standard Windows message
from the drop-down menu.

WPARAM value Enter the WPARAM value.
LPARAM value Enter the LPARAM value.

5. Click OK. The Insert Shortcut Control dialog closes, and the link is now changed.

6. CIicklE' to save your work.
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Edit the Style of a Shortcut Control

The second way to edit a shortcut control is to edit the style (e.g., font, color) of the link. When you
edit the style for a shortcut control, the style changes for all shortcut controls in any topics in your
project. To do this, modify the property settings for the style called "MadCapl|shortcut.” For more

information see the Help system.
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CHAPTER 15

Text Hyperlinks

Supported In:
ECLIPSE
HALP EPUB

HTML
M5
PPTX [ Wwee
E POF |l WORD HTML HELP

A text hyperlink is one of the most basic forms of a link. It is simply a hyperlink applied to text.
When an end user clicks the hyperlink in the output, the location specified in the hyperlink opens.
The location can be another topic in the project, a place in the current file (such as a heading or
bookmark), or a file outside of the project (such as a website or PDF on the internet). In general, text
hyperlinks are recommended for links that point to locations outside of your project (e.g., to a
website) or to a location in the project when you want particular text for the link (e.g., "click here").
On the other hand, cross-references are recommended for links that point to locations within the
project (e.g., from one topic to another, or a place within the same topic) when you want the link
text to be automatically applied.

This chapter discusses the following:

Inserting Text Hyperlinks ... 237
Editing Text Hyperlinks ... 244
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I Inserting Text Hyperlinks

You can insert text hyperlinks in content files.

How to Insert a Text Hyperlink—Standard
Method

1. Open the content file.

2. Highlight the text that you want to use as the link (or "hotspot").

3. Do one of the following, depending on the part of the user interface you are using:
® Ribbon Select Insert > Hyperlink.
® Keyboard Shortcut Press CTRL+K.

® | ocal Toolbar In the local toolbar of the XML Editor, click .

® Right-Click Right-click in the editor and select Insert > Hyperlink. This context menu
option is available only when your cursor is located in certain places in the editor (e.g.,
not in a drop-down effect).

The Insert Hyperlink dialog opens.

4. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.
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Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

*x - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [l to display and select any bookmarks within the destination file, or [2&] if
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

CHAPTER 15 239



EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

below).

ﬁ EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list

Link to:
| Email -
Email address:

techsupport @mycompany com;bob@mycompany .com
Subject:
Meed Tech Support

Recent Email Addresses

sally@mycompary.com
bob@mycompany .com

Use semi-colons to
separate multiple
email addresses.

You can select
recent email
addresses.

lam,|
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text

in the topic. If you want to insert a variable in a field, you can click . The variable will appear
as syntax in the field, but in the output the variable definition will be shown.

6. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output. Again, you can insert a variable by clicking ‘

When you enter a screen tip, it is added as a <title> tag in the markup.

For more information see the Help system.
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7. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an

element. Again, you can insert a variable by clicking B

8. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare Desktop uses the
parent "a" style.)

9. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

10. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in a topic. So when a user presses the TAB key the first time in a topic,
the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of 2 will
be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTMLS5, Clean XHTML,
WebHelp, WebHelp Plus.

11. Click OK. The hyperlink is added to the topic.

12. CIicklE' to save your work.
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How to Insert a Text Hyperlink—Quick Link
Method

1.

2
3.
4

5.

6.

Open the content file.
In the XML Editor right-click at the location where you want to insert the hyperlink.
From the context menu select Insert > Quick Link.

Select the appropriate submenu, depending on the option that helps you find the destination
the fastest.

® Bookmarks Lets you select any bookmarks that you have already inserted into the
current file.

® Same Folder Lets you select any files that are contained in the same folder in the
Content Explorer.

® Open Documents Lets you select any other files that are also currently open in the
workspace.

Introduct \Welcome

Cut Ctrl+X
H Copy Ctrl+C ace this with your own content. Here is some generalte This exampleshows [1YOLUr OW
50 i_: Paste Ctrl+V with your own content. Here is some generaltext forat how you can create a fwn conte
) uick hyperlink that
g [~ text for a topic. R qu htent.
0f Inset P &) Image.. SUHE P points to another file ]
Create Auto Suggestion B Multimedia.. thatis ::urrenlly open.
4 Conditions... CerieshifteC | Hyperlink.. Crl+K //
uick Link 3
=/ Paragraph... Ctrl+Alt+B | E | e
4| Font.. Ctrl+Shift+B 2 Cross-Reference.. Ctrl+Shift+R Same Folder 5
g Quick Cross-Reference » | Open Docuffients  » | DropDowns.htm
g Topic Properties...  Ctrl+Shift+P : Headinas ht
%4 Snippet.. Ctrl+R New Topic... cadings.ntm
£ Variable.. Cel+Shift-V Topic... Conditions.htm

From the next submenu choose the bookmark or file. The hyperlink is added to the topic.

CIicklE' to save your work.
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| Editing Text Hyperlinks

You can edit text hyperlinks that you have inserted into a topic in at least three different ways: (1)
edit the destination and properties of the hyperlink, (2) edit the style of the hyperlink, and (3) unbind
(or remove) the hyperlink from the text.

How to Edit the Destination and Properties of a
Text Hyperlink

The first way to edit text hyperlinks is to change the destination and other properties (link text,
target frame, screen tip).

ﬁ EXAMPLE You test the topic containing the text hyperlink and you notice that the wrong
destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

1. Open the content file.
2. Inthe XML Editor, click inside the link.

3. Atthe top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned

on, click in the local toolbar of the XML Editor.

4. Select Edit Hyperlink. The Insert Hyperlink dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.
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FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.
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PLACE IN THIS DOCUMENT

This option displays any bookmarks, headings, and other elements in the current file. Expand
the appropriate section and select the element to which you want to link. If you select
anything other than an existing bookmark, Flare Desktop will insert a new bookmark at that
destination in the file.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [l to display and select any bookmarks within the destination file, or [2&] if
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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EMAIL

This option lets you add email addresses and subject line so that the user can quickly send
an email. To add multiple email addresses, separate them with semi-colons.

below).

ﬁ EXAMPLE You might use this feature to help the end user send an email to your
company's technical support department. When users click the link, it opens their
email program and begins a new email message for them, inserting the email
address and subject line for them. After you click this option, complete the E-mail
address and Subject fields to the right (or select a recent email address from the list

Link to:
| Email -
Email address:

techsupport @mycompany com;bob@mycompany .com
Subject:
Meed Tech Support

Recent Email Addresses

sally@mycompary.com
bob@mycompany .com

Use semi-colons to
separate multiple
email addresses.

You can select
recent email
addresses.

lam,|
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text
in the topic.

7. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

When you enter a screen tip, it is added as a <title> tag in the markup.

For more information see the Help system.
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8. (Optional) In the Alternate Text field, type a phrase that describes what the element is about.
This option should be used to increase accessibility for users who are unable to view an

element. Again, you can insert a variable by clicking B

9. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles (a.NameOfStyleClass) from
your stylesheet to the link. After you select a style class in the dialog, click OK. The Style Class
field displays the selected style. (If you do not specify a style class, Flare Desktop uses the
parent "a" style.)

10. (Optional) In the Target Frame field, click the drop-down arrow to select the way the linked
destination will open.

® Page Default The destination file opens in the same window as the output window.

® Parent Frame The destination file opens in the parent frame of the current topic while
hiding that topic.

® New Window The destination file opens in a new browser window.
® Same Frame The destination file opens in the same frame as the current topic.

® Top Frame The destination file opens in the same output window, removing all other
framesets. You might use this option, for example, if the destination topic has its own
frameset.

® Popup Window The destination file opens in a popup box on top of the current topic.

11. (Optional) In the Tab Index field you can enter a value to specify the order in which users can
tab through hyperlinks in a topic. So when a user presses the TAB key the first time in a topic,
the hyperlink with an index value of 1 will be selected first, the hyperlink with a value of 2 will
be selected next, and so on. If you want to skip a hyperlink, enter -1 in that field.

NOTE This feature is supported only in web outputs—HTMLS5, Clean XHTML,
WebHelp, WebHelp Plus.

12. Click OK. The hyperlink is changed in the topic. By default the hyperlink is displayed in blue,
underlined font. You can change the appearance of the link by modifying the style in the
Stylesheet Editor.

13. CIicklE' to save your work.
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How to Edit the Style of a Text Hyperlink

The second way to edit a text hyperlink is to edit the style (e.g., font, color) of the hyperlink. When
you edit the style for a text hyperlink, the style changes for all text hyperlinks in any topics in your
project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthe local toolbar, make sure the first button displays [ View: Advanced] |f the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
| Link Styles -|

4. On the left side of the editor, find and select the a tag.

If you want to modify the way links look when they are in a certain state, you can select a

pseudo class under the "a" style. Link pseudo classes include the following:

Active This class is used when the person activates the element (mouse is clicked).

Focus This class is used if the element has the focus.

Hover This class is used when the person hovers the mouse over the element.

Link This class is used for links that have not yet been clicked.

Visited This class is used for links that have already been clicked.
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% EXAMPLE You want a text hyperlink to display in green when a user hovers over it.
Therefore, in your stylesheet you expand the a style and modify the hover pseudo
class, changing the font color to green.

Stylesheet Editor 31 View: Advanced | % Add Selector =| (55 Variable ~ Medium - Options +

All Styles ~  Hide Inherited = | Medium: (default) ~  Show: All Properties ~

I [Variables) ~ Medium: (default)
4 32 ahover

G arvPaa
GlossaryPageTerm 4 Font

| color: #003000 |

font

MCBreadcrumbsLink
Popu

4 (Pseudo Classes)
active
focus
link
visited

abbr

acronym font-variant:

font-family:

font-size:

font-style:

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a

group view [E£]] or an alphabetical view []
7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [=] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. CIicklE' to save your work.

CHAPTER 15 257



How to Fix Link Overflow in a Container

If you have a long hyperlink (such as a URL) that is extending past the boundary of its container
(such as a div) in the output, you can fix it by adding an overflow-wrap property to the style.

1. Right-click your stylesheet file and select Open with > Internal Text Editor.
2. Find the style where the issue occurs, and add this to it:

overflow-wrap: break-word;

3. Click[&ll to save your work.

How to Unbind or Remove the Text Hyperlink

The third way to edit a text hyperlink is to unbind (or remove) the hyperlink effect. If you decide that
you no longer want the content to serve as a hyperlink, you can use the steps below to remove the
hyperlink, converting the content to regular text.

1. Open the content file.
2. Inthe XML Editor, click inside the link.

3. Atthe top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned

on, click in the local toolbar of the XML Editor.

4. From the context menu, select Unbind. The hyperlink effect is removed.

5. Click [l to save your work.
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CHAPTER 16

Text Popups

Supported In:

HTML
M5
ECLIPSE
EPUB HTML
E HELP HELF

A text popup is a link that opens a popup box containing basic text that you provide.

This chapter discusses the following:

Inserting Text POPUDS ... 254
Editing TexXt POPUPS ... oo 255
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I Inserting Text Popups

Inserting text popups requires only a few simple steps

How to Insert a Text Popup

1. Open the content file.

2. Inthe XML Editor, highlight the content that you want to use as the link (or "hotspot") to open
the popup.

3. Select Insert > Text Popup.

The Insert Text Popup dialog opens, with the text that you highlighted already shown in "The
Hotspot Text" field.

@ Inzert Text Popup 7 >

The Hotspot Text: |This is the link to open my text popup. | X

The Popup Text:

Cancel

If you want to insert a variable in a field, you can click . The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

4. In The Popup Text field, type the content for the popup. Again, you can insert a variable by
clicking .

5. Click OK. The link for the text popup is added to the topic. You can change the appearance of
the link by modifying the MadCap|popupHead and MadCap|popupBody styles in the
Stylesheet Editor.

6. CIicklE' to save your work.
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| Editing Text Popups

You can edit text popups that you have inserted into a topic in at least two different ways: (1) edit
the popup hotspot and text, and (2) edit the style of the text popup.

How to Edit the Popup Hotspot and Text

The first way to edit text popups is to change the popup hotspot and/or the text that users see
when the popup opens.

ﬁ EXAMPLE You test the topic containing the text popup and you notice that a word is
misspelled in the popup text. You can use the following steps to correct the spelling in the

popup.

1. Open the content file.

2. In XML Editor, right-click anywhere in the text popup marker.

Text Popups
Here is a text popup:

[F'=This is the link to open my text popup. 4
When you right-click anywhere in

the marker, a popup menu displays
tasks related to the text popup.

3. Inthe menu, select Edit Popup. The Insert Text Popup dialog opens.
4. Change the text for the hotspot or the popup itself.
5. Click OK. The changes are made to the text popup.

6. CIicklE' to save your work.
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How to Edit the Style of a Text Popup

You can edit the style (e.g., font, color) of a text popup hotspot or the popup body. When you do
this, the style changes for all text popups in any topics in your project.

ﬁ EXAMPLE You want to change the font for your text popup hotspots to dark green with no
underline. The following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays

instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
|D}fnamic Effects Styles - |

4. On the left side of the editor, find and select the style called MadCaplpopupHead (for the
hotspot) or MadCap|popupBody (for the body of the popup).

5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [=] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. CIicklE' to save your work.
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CHAPTER 17

Togglers

Supported In:

HTML
M5
ECLIPSE
EPUB HTML
E HELP HELF

A toggler is a feature that lets users click a hotspot to reveal one or more named elementsin a
topic. A named element (also called the "toggler target") is a chunk of content that can reside
anywhere in the topic. When users click the toggler hotspot, the output reveals hidden content
elements. When users click the hotspot again, the content is hidden again.
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The hotspotis identified |
by this icon.

Togglers

This topic contains a toggle

Here is the toggler hotspot: [ [Click me!4]

-7 This is the toggled content, which will be hidden or shown as the
user clicks the hotspot.

I NS

This is the content thatis shown
or hidden when the user clicks
the toggler hotspot. The yellow
flagicon atthe beginning
indicates that it is toggler text.

This chapter discusses the following:

Inserting Togglers

............................................................................. 259
Editing TOggIers ... 261
Deleting Togglers .. 264
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I Inserting Togglers

Following are steps for inserting a toggler.

How to Insert a Toggler

1. Open the content file.

2. Click anywhere in the paragraph that you want to toggle (the content that will open when
users click the hotspot).

3. Select Home > Name.

4. Type a name for the toggled element (anything that will help you identify it).

5. Click OK. The named element is added, with a yellow flag <] next to it. The flag will not
display in the output. It is simply used to show you where a named element has been
inserted. You can hide or show this flag by selecting the option from the Show tags button
in the XML Editor local toolbar.

6. Inthe topic, highlight the text that you want to use as the toggler hotspot.
7. Select Insert > Toggler.

8. Inthe Toggler targets section, click the check box next to the toggler element that you
created.

9. (Optional) In the Toggler class section, select a style class to be associated with the toggler.
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10. Click OK. The toggler hotspot now has the toggler icon next to it in the XML Editor. The
icon will not display in the output. It is simply used to show you where a named element has
been inserted.

The hotspotis identified
by this icon.

Togglers
This topic contains a toggle
Here is the toggler hotspot: P[] IClick me!4]

" This is the toggled content, which will be hidden or shown as the
user clicks the hotspot.

NN\

This is the content that is shown
or hidden when the user clicks
the toggler hotspot. The yellow

flagicon atthe beginning
indicates that it is toggler text.

11. CIicklE' to save your work.
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| Editing Togglers

You can edit togglers that you have inserted into a topic in at least three different ways: (1) edit the
content in the section that is "toggled," (2) edit the style of a toggler hotspot, and (3) associate the
hotspot with another toggler element and/or style class.

How to Edit the Toggler Content

The first way to edit drop-down text is to change the actual content in the section that gets
"toggled" when users click the hotspot.

1. Open the content file.

2. Inthe XML Editor, click in the area containing the toggler content. Then add, remove, or
replace content as necessary.

3. Click[&l to save your work.

How to Edit the Style of a Toggler Hotspot

You can edit the style (e.g., font, color) of a toggler hotspot. When you do this, the style changes for
all toggler hotspots in any topics in your project.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
|D}fnamic Effects Styles - |

4. 0On the left side of the editor, find and select the style called MadCap|toggler (or a toggler
style class you have created within it).
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5. From the Show drop-down list on the upper-right side of the editor, select
[Show: Assarted Relevant Properties *| The most relevant properties for that style are shown on the
right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group vievv or an alphabetical view .

7. Locate the property you want to change.
Following are some of the more common properties that you might change.

® mc-closed-image This style, located in the Unclassified property group, lets you select
an image to be shown next to the toggler effect when it is in a closed state.

® mc-closed-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the toggler effect when it is in a closed state.

® mc-open-image This style, located in the Unclassified property group, lets you select an
image to be shown next to the toggler effect when it is in an open state.

® mc-open-image-alt-text This style, located in the Unclassified property group, lets you
set alternate text for the toggler effect when it is in an open state.

® mc-image-spacing This style, located in the Unclassified property group, lets you set
the spacing around the image next to the toggler effect.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button =] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. Click[ll to save your work.
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How to Associate a Hotspot With Another
Toggler Element

The third way to edit a toggler is to associate the hotspot with another toggler element and/or style
class.

ﬁ EXAMPLE You might have multiple sections of content in a topic that are open and closed
via toggler hotspots. If you are using one hotspot to "toggle" one section of content, you
can easily associate that hotspot with an additional section of content, so that it "toggles”
both areas when a user clicks it.

1. Open the content file.

2. If you have not yet given a toggler element name to the content that you want to show and
hide, follow the steps for inserting a toggler.

3. Inthe XML Editor, right-click the icon at the beginning of the toggler hotspot.

4. Inthe menu, select Edit Toggler. The Insert Toggler dialog opens.

5. Inthe Toggler targets section, click the check box next to any toggler elements that you want
to associate with the hotspot. You can select as many toggler elements as needed.

6. Inthe Toggler class section, select a style class to be associated with the toggler.

7. Click OK.

8. CIicklE' to save your work.
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| Deleting Togglers

If you have inserted a toggler into a topic and want to remove the toggler hotspot, use the following
steps.

How to Delete a Toggler

1. Open the content file.
2. Right-click the icon at the beginning of the toggler.

3. From the menu, select Delete. The toggler hotspot and its content are removed from the
topic.

4. Click[&l to save your work.
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CHAPTER 18

Toolbars

Supported In:

HTML
MS
HTML WEB
ELP HELP

NOTE elLearning toolbars are supported in HTMLS5 output only. They are not supported in
the other outputs listed above.

There are three types of toolbars that you can add to your online output—topic, web, and eLearning.
A topic toolbar displays buttons in a custom toolbar within the topic content, based on the insertion
of a Topic Toolbar proxy. A web toolbar displays buttons within the skin framework. An eLearning
toolbar is typically shown at the bottom of topics to guide individuals through an online eLearning
course. See "Topic Toolbars" on page 267, "Web Toolbars" on page 333, and "elLearning Toolbars"
on page 358.

This chapter discusses the following:

Toolbarsand SKINS ... 266
ToPIC TOOIDAIS .o 267
Web Toolbars ... 333
elLearning Toolbars ... 358
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I Toolbars and Skins

The kinds of toolbars (and sometimes the buttons) that are available depend on the type of skin you
are using.

Skin Type Topic Toolbar Web Toolbar eLearning Toolbar
HTMLS5 Top b4

Navigation'

HTMLS5 Side X

Navigation'

HTML5 Skinless’ x

HTML5 Tripane?

Standard?3 b

1Side and Top Navigation—as well as skinless outputs—do not use frames, like
other outputs do. Therefore, you must use a topic toolbar if you want to display
toolbar buttons.

2|n an HTMLS5 Tripane skin, you can configure a web toolbar by using the Toolbar
tab.

3Although Pulse is supported in WebHelp and WebHelp Plus targets, you can add
Pulse-related buttons (e.g., Edit User Profile, Topic Ratings) only in a WebHelp
toolbar. You cannot add them in a topic toolbar.
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| Topic Toolbars

WEB
HELP

Supported In:

HTML

M5
HTRIL
HELP

A topic toolbar displays buttons in a custom toolbar within the topic content, based on the insertion
of a Topic Toolbar proxy. In addition to a Topic Toolbar proxy, you can use a skin component (for
HTMLS5) or a Standard skin (for WebHelp and HTML Help outputs). Choosing the buttons for the
toolbar can be done in the proxy, but it can also be done in the skin or skin component (proxy
selections have precedence).

You are here: Get Started @ Q @ E: EEII'] &
Get Started A

As a new Flare user, it's a good idea to familiarize yourself with the following information.

Key Concepts and Features

Getting Started Guide, Video, and Tutorial

Workspace

Architecture

Process
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How to Create a Topic Toolbar

1. (Optional) Add a skin or skin component, depending on your output type:
® Topic Toolbars in HTMLS Skin Components
® Topic Toolbars in WebHelp Outputs

You can control the look of the items in the topic toolbar, and the background of the topic
toolbar, by opening the Styles tab of the Skin Editor and modifying the appropriate styles. By
default, the background is transparent so it will show whatever is behind it in the body of the
topic. When you change any of these styles, they affect settings for items in both regular web
toolbars and in topic toolbars.

2. (Optional) You can create and edit a Madcapl|topicToolbarProxy style class to control the look
of the toolbar.

3. Place your cursor in a template page and select Insert > Proxy > Insert Topic Toolbar Proxy.
From the dialog, you can select a skin component, style class, and buttons.

CHAPTER 18 268



Topic Toolbar Buttons Supported

Although topic toolbars can be added in most online outputs, only certain buttons are supported in
the various outputs. The following table provides an overview.

The following table does not list Pulse-related toolbar buttons, such as Edit User Profile and Topic
Ratings. These kinds of buttons must be added either via the web toolbar (for HTML5 Tripane,
WebHelp, or WebHelp Plus outputs) or the Topic Toolbar skin component (for all HTML5 outputs).

HTML Help HTML5 WebHelp WebHelp Plus

Add Topic to x K v v
Favorites

Back v X v/ v
Collapse All v V1 v v/
Current Topic v W2 v v
Index

Expand All v v v v
Forward v X v/ v
Home v x v v
Next Topic v Wv'? v v
Previous Topic v V'3 v v
Print v v v v
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HTML Help HTMLS WebHelp WebHelp Plus

Quick Search v X v v
Refresh v x v v
Remove Search vy v v v
Highlight

Select Browse b4 X v v
Sequence

Select x v v v
Community

Select Favorite X x v v
Select Glossary X x v v
Select Index b4 X v v
Select x v X x
Language

Select Search X x v v
Select Skin X v X X
Select TOC b4 X v v
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HTML Help HTMLS WebHelp WebHelp Plus

Separator
Stop X
Hide Navigation X X

TCollapse All and Expand All are the same button for HTMLS5.

2This button is supported only for HTML5 output that is using a Tripane skin. It is not
supported for HTMLS5 output using a Top Navigation skin, or no skin.

3If you are using a Tripane skin, this button lets you navigate browse sequences. If you
are using a Top Navigation skin or no skin (or if you are using a Tripane skin without a
browse sequence), this button lets you browse table of contents entries.
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Examples

The Previous and Next buttons in HTML5 output using Side or Top Navigation skins (or no skin)
differ from those in other WebHelp and other output types (including HTML5 outputs using a

Tripane skin). In WebHelp and other output types, the Previous and Next buttons navigate between

topics in a browse sequence (if one is available); otherwise they navigate between topics in the

table of contents.

7 EXAMPLE — HTML5 Top Navigation (TOC)

spanning many topics.

the open topic.

You might want to include Previous and Next buttons in your online HTML5 Top Navigation
output when you use topics that are sequential, such as a tutorial or a long process

In this example, a user tutorial has several numbered topics that have been added to the
table of contents (TOC). We've added a menu proxy so that these TOC items display next to

‘You are here: Tutorial > Step 1. Starting & Project

Step 1: Starting a Project

Begin by creating a new Flare project and takind There are many numbered
topics in this tutonal.

1 Creating a Project The Start New Projec
template, an existing project, or an imported project. In this tutorial, we will create a

new project from a Flare template.

2. Touring the Workspace After creating you project, you should familiarize yourself

Tutorial
Step 1: Starting a Project

Step 2: Adding Elements
Step 3: Making it Look Good
Step 4: Developing Targets
Step 5° Building Output

with the Flare workspace before doing too much. This tutonial covers several major areas of the workspace.
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% When users work through the tutorial, they start at Step 1 and then logically progress

through each topic using the Next button.

i
@
1§
3

- _' _ Click this button to navigate
ca : ok to the next topic.
2L A0 "
E a project from a e aking it Look Good
Al we will create a ep 4: Developing Targe

Amiliarize yourself
vers several major areas of the workspace.

1]
@

You are here: Tutorial = Step 2° Adding Elements

Step 2: Adding Elements Tutorial
Now that you have created a project, it is tim e it (T TS = = Start!ng PRk
your project some substance. You can add a a project. B ——

Step 3: Making it Look Good

1. Topics You might say that topics are the most important part of a Flare project Step 4: Developing Targets
because they hold and display your content Step 5: Building Output

2. Images You can insert images into topics. Flare supports most common image file

formats.
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% If they need to go back to a previous topic in the TOG, it is easy for the user to click the
Previous button to find the topic.

VES

E file

i
@
*
}

Tutorial
Step 1: Star
Step 2: Add
Step 3: Making it Look Good

Click this button to navigate
to the previous topic.

Step 4: Developing Targets
Step 5: Building Output
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9% EXAMPLE — WebHelp (Browse Sequence)

Let's say you want to add Next and Previous buttons, as well as the Home button, at the
bottom of each topic in your WebHelp output. The buttons will use a browse sequence that
you've added to your output.

Therefore, you open your skin and select the Topic Toolbar tab. The default settings
already include the Next Topic, Current Topic Index, and Previous Topic items.

The Selected section already includes some of
Skin Editor  Preview as} the items we want. However, we want to remove

the Current Topic Index from the toolbar.

Zeneral

Size

About
WebHelp Setup

WebHelp Toolbar

Topic Toolbar

Cornrnuniky
HTML Help Setup

Skyles

\

Toolbar Buttons

Available |
AddTopicToFavarites

Back CurrentTopicIndex
Collapseall MextTopic
Expandall
Forward
Home

Print
QuickSearch

Refresh

RemoveHighlight

m

SelectBrowseSequence
SelectCommunity
SelectFavarites
SelectGlossary

SelectIndex
SelectSearch
SelectTOC

[t -

A A 1 @ ¥ 1 =
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¢ In the Selected section, you select CurrentTopiclndex and click[%] at the bottom of the tab.
This moves that item back to the Available section on the left.
Skin Editor | Preview as} Now we Just have the les WebHelp Window
Previous Topicand \
i Next Topic items.

zeneral

S Available s | Selected

About \PrevinusTDpic

WebHelp Setup Back
Collapseall

WebHelp Toolbar CurrentTopiclndex

Topic Toolbar :rp:::" The Current Topic Index

Community o item is now over here.

HTML Help Setup Print

Styles QuickSearch
Refresh

R RemoveHighlight
SelectBrowseSeguence
SelectCommunity
SelectFavorites
SelectGlossary i
SelectIndex
SelectSearch
A 3
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ﬁ Next, in the Available section, you select the Home item and click [ to move it to the
Selected section.

Skin Editor | Previewq 1he Home button |, as webHelp Window
has been added.

. We'll leave the items

General in this order.
Sz Available
About AddTopicToFavorites
Back PreviousTopic
WebHelp Setup
Collapseall MextTopic
WebHelp Toolbar CurrentTopicIndex
Topic Toolbar ExpandAl
Forward
Cormuniky .
Print
HTML Help Setup QuickSearch E
Refresh
Skyles

RemoveHighlight

\ SelectBrowseSeguence
SelectCommunity

SelectFavorites

SelectGlossary
Selectindex

SelectSearch
SelectTOC

[t -

A 4 1 ¥ ¥ (1) ()
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% Now that the settings in the Skin Editor are completed, you can save your changes and
insert the Topic Toolbar proxy (alternatively, you could have inserted the proxy before
editing the skin). If you had wanted the custom toolbar to display in only a few topics, you
would probably insert the proxy directly into those topics. However, because you want the
toolbar to display at the bottom of every topic, the best way to accomplish this is to insert
the proxy into a template page.

bresdcrumbs prooy

Mad...

topic body proxy

topic toolbar proxy

\ In this example, a Topic Toolbar proxy

has been inserted at the bottom of a
template page, below a Breadcrumbs
proxy and a Body proxy.
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% After making sure both the skin and the template page are associated with the WebHelp
target, you can generate the output.

B = %o LF AR XTHDE L OEH & | madcap

T

In the output, notice that the regular Thattoolbarincludes the
toolbar (which is specifiedinthe [ adipiscing elit| Previous and Next buttons (as
WebHelp Toolbar tab of the Skin ~ plit. onare vek ¢ Well as the Home butfon),  pndc
Editor) is still shown_ because we did Jam mollis id. S§ which are part of the default
not specify otherwise. se bhbendum | toolbar layout. uam
u, gravida qtis e | eget
volutpat enil finibus non. Aliqu'm erat volutpat. Ph’sellus finibus telpus nisl.

1. Lorem ipsum dolor rit amet, consectettr adipiscing elit.

2. Eusce blandit sapidn a dolor accumsan “ccumsan.

3. Nullam nepue velit, ornare_ vek orci vel._mollis frhngilla mauris.

4. Dondc sagittis elemensuny Here s the custom topic IS 19

5 Suspdndisse lectus augge! toolbar that we created fila id dnlor. Suspendisse
bhbendum imperdi thatincludesonlythe fus maurir, ornare tincidunt
qutrum eu, gray Home, Previous, and  ern, eget volutpat enil finibus
non. Aliqu, Next buttons. G|

AR alli:N
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Y% Suppose you have created your own arrow images and want to use them instead of the
images provided by Flare Desktop. You can simply select your image files in the Styles tab
of the Skin Editor.

General ‘ Styles Show Preview
@ Property Groups

We've selected the

4 I

) Alphabetical List

Next Topic style
underthe Toolbar -ToolbarTtem Propertis
Item node - AccordionTitle
- AddTopicToFavarites E Genera j=
" Back Icon resources;WebHelp/Default, Fwhtfd.|.
. - Collapseall -
Topic Toolbar CurrentTopicindex | Pressedlcon resaurces:WebHelp/Def aulk. FlwhefL.|. |
Community - EditlserProfile Haverloon A resources:WebHelp/Def aulk. FwhtfT.|. T

- ExpandAll ool
HTML Help Setup - Forward L4
.. Home TextImageRelation

Styles Logo Toolip
e ‘ NextTopic | . a
- PreviolsTopic Here is where you can )

-~ Print n{ select differentimages to

- QuickSearch

.

2 be used for the button in
a il | D its different states
(normal, pressed, hover).

Afterwards, the output might look something like this:

BoE oo ¥ AR RETHDODE L O & | madcap

You are here: Welcome

Welcome

Lorem ipsum dolor rit amet, consectettr adipiscing elit. Eusce blandit sapidn a dolor
accumsan “ccumsan. Nullam nepue velit, ornare vek orci vel, mollis frhngilla mauris. Dondc
sagittis elemensum arcu, at gravida puam mollis id. Suspdndisse lectus augte, auctor in
aliqual nec, fringilla id dnlor. Suspendisse bhbendum imperdiet korem ac placerat. Akiquam
purus maurir, crnare tincidunt qutrum eu, gravida gtis nisi. Integer pukvinar lacus libern, eget
volutpat enil finibus non. Aligu'm erat volutpat. Ph™sellus finibus telpus nisl.

1. Lorem ipsum dolor rit amet, consectetir adipiscing elit.

2. Eusce blandit sapidn a dolor accumsan “ccumsan.

3. Nullam nepue velit, orare vek orci vel, mollis frhngilla mauris.

4 Dondc sagittis elemensum arcu, at gravida puam mollis id.

5 Suspdndiss iqual nec, fringilla id dnlor. Suspendisse
bhbendum | Now the toolbaris  [at. Akiquam purus maurir, ornare tincidunt
qutrum using ourcustom kvinar lacus libern, eget volutpat enil finibus
non. ammow butions. nibus telpus nisl.

o
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Process for Topic Toolbars

Certain tasks must be completed in order when using this feature.

Editing HTMLS Topic Toolbar Skin Components

In Topic Toolbar skin components, you can use skin styles to control the look of a toolbar you add

via a proxy.
Topic Toolbar Skin Editor || Web Medium | Tablet Medium Mobile
Setup | (O
| Styles | Filter o
JI Text | | 4
Use the Toolbar style I Button
groups and properties
to make changes to Button Separator
the entire toolbar, to I Button Drop-down
buttons, to the button
separator, and to the
button drop-down. Toolbar
[Fitter Je)

I Alignment
I Layout

I Margin

=
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How to Edit an HTMLS Topic Toolbar Skin Component

1. Open an HTMLS5 Topic Toolbar skin component.

2. Select the Setup tab, and choose the buttons you want to include in the toolbar, moving them
to the right side of the tab. You can also add custom buttons (see "Adding Custom Buttons to
a Toolbar" on page 302).

3. Select the Styles tab.

4. (Optional) If you are using responsive output, make sure you select the appropriate medium—
Web, Tablet, or Mobile—in the local toolbar before making changes to styles.

5. On the left side of the editor, expand and select any of the following Toolbar style groups:

Style Group Description

Toolbar This controls the look of the entire toolbar, such as its alignment and
margins.

Toolbar > This controls the look of individual buttons in the toolbar. If you set the

Button properties at the root level, then all the buttons are affected. If you want

specific values for a particular button, select the style group for that
button and then set the properties for it.

Toolbar > This controls the look of the separator between buttons.

Button

Separator

Toolbar > This controls the look of the toolbar button drop-down menu. You can
Button Drop- also set properties for menu items, such as hover properties and fonts.
down
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6. Expand any of the nodes and complete the necessary fields. The properties and fields that
you see are different for each node. Following is a general list in alphabetical order:

ALIGNMENT

You can click in the Horizontal field and choose whether to position to the right or left side of
the display.

BACKGROUND

You can change any of the following to affect the background:

® Gradient This lets you change the background color using a progression effect. Select
the beginning gradient color in the first field, and then select a second gradient color in
the second field. You can use any of the following to enter or select a color.

Option Description

You can type a hexadecimal number (e.g., #000000) directly in

this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

E] This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

® Color This lets you select a single color.

® |mage This lets you select an image for the background. Click[E] and use the dialog to
select an image file.

® Repeat Use this field to tell Flare Desktop whether the image should repeat or not.
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NOTE The Image field has the highest precedence, which means that if you enter
settings in all of the Background fields, the image will win. Gradient has the next
highest precedence. If you want to use the Color field, you need to make sure the
Gradient fields are set to transparent and that there is no image selected.

BORDER
You can change any of the following to affect the border on the element:

® Border Edge Fields (Top, Right, Bottom, Left) You can add a border line around any of
the edges of the element. You can use any of the following. The first three fields are
used to control the type and size of the border line. The last three fields are alternative
ways to choose a color for the border.

Option Description

You can select a type of line for the border (e.g., solid, dashed,
dotted).

Type a number in the field or use the arrows to increase or
decrease it.

Click in this field and select a unit of measurement (e.g., pixels,
points, centimeters).

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color.

‘i E
4
4

This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.
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Option Description

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

® Border Radius Fields (Top Left, Top Right, Bottom Right, Bottom Left) If you want the
element to have rounded corners, you can enter values in any of these fields. In the first
field type a number or use the arrows. Then click in the second field and select the unit
of measurement (e.g., pixels, points, centimeters). The higher the number, the more of
a curve the corner will have.

BOX SHADOW
You can change any of the following to affect the box shadow on the element:

® Horizontal Shadow Length This is the position of the horizontal shadow. Negative
values are allowed. In the first field type a number or use the arrows. Then click in the
second field and select the unit of measurement (e.g., pixels, points, centimeters).

® Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

® Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

® Shadow Color This lets you select a color for the shadow. You can use any of the
following:
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Option Description

You can type a hexadecimal number (e.g., #000000) directly in

this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

[2] This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

® Shadow Inset This changes the shadow from an outer shadow (outset) to an inner
shadow. Click in the field and select an option. If you select false the shadow will be
outset. If you select true the shadow will be inset.

EVENT

You can enter a special JavaScript command that is triggered when an end user clicks a
button. For example, the following command opens the MadCap Software website when a
user clicks the button:

window.open ("http://www.madcapsoftware.com") ;

FONT

You can change any of the following to affect the font:
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® Color This lets you select a color for the font. You can use any of the following:

Option Description

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and choose
a color.

[;] This opens the Color Picker dialog, which lets you choose a color

in many ways. Note that you can select a CSS variable.

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

® Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

® Size You can change the font size. In the first field type a number or use the arrows.
Then click in the second field and select the unit of measurement (e.g., pixels, points).

® Weight You can click in this field and make the font normal or bold.

® Style You can click in this field and make the font normal or italic.

GENERAL

You can change the color for the element.
Option Description

You can type a hexadecimal number (e.g., #000000) directly in this field.
Alternatively, you can click the down arrow and choose a color.

[;] This opens the Color Picker dialog, which lets you choose a color in
many ways. Note that you can select a CSS variable.
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Option Description

Adds a bar above the cursor. As you move the cursor over any area of
your screen, the color changes in the bar to reflect the color that is
directly behind the tip of the cursor. When you click, that color is loaded
into the Color Picker dialog.

HEIGHT

You enter a height for the element. In the first field type a number or use the arrows. Then
click in the second field and select the unit of measurement (e.g., pixels, points, centimeters).

ICON

You can click[E] and select a different image for the toolbar button.

You can click the Display drop-down and choose one of the options:
® none The element will not be shown.

® block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).
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LAYOUT

You can click in the Display field and choose one of the options (some of these options might
not be available for certain styles):

® none The element will not be shown.

® block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

® inline The element will be shown but does not add a line break after it, allowing it to be
positioned next to other elements.

® inline-block The element will be shown but does not add a line break after it, allowing it
to be positioned next to other elements. This is similar to inline; however, with this
option, a width and height can be set on the element, and top/bottom margin and
padding settings are respected.

MARGIN

You can change the margin for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

PADDING

You can change the padding for any of the sides on the element (Left, Right, Top, Bottom). In
the first field type a number or use the arrows. Then click in the second field and select the
unit of measurement (e.g., pixels, points, centimeters).

SIZE

You can change the height or width of the element. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels, points,
centimeters).
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TEXT
You can click the Display drop-down and choose one of the options:
® none The element will not be shown.

® block The element will be shown and adds a line break after it. For some elements this
option might be called flex, which reflects the flexbox technology associated with it.

You can change any of the following to affect the font:

 Color This lets you select a color for the font. You can use any of the following:

Option Description

You can type a hexadecimal number (e.g., #000000) directly in
this field. Alternatively, you can click the down arrow and

choose a color.

[2] This opens the Color Picker dialog, which lets you choose a
color in many ways. Note that you can select a CSS variable.

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you
click, that color is loaded into the Color Picker dialog.

« Family You can select or type a specific font family (e.g., Arial, Tahoma, Verdana).

» Size You can change the font size. In the first field type a number or use the arrows.
Then click in the second field and select the unit of measurement (e.g., pixels,
points).

» Weight You can click in this field and make the font normal or bold.

» Style You can click in this field and make the font normal or italic.
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TEXT SHADOW

You can change any of the following to affect the text shadow on the element:

Shadow Visibility You can click in this field and choose to make the shadow either
hidden or visible.

Horizontal Shadow Length This is the position of the horizontal shadow. Negative
values are allowed. In the first field type a number or use the arrows. Then click in the
second field and select the unit of measurement (e.g., pixels, points, centimeters).

Vertical Shadow Length This is the position of the vertical shadow. Negative values are
allowed. In the first field type a number or use the arrows. Then click in the second field
and select the unit of measurement (e.g., pixels, points, centimeters).

Shadow Blur Length This is the blur distance. In the first field type a number or use the
arrows. Then click in the second field and select the unit of measurement (e.g., pixels,
points, centimeters).

Shadow Color This lets you select a color for the shadow. You can use any of the
following:

Option Description

You can type a hexadecimal number (e.g., #000000) directly in

this field. Alternatively, you can click the down arrow and choose
a color or make the background transparent.

E] This opens the Color Picker dialog, which lets you choose a color
in many ways. Note that you can select a CSS variable.

Adds a bar above the cursor. As you move the cursor over any
area of your screen, the color changes in the bar to reflect the
color that is directly behind the tip of the cursor. When you click,
that color is loaded into the Color Picker dialog.

7. Click[&ll to save your work.
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Editing Topic Toolbar Settings in a Standard Skin

Supported In:

In addition to the regular web toolbars that can be included in all most online outputs, you have
another option for including toolbars. This option lets you insert toolbars anywhere in any topics.
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How to Edit Topic Toolbar Settings in a Standard Skin

Following are steps for specifying toolbar settings in a Standard skin. You can select the buttons

either in these steps or when you insert the topic toolbar proxy.
1. Open a Standard skin.
2. Select the Topic Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Iltems that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow

button to move items from the Available section to the Selected section.

These items will
not be included
in the toolbar.

These items will
be includedin
the toolbar.

N/

\

Back

Collapseall

Expandall

Forward

Home

Print

QuickSearch

Refresh
RemoveHighlight
SelectBrowseSequence

SelectFavorites

Available M Selected v
AddTopicToFavorites

CurrentTopicIndex
MextTopic

Following are descriptions of the various items.
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ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access the topic
in the future.

Toolbar ltems | Add Topic To Favorites

Border General

‘ Glossary e i‘é.“i:-':-czes-:- |=$:] f|@ [

BACK

Lets users open the topic that was viewed previously.

Toolbar Items | Back

Glossary D B Q“‘:;-':*:es-:f |0 PR S @|D BPLPow = |£

Border General

COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).

Toolbar Items | Collapse All

‘ Glossary O & E ._-_ ||i:-':-r:-zs-~:- |=J:] E“"|;ﬂ EN)

ral

]
(12

1l

45
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CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare Desktop finds the current topic in a browse sequence and
display its position in relation to the rest of the topics in that sequence. (The root node is
used to determine the count; in other words, if there are "child" topics in the sequence
structure under the current topic, they will be included in the count.)

Toolbar Iltems | Current Topic Index

Border | | General

H Glossary ED: =@ P¥ AR XD ODBELED Do PG rage2or45 &  madcap |

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

Toolbar Items | Expand All

|

‘ Glossary " |:.. ck search |=éf,:) f H bR

FORWARD

Lets users open the next topic in a previously viewed sequence.

Toolbar Items | Forward

Border General

| |
H Glossary BEtragfo=e  (P¥YWAPKZDODE LD D> o @ rae2oaf
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HOME

Lets users open a designated home page (such as your company's website)

Toolbar Items | Home

=

Glossary mD = E=;:';gﬁf«»%%@p@ﬁﬁb@&@%gezmnlﬁ

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the next
topic from there. If you are using HTMLS5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the next topic after it.

Toolbar Items | Next Topic

|

‘ Glossary me = ':::;‘g?Z@W%@ﬁ@@p@ﬁ¢@§@hgez@-\mudcop|

PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the previous
topic from there. If you are using HTMLS5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the previous topic before it.

Toolbar ltems | Previous Topic

|

Glossary Honnofre:  |[PPABKIPDE LD DD B faezasyy & madeon |
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PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

Toolbar Items | Print

Border General

‘ Glossary O = wick search |0 % @ B R %

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

Toolbar Items | Quick Search

General

AP XEH DB L,

Glossary D = iz sl Quick search

REFRESH

Lets users update the content of the topic being viewed.

Toolbar ltems | Refresh

|

” Glossary ERE = = | ﬁf«w@@p@ﬁﬁ@&@F

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

Toolbar Items | Remove Highlight

Border | General

|| Glossary AEx:efcer  JHBYRBXZBOBELTOS
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SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

Toolbar ltems | Select Browse Sequence

| ol

General

“ Glossary i [l R N [N —

Py W%@ﬁ@@ﬁ@ &5 4 Page2of4f @ | madcq

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

Toolbar Items | Select Community

Border

General

|||||

TOC Yokl |E R RS

PrawxepDbBodally

& | madcap

SELECT FAVORITES

Lets users open the Favorites feature.

Toolbar ltems | Select Favorites

Border

| gule

General

[

” Glossary

S PP AR RBBDEAHOP @ P @raezody S ma

SELECT GLOSSARY

Lets users open the Glossary feature.

Toolbar Items | Select Glossary

General

B E = i & |[ouiksean

” Glossary

:pgmwx@z@@@¢@.§mpagem4mawm
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SELECT INDEX

Lets users open the Index feature.

Toolbar Items | Select Index

|

General

” Glossary [

I AR RS D EEQ@&@Pagean&lm

SELECT SEARCH

Lets users open the Search feature.

Toolbar Items | Select Search

|

General

| Glossary Brs e (9 AP XFQBHIPC D5 & & paerea® &

SELECT TOC

Lets users open the TOC feature.

Toolbar Items | Select TOC

|

General

” Glossary BE = & & |cuicsesrn

PEARPRZOOE LD D 5 P rage2ors

STOP

Lets users prevent a page from downloading file information.

Toolbar ltems | Stop

General

|

H Glossary B e

ﬁf«@@@p@ﬁ‘;@@@%ge
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TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output window.

Border

‘ Glossary

Toolbar ltems | Toggle Navigation Pane

=

BF: % @ ]3P FA R

4. (Optional) You

Option

CHAPTER 18

can use the buttons at the bottom of the tab to perform additional tasks.

Description

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click | to move it
to the Selected section.

Unless you specify otherwise, in the output the new button will display the
text for the name you gave it. However, you can change this by editing the
control type for the new button. To do this, you can select the Styles tab in
the Skin Editor, expand the Toolbar Item node, select one of the styles listed
above, expand the Type property group, and from the Control Type field
select Button. To choose an image for the button, expand the General
property group on the Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that
clicking the button opens a website), you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and enter a command in the OnClick field.
For example, the following command opens the MadCap Software website
when a user clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Topic Toolbar tab to
enter a command for the button. See the next step.
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Option Description

Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the
output, buttons are displayed left to right according to the order in which
they appear on this tab, with the item at the top being the first button shown
on the left in the output.

Moves the selected item down in the order in the Selected section.
Removes the selected item(s) from the Selected section.
Adds a separator to the Selected section. A separator is the divider between

the toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()

{

window.open("http://www.madcapsoftware.com");

}

6. CIicklE' to save your work.
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Adding Custom Buttons to a Toolbar

Supported In:

HTML

M5
HTRIL
HELP

WEB
HELP

In addition to the toolbar button options provided by Flare Desktop, you can add your own custom
buttons with some associated JavaScript to serve various purposes. To work through a scenario
for adding custom buttons with JavaScript, see the Custom Toolbar Tutorial.

How to Add a Custom Toolbar Button

1. From the Project Organizer, open your Topic Toolbar skin component (if producing HTML5)
or your Standard skin (and select the Topic Toolbar tab, if producing another output type).

2. Atthe lower-left of the editor, click .

3. Inthe dialog, provide a name for the new button, then click OK.

4. On the left side of the editor, double-click the name of your custom button to move it to the
right. Then use the arrow keys at the bottom to adjust its placement in the list of buttons. The
higher a button is in the list, the further to the left it will be in the toolbar. The lower it is, the
further to the right it will be.

5. Add JavaScript for the button:

® |f the button requires multiple lines of JavaScript, select the button name. Then, on the
lower-right of the editor, click Edit. Enter or paste your JavaScript Code, and click OK.

® |f the button just requires one line of JavaScript for its event, select the Styles tab in the
editor. Expand the Toolbar Button node. Then expand the node with the name of your
custom button. Finally, expand the Event node and in the Click field, enter the
JavaScript.

NOTE The above is for a Topic Toolbar skin component. If you are working in a
Standard skin for a non-HTML5 output, the node and field labels are just a bit
different (e.g., Toolbar Item, Type, OnClick).
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6. Provide a background image to represent the button. Under the node with your button name,
expand the Background node, and complete the Image field.

NOTE If you are working in a Standard skin for a non-HTML5 output, the node and
field labels are just a bit different.

7. (Optional) Use any of the other nodes and fields on the Styles tab to make further design
changes for the custom button.

8. CIicklE' to save your work.
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Using a Style to Edit the Look of Topic Toolbars

Supported In:

HTML

M5
HTRIL
HELP

WEB
HELP

You can use the Madcap|topicToolbarProxy style to change the look of the container holding
generated topic toolbars, although it is not always the preferred method, especially with HTML5
output, where modifying the skin component is more common. For more information about how
the style settings work with the different kinds of outputs that support topic toolbars, see the Help
system.

How to Use a Style to Edit the Look of Topic Toolbars

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays
instead, then click it.

NOTE Some of the necessary style properties can also be changed in the Simplified
view in the Stylesheet Editor.

w

In the upper-left corner of the editor, click in the drop-down field and select
|Reusable Content Styles *|.

4. On the left side of the editor, select MadCap|topicToolbarProxy.

5. From the Show drop-down list on the upper-right side of the editor, select
|Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the

right side of the editor.
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6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group vievv or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [=] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

Here are some of the more common properties that you might change.

Border below To change the border line that appears at the bottom of the topic toolbar,
expand the Borders property group. Then to the right of border-bottom, click [-], and in

the popup set the border width, unit of measurement, color, and/or style. Click OK. You

can also use the other cells in this property group to add borders above, to the left, or to
the right of the topic toolbar.

Padding above To change the amount of empty space (padding) above the text within
the topic toolbar container, expand the Box property group. Then to the right of
padding-top, click ], in the popup set the padding value, and click OK.

Padding below To change the amount of empty space (padding) below the text within
the topic toolbar container, expand the Box property group. Then to the right of
padding-bottom, click =], in the popup set the padding value, and click OK.

Space above To change the amount of space above the topic toolbar container, expand
the Box property group. Then to the right of margin-top, click -], in the popup set the
margin value, and click OK.

Space below To change the amount of space below the topic toolbar container, expand
the Box property group. Then to the right of margin-bottom, click =1, in the popup, set
the margin value, and click OK.
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LEFT

™ MARGIN (TRANSPARENT)

LKA

TB BORDER

TP PADDING
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BOTTOM

MARGIN EDGE

BORDER EDGE

PADDING EDGE

9. CIicklE' to save your work.

CHAPTER 18

NOTE Different browsers may treat margin and padding settings differently. For
example, Firefox honors padding settings more than it honors margin settings.
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Inserting and Editing a Topic Toolbar Proxy

Supported In:

HTML

M5
HTRIL
HELP

WEB
HELP

You can use the Topic Toolbar proxy to generate a toolbar anywhere in your topics. This is an
alternative (or an additional option) to the web toolbar that can be included in some online outputs.

How to Insert a Topic Toolbar Proxy

1. Do one of the following:

® Open a topic where you want the toolbar to appear. This is a good method if you only
want the toolbar to be shown in one topic, or just a few topics.

® Open atemplate page that you will use when generating the target. This is the best
method if you want the toolbar to be shown on all topics in the output.

2. Place your cursor where you want the toolbar to be shown in the output (e.g., bottom or top
of the topic or template page). If you are working in a template page, you may need to press
the down arrow on your keyboard and then press ENTER at the correct location.

3. Select Insert > Proxy > Insert Topic Toolbar Proxy. The Topic Toolbar Proxy dialog opens.

4. (Optional) If you are working with HTML5 output, you can select a skin component in the Skin
File field. From the Topic Toolbar Skin Editor, you can select the buttons to be included in the
toolbar. Alternatively, you can select buttons from the Buttons field below.

If you do not select a skin component in this field, Flare Desktop uses the first one it finds in
your project (if one exists). Otherwise, Flare Desktop provides a default design.
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5. (Optional) In the Stylesheet class for proxy field, you can select a class to affect the look of
the entire toolbar.

You might create and use a proxy style class, for example, if you want to add a border around
the toolbar. If you do not select a class from this field, the generated toolbar will use the style
settings from the parent MadCapltopicToolbarProxy style. You have the option of creating a
class for this proxy style in the Stylesheet Editor. To do this, select the
MadCapltopicToolbarProxy style and in the local toolbar click Add Selector to create a class.
The class will then be available from this field.

6. (Optional) You can select buttons for the toolbar here, rather than doing so in the skin.
However, adding buttons in the skin might be preferable, especially since you can also add
custom buttons there (see "Adding Custom Buttons to a Toolbar" on page 302).

a. Click Select buttons.

b. From the Available section, select the buttons you want to include (select multiple
buttons by pressing the SHIFT or CTRL key and clicking a range or individual buttons,

respectively). Then click | to move the button(s) to the Selected section.

ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access
the topic in the future.

Toolbar ltems | Add Topic To Favorites

‘ Glossary

General

BACK

Lets users open the topic that was viewed previously.

Toolbar Items | Back

>

Glossary BB = = & |[cuckeearn PRGN DB LED S o 4

|
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COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding
text effects in a topic (if they are expanded).

Toolbar Iltems | Collapse All

ral

[
i)

n

3]

©
| %
£
¥

| Glossary

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in
question exists in a browse sequence. Flare Desktop finds the current topic in a browse
sequence and display its position in relation to the rest of the topics in that sequence.
(The root node is used to determine the count; in other words, if there are "child" topics
in the sequence structure under the current topic, they will be included in the count.)

Toolbar ltems | Current Topic Index
|
” Glossary B R = % & |[ouicksean ?f«w%@@@@p@&aﬁﬁlmadcoﬂ
EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding
text effects in a topic (if they are not yet expanded).

Toolbar Items | Expand All

Border | General

‘ Glossary Eﬂ = :-‘é. |':.- ch zearch |=J:) g"’ H B %
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FORWARD

Lets users open the next topic in a previously viewed sequence.

Toolbar ltems | Forward

General

‘ Glossary =8 = '=Q=}3§’ 0B PE D= o &P § Page20ofaii

Border

o

HOME

Lets users open a designated home page (such as your company's website)

Toolbar Items | Home

|

‘ Glossary D : =gy [PFARXEDME LD 0D 0 F P20

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the
next topic from there. If you are using HTMLS Side Navigation, Top Navigation, or
skinless output, or if you are not using a browse sequence, Flare Desktop looks at the
position of the current topic in your table of contents (TOC) and opens the next topic
after it.

Toolbar Iltems | Next Topic

|

Glossary G e — W%'@ﬁ@@ﬁ@ﬁl:ﬁ@Q@Pagez6‘m0dccp|
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence,
Flare Desktop attempts to find the current topic in a browse sequence and navigate to
the previous topic from there. If you are using HTMLS5 Side Navigation, Top Navigation,
or skinless output, or if you are not using a browse sequence, Flare Desktop looks at
the position of the current topic in your table of contents (TOC) and opens the previous
topic before it.

Toolbar Items | Previous Topic

|

P AR XREH D @p@ﬁ#@agezum@ lecdcap”

H Glossary BEE = % |ouckeenn

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

Toolbar Items | Print

Border | General

‘ Glossary o = L& wick zearch |=):' f H B K Fczl

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been
typed in the field next to the button.

Toolbar Items | Quick Search

e

Glossary B = = ielauickcearn FPEFaApRpRIBODBEL, Do
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REFRESH

Lets users update the content of the topic being viewed.

Toolbar Items | Refresh

|

H Glossary A e PFlaw R DB LD D = L@

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

Toolbar ltems | Remove Highlight

Border | General

Glossary ER = % w||Qukean -u PRIDDELE D S

SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

Toolbar ltems | Select Browse Sequence

\

LEAPXTH OB LOE Dk P§ ragezorsfy & madeg

H Glossary i Y [F—

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

Toolbar Items | Select Community
Border General

ToC Jedriieie | B B R @ |[Quickeeann

PrlawvxapDprdales & medeop
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SELECT FAVORITES

Lets users open the Favorites feature.

Toolbar Items | Select Favorites

-

General

” Glossary I~ s |

S P FARXEROELHOR 9 P @ rage20f S ma

SELECT GLOSSARY

Lets users open the Glossary feature.

Toolbar ltems | Select Glossary

Border

General

|| Glossary B R = = & ||cuickesarn

ﬁf‘ﬂ»%%ﬁ@@Q@Q@Pagezam@@-\m

SELECT INDEX

Lets users open the Index feature.

Toolbar Items | Select Index

|l

General

|| Glossary

PYUAURXTRBEP IO Do P rage20af
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SELECT LANGUAGE

Lets users switch between languages using a drop-down menu, if you have built

multilingual output.

Spanish, and Japanese Help in your HTMLS5 output.

Before you can build your output, you need to make sure that each of your
linked multilingual projects has the Select Language button is available in its
HTMLS5 toolbar, and that you've added the Topic Toolbar proxy to a template

ﬁ EXAMPLE You want your users to be able to switch between US English,

page. If it the button isn't there, users won't be able to switch from one
language to another in your output.

Open the Project Organizer. In the Skins folder, open the Topic Toolbar skin
component. On the Setup tab, select the Select Language button, click to

add it to your skin, and then save your work.

= Project Organizer

EEEEEE NS

& Project
1[] Advanced
Conditional Text
Destinations
||| Exports
Glossaries
[ | Imports
_1[ ] Reports
Skins

% Home-5earchbar

[ [ ] Topic Toolbar ‘
[ [ ] Topics-Menu

&

B

Topics-Searchbar
Top-Mavigation
C o [] Targets
= [3 [ ] HTMLS (Primary)
o[ | PDF
TOCs
Wariables

W

® Topic Toolbar * \
Topic Toolbar Skin Editor

ARl = Topic Toolbar

Start Page X .

Setup Toolbar Buttons

Styles | Available

Ul Text EditUserProfile
ExpandAill
Filler

Print

RemowveHighlight

SelectSkin

TopicRatings

} Selected

PreviousTopic
CurrentTopicindex

MNextTopic

Now you can prepare and build your multilingual output.

When you open the HTML5 output, it defaults to the US English Help because

that is your browser’s default setting.
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drop-down menu.

% However, because you added the Select Language button to your Topic
Toolbar skin component, you can easily change the language setting using a

Getting Started Procedures FAQs Tips Company
' English
United
Getting Started E
States)
What's New )
andit sapidn a dolor Basic Steps A4S
ollis frhngilla mauris. Dondc
Procedures
e lectus augte, auctor in EAQs Espafiol
korem ac placerat. Akiquam Tips
er pukvinar lacus libern, eget ~ Company
telpus nisl

Now the Japanese project is listed before the Spanish project.

SELECT SEARCH

Lets users open the Search feature.

Toolbar Items | Select Search

T :
el 1P TR XERBALPC % 5 O @rmerais &

B0 %

Glossary
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SELECT SKIN

Lets users choose from multiple skins to change the display of the output.

% EXAMPLE Your main Top Navigation skin has a black header background, but
you want users to be able to select a skin with a green header background and
a different logo, or even a third skin that does not have a header at all.
Therefore, you create the additional skins and edit them to look the way you
want. Then you add the Skins button in your Topic Toolbar skin component.

In the output, a user can click the button [¥8] in the topic toolbar and choose one
of the options, which are based on the skin file name.

In this example, the Black skin is
currently shown around the topic
content, but you can click here and
select one of the other skins to
changethelook.

Getting Started Links and Lists

Getting Started
Basic Steps
What's New

Links and Lists

No Header

lace this with your own

Images
More Features

ace this with your awn

lace this with your own content.

ist item. Replace this with your own content. Here is some general text for a
ome general text for a list item. Replace this with your own content.
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% If the user selects Green, the output might look something like this:

gYOUR LOGO Getting Started Links and Lists Images More Features
Search -

Getting Started Getting Started
Basic Steps
Whats New

See the following to get started quickly

Links and Lists
Images
More Feaiures

3 Do This Here is some general text for a list item. Replace this with your own
contant. Here is some general text for a listitem. Replace this with your own
content.

¥ Do That Here is some general text for a listitem. Replace this with your own content.

¥ Do The Other Thing Here is some general text for a listitem. Replace this with your own content. Here is some general text fora
listitem. Replace this with your own content. Here is some general text for a list item. Replace this with your own content.

And if the user selects NoHeader, the output might look something like this:

Getting Started Getting Started

Basic Steps
See the following to get started quickly

Whats New
Links and Lisis
Images
More Feaiures

¥ Do This Here is some general text for a list item. Replace this with your own
content. Here is some general text for a listitem. Replace this with your own
content.

¥ Do That Here is some general text for a listitem. Replace this with your own content.

¥ Do The Other Thing Here is some general text for a listitem. Replace this with your own content Here is some general text for a
listitem. Replace this with your own content. Here is some general text for a list item. Replace this with your own content.
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% The name of the skin is reflected at the end of the URL in the browser.

Le
1_?_:,
#
[

20Started/Getting%20Started.htm?skinName=No_Header |

|
1]
%

Getting Started

Basic Steps
What's New
- Links and Lists
5 with your own
o Images
b with your own More Features

E with your own content.
Replace this with your own content. Here is some general text for a

tneral text for a list item. Replace this with your own content

SELECT TOC

Lets users open the TOC feature.

Toolbar Items | Select TOC

=
% ilapa¢

Glossary ERE = = g  [P£FHPB K = &2 |1 Page 2 of 4]
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SEPARATOR

This is the divider on the side of the row of buttons.

Toolbar Items | Separator

General
Index \k‘k\k\k\kﬁ O %= %= Q |'.-.-':-c355-‘:-- |§£:] f 4 B
1
STOP

Lets users prevent a page from downloading file information.

Toolbar Items | Stop

Borden | General

H Glossary n;:;:ggﬁf«wau@paﬁéﬁé’@me

TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output
window.

Toolbar Items | Toggle Navigation Pane

Eorder General
: : = T U | P ———
: i g |--.. ck zearch

| Glossary

c. Click OK when you are finished.

7. Click OK. The proxy is added.

8. Click [l to save your work.
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Editing a Topic Toolbar Proxy

After inserting a Topic Toolbar proxy, you can edit it. To do this, open the topic or template page
where the proxy is inserted, right-click on it, and select Edit Topic Toolbar Proxy.

What's Noteworthy?

NOTE Although you can insert Topic Toolbar proxies in most of the online outputs,
choosing the buttons for the toolbar can be done in the skin for only some outputs. For
Microsoft HTML Help output, you can select buttons in the Topic Toolbar proxy only.

NOTE If you are generating an Eclipse Help target that uses a Topic Toolbar proxy, Flare
Desktop will automatically remove the proxy when building the output. This is because the
Eclipse development platform provides its own toolbar support. See the Platform Plug-in
Developer Guide from Eclipse at: help.eclipse.org
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Other Information for Topic Toolbars

In addition to the primary concepts, there is some additional information that might help you when

working with this feature.

Topic Toolbar Buttons Supported

Although topic toolbars can be added in most online outputs, only certain buttons are supported in

the various outputs. The following table provides an overview.

The following table does not list Pulse-related toolbar buttons, such as Edit User Profile and Topic

Ratings. These kinds of buttons must be added either via the web toolbar (for HTML5 Tripane,

WebHelp, or WebHelp Plus outputs) or the Topic Toolbar skin component (for all HTML5 outputs).

Add Topic to
Favorites

Back

Collapse All

Current Topic
Index

Expand All

Forward

Home

CHAPTER 18

HTML Help

x

HTMLS

X

WebHelp Plus

321



HTML Help HTMLS WebHelp WebHelp Plus

Next Topic v V'3 v v
Previous Topic v V'3 v v
Print v v v v
Quick Search v X v v
Refresh v X v v
Remove Search v v v W
Highlight

Select Browse X x v v
Sequence

Select b4 v v v
Community

Select Favorite x X v v
Select Glossary p 4 b 4 v 4 v
Select Index X x v v
Select b4 v X b4
Language
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Select Search

Select Skin

Select TOC

Separator

Stop

Hide Navigation

HTML Help

%

x

HTMLS

x

WebHelp WebHelp Plus

1Collapse All and Expand All are the same button for HTMLS.

2This button is supported only for HTML5 output that is using a Tripane skin. It is not
supported for HTMLS output using a Top Navigation skin, or no skin.

3If you are using a Tripane skin, this button lets you navigate browse sequences. If you
are using a Top Navigation skin or no skin (or if you are using a Tripane skin without a
browse sequence), this button lets you browse table of contents entries.
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Previous and Next Buttons

The Previous and Next buttons in HTML5 output using Side or Top Navigation skins (or no skin)
differ from those in other WebHelp and other output types (including HTML5 outputs using a
Tripane skin). In WebHelp and other output types, the Previous and Next buttons navigate between
topics in a browse sequence (if one is available); otherwise they navigate between topics in the

table of contents.

¢ EXAMPLE — HTMLS5 Top Navigation (TOC)
You might want to include Previous and Next buttons in your online HTML5 Top Navigation
output when you use topics that are sequential, such as a tutorial or a long process
spanning many topics.
In this example, a user tutorial has several numbered topics that have been added to the
table of contents (TOC). We've added a menu proxy so that these TOC items display next to
the open topic.

‘You are here: Tutorial > Step 1. Starting & Project

Step 1: Starting a Project Tt
Step 1: Starting a Project

Begin by creating a new Flare project and takind There are many numbered
topics in this tutonal.

1 Creating a Project The Start New Projec ] ] Step 3: Making it Look Good
template, an existing project, or an imported project. In this tutorial, we will create a Step 4: Developing Targets

new project from a Flare template. Step 5: Building Output

Step 2: Adding Elements

2. Touring the Workspace After creating you project, you should familiarize yourself
with the Flare workspace before doing too much. This tutonial covers several major areas of the workspace.
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% When users work through the tutorial, they start at Step 1 and then logically progress

through each topic using the Next button.

i
@
1§
3

- _' _ Click this button to navigate
ca : ok to the next topic.
2L A0 "
E a project from a e aking it Look Good
Al we will create a ep 4: Developing Targe

Amiliarize yourself
vers several major areas of the workspace.

1]
@

You are here: Tutorial = Step 2° Adding Elements

Step 2: Adding Elements Tutorial
Now that you have created a project, it is tim e it (T TS = = Start!ng PRk
your project some substance. You can add a a project. B ——

Step 3: Making it Look Good

1. Topics You might say that topics are the most important part of a Flare project Step 4: Developing Targets
because they hold and display your content Step 5: Building Output

2. Images You can insert images into topics. Flare supports most common image file

formats.
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% If they need to go back to a previous topic in the TOG, it is easy for the user to click the
Previous button to find the topic.

VES

E file

i
@
*
}

Tutorial
Step 1: Star
Step 2: Add
Step 3: Making it Look Good

Click this button to navigate
to the previous topic.

Step 4: Developing Targets
Step 5: Building Output
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9% EXAMPLE — WebHelp (Browse Sequence)

Let's say you want to add Next and Previous buttons, as well as the Home button, at the
bottom of each topic in your WebHelp output. The buttons will use a browse sequence that
you've added to your output.

Therefore, you open your skin and select the Topic Toolbar tab. The default settings
already include the Next Topic, Current Topic Index, and Previous Topic items.

The Selected section already includes some of
Skin Editor  Preview as} the items we want. However, we want to remove

the Current Topic Index from the toolbar.

Zeneral

Size

About
WebHelp Setup

WebHelp Toolbar

Topic Toolbar

Cornrnuniky
HTML Help Setup

Skyles

\

Toolbar Buttons

Available |
AddTopicToFavarites

Back CurrentTopicIndex
Collapseall MextTopic
Expandall
Forward
Home

Print
QuickSearch

Refresh

RemoveHighlight

m

SelectBrowseSequence
SelectCommunity
SelectFavarites
SelectGlossary

SelectIndex
SelectSearch
SelectTOC

[t -

A A 1 @ ¥ 1 =
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¢ In the Selected section, you select CurrentTopiclndex and click[%] at the bottom of the tab.
This moves that item back to the Available section on the left.
Skin Editor | Preview as} Now we Just have the les WebHelp Window
Previous Topicand \
i Next Topic items.

zeneral

S Available s | Selected

About \PrevinusTDpic

WebHelp Setup Back
Collapseall

WebHelp Toolbar CurrentTopiclndex

Topic Toolbar :rp:::" The Current Topic Index

Community o item is now over here.

HTML Help Setup Print

Styles QuickSearch
Refresh

R RemoveHighlight
SelectBrowseSeguence
SelectCommunity
SelectFavorites
SelectGlossary i
SelectIndex
SelectSearch
A 3
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ﬁ Next, in the Available section, you select the Home item and click [ to move it to the
Selected section.

Skin Editor | Previewq 1he Home button |, as webHelp Window
has been added.

. We'll leave the items

General in this order.
Sz Available
About AddTopicToFavorites
Back PreviousTopic
WebHelp Setup
Collapseall MextTopic
WebHelp Toolbar CurrentTopicIndex
Topic Toolbar ExpandAl
Forward
Cormuniky .
Print
HTML Help Setup QuickSearch E
Refresh
Skyles

RemoveHighlight

\ SelectBrowseSeguence
SelectCommunity

SelectFavorites

SelectGlossary
Selectindex

SelectSearch
SelectTOC

[t -

A 4 1 ¥ ¥ (1) ()
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% Now that the settings in the Skin Editor are completed, you can save your changes and
insert the Topic Toolbar proxy (alternatively, you could have inserted the proxy before
editing the skin). If you had wanted the custom toolbar to display in only a few topics, you
would probably insert the proxy directly into those topics. However, because you want the
toolbar to display at the bottom of every topic, the best way to accomplish this is to insert
the proxy into a template page.

bresdcrumbs prooy

Mad...

topic body proxy

topic toolbar proxy

\ In this example, a Topic Toolbar proxy

has been inserted at the bottom of a
template page, below a Breadcrumbs
proxy and a Body proxy.
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% After making sure both the skin and the template page are associated with the WebHelp
target, you can generate the output.

B = %o LF AR XTHDE L OEH & | madcap

T

In the output, notice that the regular Thattoolbarincludes the
toolbar (which is specifiedinthe [ adipiscing elit| Previous and Next buttons (as
WebHelp Toolbar tab of the Skin ~ plit. onare vek ¢ Well as the Home butfon),  pndc
Editor) is still shown_ because we did Jam mollis id. S§ which are part of the default
not specify otherwise. se bhbendum | toolbar layout. uam
u, gravida qtis e | eget
volutpat enil finibus non. Aliqu'm erat volutpat. Ph’sellus finibus telpus nisl.

1. Lorem ipsum dolor rit amet, consectettr adipiscing elit.

2. Eusce blandit sapidn a dolor accumsan “ccumsan.

3. Nullam nepue velit, ornare_ vek orci vel._mollis frhngilla mauris.

4. Dondc sagittis elemensuny Here s the custom topic IS 19

5 Suspdndisse lectus augge! toolbar that we created fila id dnlor. Suspendisse
bhbendum imperdi thatincludesonlythe fus maurir, ornare tincidunt
qutrum eu, gray Home, Previous, and  ern, eget volutpat enil finibus
non. Aliqu, Next buttons. G|

AR alli:N
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Y% Suppose you have created your own arrow images and want to use them instead of the
images provided by Flare Desktop. You can simply select your image files in the Styles tab
of the Skin Editor.

General ‘ Styles Show Preview
@ Property Groups

We've selected the

4 I

) Alphabetical List

Next Topic style
underthe Toolbar -ToolbarTtem Propertis
Item node - AccordionTitle
- AddTopicToFavarites E Genera j=
" Back Icon resources;WebHelp/Default, Fwhtfd.|.
. - Collapseall -
Topic Toolbar CurrentTopicindex | Pressedlcon resaurces:WebHelp/Def aulk. FlwhefL.|. |
Community - EditlserProfile Haverloon A resources:WebHelp/Def aulk. FwhtfT.|. T

- ExpandAll ool
HTML Help Setup - Forward L4
.. Home TextImageRelation

Styles Logo Toolip
e ‘ NextTopic | . a
- PreviolsTopic Here is where you can )

-~ Print n{ select differentimages to

- QuickSearch

.

2 be used for the button in
a il | D its different states
(normal, pressed, hover).

Afterwards, the output might look something like this:

BoE oo ¥ AR RETHDODE L O & | madcap

You are here: Welcome

Welcome

Lorem ipsum dolor rit amet, consectettr adipiscing elit. Eusce blandit sapidn a dolor
accumsan “ccumsan. Nullam nepue velit, ornare vek orci vel, mollis frhngilla mauris. Dondc
sagittis elemensum arcu, at gravida puam mollis id. Suspdndisse lectus augte, auctor in
aliqual nec, fringilla id dnlor. Suspendisse bhbendum imperdiet korem ac placerat. Akiquam
purus maurir, crnare tincidunt qutrum eu, gravida gtis nisi. Integer pukvinar lacus libern, eget
volutpat enil finibus non. Aligu'm erat volutpat. Ph™sellus finibus telpus nisl.

1. Lorem ipsum dolor rit amet, consectetir adipiscing elit.

2. Eusce blandit sapidn a dolor accumsan “ccumsan.

3. Nullam nepue velit, orare vek orci vel, mollis frhngilla mauris.

4 Dondc sagittis elemensum arcu, at gravida puam mollis id.

5 Suspdndiss iqual nec, fringilla id dnlor. Suspendisse
bhbendum | Now the toolbaris  [at. Akiquam purus maurir, ornare tincidunt
qutrum using ourcustom kvinar lacus libern, eget volutpat enil finibus
non. ammow butions. nibus telpus nisl.

o
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I Web Toolbars

WEB
HELP

Supported In:

HTML

M5
HTRIL
HELP

Creating a web toolbar is simply a matter of adding and editing the appropriate skin, depending on
the output type. As long as that skin is associated with your target, end users will see the web
toolbar in the output.
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Web Toolbars in HTMLS Output

You can specify web toolbar settings for some online outputs. This includes determining which
buttons are displayed in the web toolbar. You can also add custom JavaScript for the toolbar.

How to Specify Custom Toolbar Settings for HTMLS
Output

1. Open an HTMLS Tripane skin.
2. Select the Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow

button to move items from the Available section to the Selected section.

Following are descriptions of the various items.

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare Desktop finds the current topic in a browse sequence and
display its position in relation to the rest of the topics in that sequence. (The root node is
used to determine the count; in other words, if there are "child" topics in the sequence
structure under the current topic, they will be included in the count.)

Toolbar Button | Cumrent Topic Index

Padding | Border | Background |

@ madcap Search AlFis v | O

Contents

Index

Glossary ~ Browse IR % i

Book A . ind
[l BookB Toplc A ‘ﬂ
[l Werged al =] | [« [

Chunk

ﬁ Chunk (link) Lorem ipsum dolor sit amet. consectetur adipiscing elit. Donec a

=] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar

=] Topic Toolbar lobortis, velit magna sodales lectus, sit amet interdum magna urna

5] New Topic eget leo. Pellentesque risus eros, vehicula non tempus at, bibendum in

|5] Help Controls 4 neque. In mollis malesuada facilisis. Nullam nibh libero, gravida

=] Equation and QR Code I dapibus laoreet non, elementum nec sapien. Mullam in lacus libero.
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EDIT USER PROFILE

Lets users edit their Pulse or Feedback registration profile settings.

o/

Toolbar Button | Edit User Profile

.
& madcap AllFiles ¥

Contents

[l BookA

[l BookB =
[l Merged B8 (=] | [«] [»

[l chunk

[l Chunk (link) Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a

|=] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar

Padding | Border | Background | | Position 1

Index

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text

effects in a topic (if they are not yet expanded).

Toolbar Bulton | Expand All

Padding | Border | | Background 1 Position

Contents Index

[l ook A . =
[l BookB TOpIC A =
[l Merged al =] | [« [+

[l Chunk

[l Chunk (link) Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a

=] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar

=] Topic Toolbar lobortis, velit magna sodales lectus, sit amet interdum magna urna

=] New Topic eget leo. Pellentesque risus eros, vehicula non tempus at, bibendum in

=] Help Controls neque. In mollis malesuada facilisis. Mullam nibh libero, gravida

=] Equation and QR Code

=] Proxies

AllFiles * | O

dapibus laoreet non, elementum nec sapien. Nullam in lacus libero.

Cras vel risus et quam luctus vehicula. Morbi sapien diam, posuere eu
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FILLER
Lets users add a filler item, which is used to specify where the empty space should go in the
toolbar.

a

i
4
Y
4
s
4
!
4
Y

"Filler" area

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the next
topic from there. If you are using HTMLS5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the next topic after it.

Toolbar Button | Next Topic

| Padding | Border Background | Position

AllFiles * | O

Contents Index Glossary Browse PRV RS R R -l
[l BookA . i
[l BookB Toplc A H
i [ d —
[l Merged al = | [« [+
[l chunk
[l chunk (link) Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a
=] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar
*| Topic Toolbar lobortis, velit magna sodales lectus, sit amet interdum magna urmna
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the previous
topic from there. If you are using HTMLS Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the previous topic before it.

Toolbar Button | Previous Topic

[ Padding | | | | Background | Position |

&. madcap Mfies*| O

Contents

a8 E

[ Book A . nl
[l BookB TOpIC A H
[l Merged al = | [« [

Il chunk

i Chunk {link} Laorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a

|£] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

Toolbar Button | Print ) o o o
‘ Padding | Border [ Background | Position

L
& madcap Allfies ¥ | O

Contents Index G y =% W 7

[l Book 2 . S
[l BookB TOpIC A H
[l vergea 8l = | [« [»

[l chunk

[l chunk (link) Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a

|Z] Topic dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar

|£] Topic Toolbar lobortis, velit magna sodales lectus, sit amet interdum magna urna

|Z] Mew Topic eget leo. Pellentesque risus eros, vehicula non tempus at, bibendum in

|=] Help Controls 4 neque. In mollis malesuada facilisis. Nullam nibh libero, gravida

|5] Equation and QR Code dapibus laoreet non, elementum nec sapien. Mullam in lacus libero.

|Z] Proxies I Cras vel risus et quam luctus vehicula. Morbi sapien diam, posuere eu
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REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is

highlighted. This button lets users turn the highlights off.

TOPIC RATINGS

Lets users submit ratings for a topic (if you have incorporated your output with MadCap

Pulse or Feedback).

Toolbar Button | Topic Ratings (full)

Contents Index

[l BookA

[l BookB

[l Merged

[l chunk

[l chunk (link)
|&] Topic

|&] Topic Toolbar
|&] New Topic
|=] Help Controls

Padding l | | Background

AllFiles ¥

Position

Pel

Topic A

(=]

1]
3
3

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Donec a
dictum dolor. Suspendisse potenti. Donec commodo, mi et pulvinar
lobortis, velit magna sodales lectus, sit amet interdum magna urna
eget leo. Pellentesque risus eros, vehicula non tempus at, bibendum in
neque. In mollis malesuada facilisis. Nullam nibh libero, gravida

m_ | »

4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.
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Option Description

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click |Z] to move it
to the Selected section.

If you want to provide a command for the custom button (e.g., so that
clicking the button opens a website), you can select the Styles tab in the Skin
Editor, select one of the styles listed above, expand the Event property group,
and enter a command in the Click field. For example, the following command
opens the MadCap Software website when a user clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Toolbar tab to enter a
command for the button. See the next step.

Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the
output, buttons are displayed left to right according to the order in which
they appear on this tab, with the item at the top being the first button shown
on the left in the output.

Moves the selected item down in the order in the Selected section.

[=]

Removes the selected item(s) from the Selected section.

Adds a separator to the Selected section. A separator is the divider between
the toolbar buttons and the navigation pane.
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Option Description

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()

{

window.open("http://www.madcapsoftware.com");

}

6. CIicklE' to save your work.
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Web Toolbars in HTML Help Output

If you incorporate MadCap Feedback into your Flare project and generate Microsoft HTML Help
output, a web toolbar is automatically added to the top of each topic in the CHM file. However, this
toolbar is not only for MadCap Feedback. Even if you are not using Feedback in your project, you
can add the web toolbar to your Microsoft HTML Help output.

In addition to submitting topic ratings and comments, the default buttons in the web toolbar let
users expand or collapse Dynamic HTML effects (e.g., drop-down text, expanding text), search, go
to the next or previous topic, and more. You can change the buttons included in the web toolbar,
removing ones you do not want and adding others.

How to Specify Custom Toolbar Settings for HTML
Help Output
After adding the web toolbar for Microsoft HTML Help output, complete the following steps.
1. Open a Standard skin.
2. Select the WebHelp Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Iltems that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow

button to move items from the Available section to the Selected section.

Following are descriptions of the various items.

BACK

Lets users open the topic that was viewed previously.

Toolbar Items | Back

L =
o [l R + A

General
Glossary mE = BLODD oL
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COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).

Toolbar ltems | Collapse All

‘ Glossary

ral

[
)

N

o

©
| %
£
¥

CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare Desktop finds the current topic in a browse sequence and
display its position in relation to the rest of the topics in that sequence. (The root node is
used to determine the count; in other words, if there are "child" topics in the sequence
structure under the current topic, they will be included in the count.)

Toolbar Items | Current Topic Index

L
PP AP RTHD @paa¢a@lapagezom@lc}\mwccpl

H Glossary B %= % & |[sucke=amn

EDIT USER PROFILE

Lets users edit their Pulse or Feedback registration profile settings.

Toolbar Items | Edit User Profile

Index u‘r‘“\m = T i |[Quicks=srch 120 %@ W
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EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

Toolbar Items | Expand All

‘ Glossary

neral

Q)
(12

|‘:_. ck zearch |=}:] f H W %

FORWARD

Lets users open the next topic in a previously viewed sequence.

Toolbar Items | Forward

Border General

|
H Glossary BHrs e 1P¥WPKTB/ODE LD DD o D@ rage20ay

HOME

Lets users open a designated home page (such as your company's website)

Toolbar ltems | Home

Border General

H Glossary B e PYARXERPEL DO D @ £ Pauezolp

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the next
topic from there. If you are using HTMLS Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the next topic after it.

Toolbar Items | Next Topic

|

| Glossary Arn o 9*ApXERBBS 00 %0 P raedof & modeop |
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PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the previous
topic from there. If you are using HTMLS Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the previous topic before it.

Toolbar ltems | Previous Topic

Border | General

” Glossary B e Qﬁf«»%@@@@p@ﬁ#@ageﬂ:m@ 6\"‘!0(100[.)”

PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

Toolbar ltems | Print

‘ Glossary =

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

Toolbar Items | Quick Search

AP XTHLIODBELFID

Glossary
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REFRESH

Lets users update the content of the topic being viewed.

Toolbar Items | Refresh

Glossary

E o :::; |’..- ck zearch

R

@@paa¢@@@F

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is

highlighted. This button lets users turn the highlights off.

Toolbar ltems | Remove Highlight

General

O %= %

ke zearch

Glossary Qg, >

B LB B

elwxena

STOP

Lets users prevent a page from downloading file information.

Toolbar ltems | Stop

General

” Glossary |2 ¥4

@Q@p@ﬁ%@&@?age

TOPIC RATINGS

Lets users submit ratings for a topic (if you have incorporated your output with MadCap

Pulse or Feedback).

Toolbar ltems | Topic Ratings

Index BT Iz
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4. (Optional) You can use the buttons at the bottom of the tab to perform additional tasks.

Option Description

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click | to move it
to the Selected section.

Unless you specify otherwise, in the output the new button will display the
text for the name you gave it. However, you can change this by editing the
control type for the new button. To do this, you can select the Styles tab in
the Skin Editor, expand the Toolbar Item node, select one of the styles listed
above, expand the Type property group, and from the Control Type field
select Button. To choose an image for the button, expand the General
property group on the Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that
clicking the button opens a website), you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and enter a command in the OnClick field.
For example, the following command opens the MadCap Software website
when a user clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the WebHelp Toolbar tab to
enter a command for the button. See the next step.

Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the
output, buttons are displayed left to right according to the order in which
they appear on this tab, with the item at the top being the first button shown
on the left in the output.
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Option Description

Moves the selected item down in the order in the Selected section.
Removes the selected item(s) from the Selected section.
Adds a separator to the Selected section. A separator is the divider between

the toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()

{

window.open("http://www.madcapsoftware.com");

}

6. CIicklE' to save your work.

NOTE You can also specify which buttons should be included in the navigation toolbar at
the top of the CHM window.

NOTE You can also add a web toolbar that is displayed within topic content. This can be
done with the help of a topic toolbar proxy.
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Topic Toolbars in WebHelp Outputs

Supported In:

() IMPORTANT WebHelp and WebHelp Plus are deprecated in Flare Desktop, which means
that they are slated to be removed in a future version.

In addition to the regular web toolbars that can be included in all most online outputs, you have
another option for including toolbars. This option lets you insert toolbars anywhere in any topics.
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How to Specify Topic Toolbar Settings in a Standard

Skin

1. Open a Standard skin.
2. Select the Topic Toolbar tab.

3. Select options to include specific features (buttons) in the toolbar. Items that will be included
in the toolbar are displayed in the Selected section on the right. Items that will not be included
in the toolbar are displayed in the Available section on the left. You can use the right arrow

button to move items from the Available section to the Selected section.

These items will
not be included
in the toolbar.

These items will
be includedin
the toolbar.

4

N/

Back

Collapseall

Expandall

Forward

Home

Print

QuickSearch

Refresh
RemaoveHighlight
SelectBrowseSequence

SelectFavarites

Available Selected L4
AddTopicToFavarites

CurrentTopicIndex
MextTopic

Following are descriptions of the various items.
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ADD TOPIC TO FAVORITES

Lets users add the active topic to the Favorites pane so that they can quickly access the topic
in the future.

Toolbar ltems | Add Topic To Favorites

Border General

‘ Glossary e i‘é.“i:-':-czes-:- |=$:] f|@ [

BACK

Lets users open the topic that was viewed previously.

Toolbar Items | Back

Glossary D B Q“‘:;-':*:es-:f |0 PR S @|D BPLPow = |£

Border General

COLLAPSE ALL

Lets users collapse all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are expanded).

Toolbar Items | Collapse All

‘ Glossary O & E ._-_ ||i:-':-r:-zs-~:- |=J:] E“"|;ﬂ EN)

ral

]
(12

1l

45
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CURRENT TOPIC INDEX

Lets users see the display for the current topic in the sequence. This is typically used in
conjunction with the "Next Topic" and "Previous Topic" buttons when the topic in question
exists in a browse sequence. Flare Desktop finds the current topic in a browse sequence and
display its position in relation to the rest of the topics in that sequence. (The root node is
used to determine the count; in other words, if there are "child" topics in the sequence
structure under the current topic, they will be included in the count.)

Toolbar Iltems | Current Topic Index

Border | | General

H Glossary ED: =@ P¥ AR XD ODBELED Do PG rage2or45 &  madcap |

EXPAND ALL

Lets users expand all elements such as togglers, drop-down effects, and expanding text
effects in a topic (if they are not yet expanded).

Toolbar Items | Expand All

|

‘ Glossary " |:.. ck search |=éf,:) f H bR

FORWARD

Lets users open the next topic in a previously viewed sequence.

Toolbar Items | Forward

Border General

| |
H Glossary BEtragfo=e  (P¥YWAPKZDODE LD D> o @ rae2oaf

CHAPTER 18 357




HOME

Lets users open a designated home page (such as your company's website)

Toolbar Items | Home

=

Glossary mD = E=;:';gﬁf«»%%@p@ﬁﬁb@&@%gezmnlﬁ

NEXT TOPIC

Lets users open the next topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the next
topic from there. If you are using HTMLS5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the next topic after it.

Toolbar Items | Next Topic

|

‘ Glossary me = ':::;‘g?Z@W%@ﬁ@@p@ﬁ¢@§@hgez@-\mudcop|

PREVIOUS TOPIC

Lets users open the previous topic in the output. If you are using a browse sequence, Flare
Desktop attempts to find the current topic in a browse sequence and navigate to the previous
topic from there. If you are using HTMLS5 Side Navigation, Top Navigation, or skinless output,
or if you are not using a browse sequence, Flare Desktop looks at the position of the current
topic in your table of contents (TOC) and opens the previous topic before it.

Toolbar ltems | Previous Topic

|

Glossary Honnofre:  |[PPABKIPDE LD DD B faezasyy & madeon |
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PRINT

Lets users open the Print dialog so that they can send the open topic to the printer.

Toolbar Items | Print

Border General

‘ Glossary O = wick search |0 % @ B R %

QUICK SEARCH

Lets users initiate a search in the active topic for the word or phrase that has been typed in
the field next to the button.

Toolbar Items | Quick Search

General

AP XEH DB L,

Glossary D = iz sl Quick search

REFRESH

Lets users update the content of the topic being viewed.

Toolbar ltems | Refresh

|

” Glossary ERE = = | ﬁf«w@@p@ﬁﬁ@&@F

REMOVE HIGHLIGHT

After a user performs a quick search in a topic, the search text found in the topic is
highlighted. This button lets users turn the highlights off.

Toolbar Items | Remove Highlight

Border | General

|| Glossary AEx:efcer  JHBYRBXZBOBELTOS
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SELECT BROWSE SEQUENCE

Lets users open the Browse Sequence feature.

Toolbar ltems | Select Browse Sequence

| ol

General

“ Glossary i [l R N [N —

Py W%@ﬁ@@ﬁ@ &5 4 Page2of4f @ | madcq

SELECT COMMUNITY

Lets users access their Pulse community features, if the are using MadCap Pulse.

Toolbar Items | Select Community

Border

General

|||||

TOC Yokl |E R RS

PrawxepDbBodally

& | madcap

SELECT FAVORITES

Lets users open the Favorites feature.

Toolbar ltems | Select Favorites

Border

| gule

General

[

” Glossary

S PP AR RBBDEAHOP @ P @raezody S ma

SELECT GLOSSARY

Lets users open the Glossary feature.

Toolbar Items | Select Glossary

General

B E = i & |[ouiksean

” Glossary

:pgmwx@z@@@¢@.§mpagem4mawm
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SELECT INDEX

Lets users open the Index feature.

Toolbar Items | Select Index

|

General

” Glossary [

I AR RS D EEQ@&@Pagean&lm

SELECT SEARCH

Lets users open the Search feature.

Toolbar Items | Select Search

|

General

| Glossary Brs e (9 AP XFQBHIPC D5 & & paerea® &

SELECT TOC

Lets users open the TOC feature.

Toolbar Items | Select TOC

|

General

” Glossary BE = & & |cuicsesrn

PEARPRZOOE LD D 5 P rage2ors

STOP

Lets users prevent a page from downloading file information.

Toolbar ltems | Stop

General

|

H Glossary B e

ﬁf«@@@p@ﬁ‘;@@@%ge
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TOGGLE NAVIGATION PANE

Lets users toggle between hiding and showing the navigation pane in the output window.

Border

‘ Glossary

Toolbar ltems | Toggle Navigation Pane

=

BF: % @ ]3P FA R

4. (Optional) You

Option

CHAPTER 18

can use the buttons at the bottom of the tab to perform additional tasks.

Description

Opens the New Toolbar Button dialog, which lets you add a custom button to
the toolbar. After creating the custom button, select it and click | to move it
to the Selected section.

Unless you specify otherwise, in the output the new button will display the
text for the name you gave it. However, you can change this by editing the
control type for the new button. To do this, you can select the Styles tab in
the Skin Editor, expand the Toolbar Item node, select one of the styles listed
above, expand the Type property group, and from the Control Type field
select Button. To choose an image for the button, expand the General
property group on the Styles tab and select image files in the Icon fields.

If you want to provide a command for the custom button (e.g., so that
clicking the button opens a website), you can select the Styles tab in the Skin
Editor, expand the Toolbar Item node, select one of the styles listed above,
expand the Type property group, and enter a command in the OnClick field.
For example, the following command opens the MadCap Software website
when a user clicks the button:

window.open("http://www.madcapsoftware.com");

Alternatively, you can use the JavaScript area on the Topic Toolbar tab to
enter a command for the button. See the next step.
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Option Description

Removes the selected custom button from the Available section.

Moves the selected item up in the order in the Selected section. In the
output, buttons are displayed left to right according to the order in which
they appear on this tab, with the item at the top being the first button shown
on the left in the output.

Moves the selected item down in the order in the Selected section.
Removes the selected item(s) from the Selected section.
Adds a separator to the Selected section. A separator is the divider between

the toolbar buttons and the navigation pane.

Resets the toolbar to the default settings.

5. (Optional) If you want to include custom JavaScript in the toolbar, click Edit in the area to the
right. This opens the Toolbar JavaScript dialog, which you can use to enter or load custom
JavaScript for the toolbar.

For example, the following command opens the MadCap Software website when a user clicks
the button:

function MyFunction()

{

window.open("http://www.madcapsoftware.com");

}

6. CIicklE' to save your work.
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| eLearning Toolbars

An elearning course should be easy to follow from beginning to end. The eLearning Toolbar proxy
lets you include intuitive navigation buttons and controls in your course. These might be a Next and
Previous button, or a progress bar. When you build HTML5 output, the proxy content is replaced
with the generated navigation tools.

How to Add the eLearning Toolbar Proxy to a
Template Page

To get the navigation tools to display in the output, the eLearning Toolbar proxy needs to be added
to a template page. The proxy is a placeholder to generate the eLearning toolbar in the output. The
proxy will show up in all the topics where the template page is applied.

1. From the Content Explorer, expand Resources > TemplatePages. This is the default location
for template pages. However, you might keep yours in a different location. Open the template
page applicable to the course topics (e.g., Other-Topics.flmsp).

2. Place your cursor at the location in the template page where you want to add a proxy (e.g.,
after other proxies).

bresdcrumbs proxy

I“F':'“'“"y"’ﬂ’) Cursor position.
L

NOTE Most template pages include a Topic Body proxy. If the Topic Body proxy is
not included, insert it from the Insert ribbon, Proxy > Body Proxy. This proxy is
required as it is the body content placeholder for each of the topics used in the
output.

bl
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3. From the eLearning ribbon, select eLearning Toolbar Proxy. Alternatively, from the Insert
ribbon, select the Proxy drop-down, and choose eLearning Toolbar Proxy.

elearning
Toolbar Proxy

4. Inthe eLearning Toolbar Proxy dialog, from the Skin File drop-down, you can select a
customized el.earning Toolbar skin component. If you leave the default setting, the first
eLearning Toolbar skin component in the project will be used. Click OK.

The eLearning Toolbar proxy lets you indude a toolbar with
navigation controls for a course. Please see the Help for more
information on how the various buttons can be customized using
a skin file,

Skin File:
Praoject/Skins feLearning e

NOTE If you have not created a skin component to associate with the proxy, you can

always come back to the inserted proxy later and edit it once the skin component is
created.

5. CIicklE' to save your work.

What's Next?

Now that the proxy is in place, you need to select which navigation tools you want to include in your
output. This is done in the eLearning skin component.
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Adding an eLearning Toolbar Skin Component

The eLearning skin component contains information that dictates the general appearance for the
course. You can choose which navigation buttons and controls to use, and customize how they
display in the output.

How to Add the eLearning Toolbar Skin

1. From the Project Organizer, right-click the Skins folder, and select Add Skin.

2. From the Add File dialog, expand Factory Templates, and select HTML5 Component —
eLearning Toolbar. Give it a file name (e.g., eLearning), and click Add.

File Type:

‘Gskm "

Source Description

® New from template: eLesrning Toolbar skin

~ [ Factory Templates ~

tent

e wledge
5§ Micro Content - Promotion
=g WebHelp -Blue

|53 WebHelp - Default

(5% WebHelp - Green

(5 WebHelp - Silver v | |3

(O New from existing:

Skin

Folder:
[(root folder) | [

File Name:
>¢d&ammg |
® Attributes

Condition Tags File Tags
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3. Inthe Skin Editor, from the Setup tab, determine which toolbar buttons you want to display in

your test. By default, the toolbar buttons are: PreviousTopic, NextTopic, and ProgressBar.

You can use the local toolbar to add, delete, and reorder the toolbar buttons.

4. CIicklE' to save your work.

CHAPTER 18

elearning Toolbar Skin Editor

Setup
Styles
Ul Text

Toolbar Buttons

| Available

jg.&%

=

MextTopic

ProgressBar

|1} 4 xln

Custom JavaScript to indude in Toolbar page:

Edit...
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CHAPTER 19

Topic Popups

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

NOTE This feature is supported in HTMLS5 Tripane and skinless output, but not in HTMLS
Side Navigation or Top Navigation output.

A topic popup is a text hyperlink that opens a topic or external file (such as a website) in a popup
box.

This chapter discusses the following:

Inserting TOPIC POPUPRS ... 363
Editing TOPIC POPUPS ... 367
Customizing the Size of Topic POpups ... 375
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I Inserting Topic Popups

Inserting topic popups requires only a few simple steps

How to Insert a Topic Popup

1.
2.

Open the content file.

In the XML Editor, highlight the text that you want to use as the link (or "hotspot") for the topic
popup.
Select Insert > Hyperlink > Topic Popup.

The Insert Topic Popup dialog opens. The Target Frame field at the bottom of the dialog
already has Popup Window selected.

From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based on the option you choose, the section below gives you a list of
selections or additional fields to complete.

FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

=] Shows or hides the folders that the files are stored in.
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Option Description

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx = Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click Il to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select [Tl if you have selected a PDF file. See "Named Destinations" on page
161.

EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [ to display and select any bookmarks within the destination file, or if
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.
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NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click (€] The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).

HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
=] Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is

shown on the left side, and the files and subfolders within it are shown
on the right.
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® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click =]. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

5. (Optional) The Link Text field displays the text that you highlighted in the topic, which will be
used as the hyperlink. Leave the text as it is, unless you decide you would like to change it. If
you want to change the link text, type the new text in the field. It will replace the previous text
in the topic.

6. (Optional) In the Screen Tip field, you can type a phrase that will appear when the end user
hovers over the hyperlink in the output.

7. (Optional) Next to the Style Class or Style ID field click [=1. This opens the Select Class dialog,
which lets you apply a CSS style or a style ID to a link. Generic classes and IDs are also
available for selection in this dialog. You can change the appearance of the link in the
Stylesheet Editor. After you select a style class in the dialog, click OK. If you selected a class,
it appears in the Style Class field, and if you selected an ID, it appears in the Style ID field. (If
you do not specify a style class, Flare Desktop uses the parent "a.Popup” style class.)

8. Inthe Target Frame field, leave Popup Window as the selection.

9. Click OK. The hyperlink for the topic popup is added to the topic. You can change the
appearance of the link by modifying the a.Popup style in the Stylesheet Editor. This includes
the ability to change the size of the popup. See "Editing Topic Popups” on the next page and
"Customizing the Size of Topic Popups" on page 375.

10. CIicklE' to save your work.
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| Editing Topic Popups

You can edit topic popups that you have inserted into a topic in at least three different ways: (1) edit
the destination and properties of the topic popup, (2) edit the style of the topic popup, and (3)
unbind (or remove) the hyperlink from the topic popup.

How to Edit the Destination and Properties of a
Topic Popup

The first way to edit topic popups is to change the destination and other properties (link text, target
frame, screen tip).

ﬁ EXAMPLE You test the topic containing the popup and you notice that the wrong
destination topic is opening when you click the hyperlink. So you use the steps below to
associate the correct destination topic with the hyperlink.

1. Open the content file.
2. Inthe XML Editor, click inside the link.

3. Atthe top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned

on, click in the local toolbar of the XML Editor.

4. Select Edit Hyperlink. The Insert Topic Popup dialog opens.

5. From the Link to drop-down field, select a way to identify the topic, bookmark, or file to which
you want to link. Based the option you choose, the section below gives you a list of selections
or additional fields to complete.

CHAPTER 19 367



FILE IN PROJECT

This option lets you search for a file within your project. After you select this option, use the
area below to navigate to the file that you want to link to and select it. By using the buttons in
the local toolbar, you can view all files in a list, view files in their folder structure, and use
other options.

Option Description

Shows all of the files in the project in a list below. Click the
button again to switch to a folder tree view. You can click the
File, Type, or Path column headers to sort the list alphabetically
by that column data.

Shows or hides the folders that the files are stored in.

[

Shows or hides the files. If you click this button when the Show
Folders button |:| is selected, the area splits into two. The folder

is shown on the left side, and the files and subfolders within it
are shown on the right.

If the Show Files button is the only one selected, you can
click this button to move up one folder level.

wx - Lets you filter the kinds of files shown below. Depending on the
task you are performing, this field may already be populated with
the most appropriate file type(s).

You can also click [l to display and select any bookmark or a location using a particular style
(including classes and IDs). If necessary, a bookmark will be created at that location if one
does not exist. If you want to clear a bookmark in the link, select it and click the button at the
bottom of the dialog. See "Inserting Bookmarks" on page 12.

You can also select if you have selected a PDF file. See "Named Destinations" on page
161.
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EXTERNAL FILE

This option lets you search for a file (e.g., HTM, HTML, XML, PDF, Microsoft Office files)
outside your project. This is especially useful if you want to link from one topic to another in
separate project outputs, such as CHM files. After you select this option, enter the path to the
file in the field next to the External File button.

You can also click [l to display and select any bookmarks within the destination file, or [2&] i
you have selected a PDF file. See "Inserting Bookmarks" on page 12 and "Named
Destinations" on page 161.

For more information see "External Links—HTML, PDF, Microsoft Office" on page 113.

NOTE Because the link usually needs to be relative, based on the final locations of
your output files, it is preferable to enter the text directly into the field, rather than
clicking the External File button.

WEBSITE

This option lets you enter the path to an external file, such as the URL for a website. After you
click this option, simply type the path in the field next to the Website field (e.g.,
http://www.acme.com).

If you want to insert a variable in a field, you can click [Z] The variable will appear as syntax in
the field, but in the output the variable definition will be shown.

You can create links to specific topics in HTML5, WebHelp, or WebHelp Plus output. This
includes the ability to incorporate search strings and skin references (for some outputs).
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HTML HELP FILE

This option lets you search for a topic within an HTML Help (CHM) file that you have added to
your project. After you select this option, click the External File button. In the Link to HTML
Help dialog, you can do one of the following.

® Select Project Files and then use the area below to navigate to the file that you want to
link to and select it. By using the buttons in the local toolbar, you can view all files in a
list, view files in their folder structure, and use other options.

Option Description
[ Shows or hides the folders that the files are stored in.
Shows or hides the files. If you click this button when the Show

Folders button |:| is selected, the area splits into two. The folder is
shown on the left side, and the files and subfolders within it are shown
on the right.

® Select Import Existing. In the dialog that opens, find and double-click the CHM file. Then
from the drop-down—which displays "(root folder)" by default, you can select a specific
content folder in your project to place the CHM file.

After the CHM file is selected, in the Topic field click 1. In the dialog that opens, find and
double-click the topic that you want to link to.

When you are finished, click OK in the Link to HTML Help dialog.

6. (Optional) The Link text field displays the text that you highlighted in the topic, to be used as
the hyperlink. Leave the text as it is, unless you decide to change it. If you want to change the
link text, type the new text in the field.

7. (Optional) In the Screen Tip field, you can type a phrase to appear when the end user hovers
over the hyperlink in the output.

8. (Optional) Next to the Style Class field, click the Select button. This opens the Select Class
dialog, which lets you apply one of the defined hyperlink styles from your stylesheet to the
link. After you select a style class, click OK. (If you do not specify a style class, Flare Desktop
uses the "a.Popup” style class.)

©

In the Target Frame field, leave Popup Window as the selection.
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10. Click OK. The hyperlink for the topic popup is added. By default it has a blue, underlined font.
You can change its appearance by editing the style.

11. CIicklE' to save your work.

CHAPTER 19 371



How to Edit the Style of a Topic Popup Hyperlink

You can edit the style (e.g., font, color) of the hyperlink for a topic popup. When you do this, the style
changes for all topic popups in any topics in your project.

ﬁ EXAMPLE You want to change the font for your topic popups to dark green with no
underline. The following steps show you how to accomplish this.

1. From the Content Explorer, open the stylesheet that you want to modify.

2. Inthelocal toolbar, make sure the first button displays . If the button displays

instead, then click it.
NOTE For steps using the Simplified view, see the Help system.

3. Inthe upper-left corner of the editor, click in the drop-down field and select
| Link Styles -|

4. 0On the left side of the editor, find and select the a.Popup tag.

CHAPTER 19 372



5. From the Show drop-down list on the upper-right side of the editor, select

[Show: Assarted Relevant Properties *| The most relevant properties for that style are shown on the

right side of the editor.

Stylesheet Editor é_hl View: Advan

All Styles -

(Linked Stylesheets)
I (Generic Classes)

I [Generic Pseudo Classes)

We've chosen to display the most |
relevant properties for the style
(Assorted Relevant Properties).

ium ~ Options «

4 Font
(Identifiers)
(Custom Lists) font
I (Variables)
4 3 font-family:
GlossaryPageTerm
MCEreadcru ink font-size:
| (pso Class font-style The most relevant_properljes for
abbr R the a. P_o_pup style |nclud<_e those
scronym forresizing the popup window,
address font-weight: as well as font properties.
area ) )
article line-height
aside text-decoration:
b
big text-transform:

Show: Assorted Relevant Properties ™

—— |

Medium: (default)
aPopup

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. Locate the property you want to change.

8. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button [=] to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

9. CIicklE' to save your work.
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How to Unbind or Remove the Topic Popup
Hyperlink

The third way to edit a topic popup is to unbind (or remove) the hyperlink effect. If you decide that
you no longer want the content to serve as a hyperlink, you can use the steps below to remove the
hyperlink, converting the content to regular text.

1. Open the content file.
2. Inthe XML Editor, click inside the link.

3. Atthe top of the XML Editor, right-click the span bar representing the link. For example,
hyperlink span bars have an "a" label, and cross-reference span bars have a "MadCap:xref"
label. When you click on the link in the topic, the appropriate span bar at the top of the XML
Editor will change color to indicate that it goes with the link. If your span bars are not turned

on, click in the local toolbar of the XML Editor.

4. Select Unbind. The hyperlink effect is removed.

5. Click [l to save your work.
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I Customizing the Size of Topic Popups

If you insert a topic popup link, the popup displays in a default window size in the output (after the
link is clicked). However, you can adjust the style to specify a custom size for the popup box. You
can do this by selecting the a.Popup style class and changing the values for the mc-popup-width

and mc-popup-height properties (located in the Unclassified property group).

How to Customize the Size of Topic Popups

1.

2.

w

o s

6. From the Properties section, click [-] to the right of mc-popup-width or mc-popup-height.

T |

From the Content Explorer, open the stylesheet that you want to modify.

In the local toolbar, make sure the first button displays [ View: Advanced]. |f the button displays
View: Simplified| jnstead, then click it.

In the upper-left corner of the editor, click in the drop-down field and select
| Link Styles

In the Styles section on the left side of the editor, find and select the a.Popup style class.

From the Show drop-down list on the upper-right side of the editor, select
|Show: Assarted Relevant Properties ~| The most relevant properties for that style are shown on the
right side of the editor.

Stylesheet Editor é"‘ WView: Advan

All Styles

-

We've chosen to display the most
relevant properties for the style

(Linked Stylesheets)
(Generic Classes)
(Generic Pseudo Classes)

4 Font

(Identifiers)
(Complex Selectors) wrtpriman)
(Custom Lists) font
(Variables)
a font-family:

GlossaryPageTerm

MCBreadcrugaia! ink font-size:
| [pseudo$ ont-style The most relevant properties for
abbr font-variant: the a.Popup style include those
scronym forresizing the popup window,
accre-ss font-weight: as well as font properties.
area . .
article line-height
aside text-decoration
b
big text-transform:

(Assorted Relevant Properties).

Ilum ~ Options

Show: Assorted Relevant Properties ™
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7. Inthe top-right corner of the popup (next to "Automatic"), click the down arrow and select
Length.

8. Inthe lower-left field, enter a number.
9. Inthe lower-right field, click the down arrow and select a unit of measurement.

10. Inthe popup box, click OK.

11. Click@ to save your work.
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CHAPTER 20

Hotspots and Dynamic Effects

Supported In:

HTML
M3
ECLIPSE [l Fop T WEB
HELP HELP HELP

A hotspot is the part of an element that you click to make it do something (e.g., open another topic,
open a popup, expand text). For some navigation features—such as cross-references and
hyperlinks—the entire element is a hotspot. For dynamic effects—drop-down text, expanding text,
togglers, and popups—only part of the effect is a hotspot. For features such as this, you can use
styles to change the hotspot portion of the element.

Hotspot Styles

MadCap|dropDownHotspot

Modifies the specific text that you select in the first paragraph of a drop-down effect to serve as the
link for opening the drop-down body. If you do not select specific text in the first paragraph to serve
as the hotspot, the entire first paragraph is used as the hotspot.

MadCapl|expandingHead

Modifies the hotspot portion of an expanding text effect.
MadCap|popupHead

Modifies the hotspot portion of a popup text effect.
MadCapltoggler

Modifies the hotspot portion of a toggler.
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CHAPTER 21

Viewing and Fixing Links

In Flare Desktop there are many ways that you can link one file with another, thus creating a
dependency. Link dependencies are created when you perform tasks such as: inserting a text
hyperlink, inserting an image, applying a stylesheet to a topic, and more. The Link Viewer window
pane lets you see what other files a particular file is linked to and from.

Whenever you want to view links to and from a file, you simply need to open the Link Viewer window
pane and give focus to the file in question. Following are two ways to do this:

® Select View > Link Viewer. The Link Viewer window pane opens by default on the right side of
the workspace. Next, open a file (e.g., topic, stylesheet, table of contents). As long as that file
has focus (e.g., click in it), the related links are shown in the Link Viewer window pane.

® |n one of the window panes containing files (e.g., Content Explorer, Project Organizer, File List
window pane), right-click on a file and from the context menu select View Links. If it's not
already open, the Link Viewer window pane opens by default on the right side of the
workspace, showing the related links.

NOTE Whenever you switch focus to another file (i.e., open it and click on it), the links in the
Link Viewer window pane change accordingly.

This chapter discusses the following:

Incoming Links From Other Files ... 380
Outgoing Links to Other Files ... 381
Targets Linked toa File ... 382
Lock Window Pane ... 383
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CHAPTER 21

Go to Previous and Next ... 383
View Broken Links ... 384
Viewing Broken LINKS ... 385
Viewing Broken Bookmarks ... 387
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I Incoming Links From Other Files

This shows links from other files to the active file.

% EXAMPLE You have a topic called "Getting Started" and in another topic you have inserted
a hyperlink to it. Unfortunately, you cannot remember exactly which topic. Furthermore,
you've made changes to the Getting Started topic, so you want to see if any other topics
linking to it also require modifications as a result. Therefore, you open the Link Viewer
window pane. You then open the Getting Started topic. Because that topic is the file
containing focus, the Link Viewer window pane provides a list of all the files with links to it.
Not only can you see a list of files with links to the Getting Started topic, but you can
double-click each file to open it and work on it.

— Link Viewer

2 @
File Information The name of the

€ Getting—!ia'tadhm< "active” file is

Eie Path: shown here.

|ﬁle:H,."C:ﬂJsersfpstoeddeinfDnmmentsﬂdy Pr e
Assodated Targets:
ElHms
'mPDF1
'mPDF2 .

You can double-click
either of these files to
openitinthe
/ appropriate editor.
This area shows that Linked From: __ﬁkﬂu:l IGH
onetopicandone I3 .
Home.htm G Mare-Information.htm
table of contents file T .
S TOC. fito “4 My-Snippet. f
contain links to the file > ; YEnpRELTEE
inquestion ("Getting-
Started htm™).
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I Outgoing Links to Other Files

This shows links to other files from the active file.

other files linked from it.

Link Viewer

2 &

ﬁ EXAMPLE You have a topic called "Getting Started,” which contains a snippet, which you
want to edit. One way to edit the snippet file is to go look for it in the Content Explorer and
double-click it. That method can take a lot of time if you have hundreds of snippets.
Another method is to right-click on the snippet within the topic and select Open Snippet
File. But another quick method is to use the Link Viewer window pane, which not only lets
you open the snippet quickly, but also see the file name of the snippet and other linked files
at a glance. Therefore, you open the Link Viewer window pane. You then open the Getting
Started topic. Because that topic is the file containing focus (i.e., it's the most recent file
you've opened or clicked in), the Link Viewer window pane provides you with a list of all the

File Information

¢ Getting—ﬂatedjim<

File Path:

|ﬁIE:H,|"C:Msersfpstoeddeinm::mmentsﬂﬂy Pr yeeeprererey

The name of the

"active" fileis
shown here.

Assodated Targets:

ElHmLs
‘HPDF1

This area shows that
thefilein question Ny

("Getting-Started_htm")
containslinks to another A;

topic and a snippet. Linked To:
G Mare-Information.htm —
IUL..HE! 4 My-Snippet. flsnp ":'-...__

You can double-click
either of these files to
openitinthe
approprate editor.
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| Targets Linked to a File

You can see which targets are associated with the file that has focus. This is useful, for example,
because it lets you know which outputs will be affected when you make changes to that file. The
link to the target might be direct (e.g., the active file is a topic that is included in the table of
contents for a target) or indirect (e.g., the active file is a snippet that has been inserted into a topic
that is included in the table of contents for a target).

% EXAMPLE You have a topic called "Getting Started" and you need to make many changes
to it. After you are finished making your changes, you need to make sure your work looks
correct in each output. Unfortunately, you cannot remember which of your outputs (i.e,,
targets) includes that topic. Therefore, you open the Link Viewer window pane. You then
open the Getting Started topic. Because that topic is the file containing focus (i.e., it's the
most recent file you've opened or clicked in), the Link Viewer window pane provides you
with a list of all the targets that will include the topic when output is generated. You can
then keep the Link Viewer open as a reference while you generate and view each of those

targets.
= Link Viewer
2 @
File Information The name of the
¢ Gauing-:aartedun< "active” fileis
Fie Path: shown here.
|ﬁle:,IHC:ﬂJsersfpstoeddeinfDommentst Prcmﬂ,—l—
This area shows that the Associated Targets:

You can double-click

filein question ("Getting-
Started htm") will be ;}- %;;*;5 < any of h‘]ese_ﬁles to
included in three different WPDE2 open Ih_em in t_he
outputs (i.e., targets). appropriate editor.
Linked From: Linked To:
G. Home. him 'E More-Information. htm
% ToC. fitoc hel My-Snippet. flsnp
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I Lock Window Pane

Normally when you click in a different file, giving it focus, the links for that file are shown in the Link
Viewer window pane. However, there may be times when you want a previous set of links to
continue to show in the Link Viewer, even when you click in other files. In that case, you can lock the
Link Viewer by clicking the Lock button |=] in the local toolbar. To unlock the window pane, click the
button again.

| Refresh

You can click[®]in the local toolbar to refresh the Link Viewer window pane at any time. This
ensures you are seeing the most up-to-date links for the active file.

¢ EXAMPLE You are using the Link Viewer window pane to see the links for a topic. While
doing this, suppose you decide to delete one of the targets in your project, and that target is
linked to the topic file. After the file is deleted, it still is shown in the Link Viewer window
pane. But if you click the Refresh button, the window pane no longer shows that file link.

I Go to Previous and Next

If you have been viewing links for multiple files, the Link Viewer window pane remembers those files

and their links. You can click the Previous or Next buttons in the local toolbar to see file links
that you have already viewed.
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I View Broken Links

If the active file contains broken links, this will be indicated by a broken link icon in the Link Viewer

window pane.

ﬁ EXAMPLE The active file contains a hyperlink to another file, but the link is broken. In that
case, you will see something like this in the Link Viewer window pane:

— Link Viewer » 0 x

2 @
File Information
€ Getting-Started him

File Path:
|ﬁIE:HIC:ﬂJsersfpstoeddeinfDummentsﬂﬂy Prnjectsﬂ'ﬂutl

Associated Targets:
ElHms
'mPDF1
'mPDF2
Linked From: Linked To:
E Home, him G Mare-Information.htm
7| TOC. fitoc fﬁpmcedurel.hh‘n
T My-Snippet. flsnp

Thisiconindicates a
broken outgoing link.
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| Viewing Broken Links

You can view a list of files in your project where a broken link is located, including which file it is
trying to find, the link text, the link tag, and other information. Also, you can open the file where the
broken link is located. The broken link is highlighted so that you can easily fix it.

How to View and Fix Broken Links

1. From the Analysis ribbon, click the Summary button.

File Home  Insert  View
PES 5 2| R
J e In ¥ =
Summary Links Suggestions Undefined Used Mare File
@ o ltems *  ltems » Reports~  lssues
Dynamic Reports Analysis

If you see a row indicating broken links in red, double-click it.
In the grid listing all broken links, double-click one.

In the file that opens, the broken link is highlighted.

a N

Edit the broken link or remove it.

6. Click@ to save your work.
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How to Fix Links Directly in the Broken Links
Window Pane

1. Inthe Broken Links window pane, click the row that you want to correct, then CIick. The Fix
Broken Links dialog opens.

2. Inthe Fix Broken Links dialog, do one of the following.

u Click or right-click a file and from the context menu, select Select file for linking. This
option opens a dialog, from which you can select a new link.

= Click 5@l or right-click a file and from the context menu, select Scan for Potential Links.
This option scans the project for potential matches to the broken link. When this option
is selected, the Search for Similar Files dialog opens, which lists the similar files that
the analysis tool has found. You can then select a file from that list.

The name of the file you select to fix the broken link will be displayed in the File field at the
bottom of the Fix Broken Links dialog.

3. Click Apply.
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I Viewing Broken Bookmarks

You can view a list of files with broken bookmarks, including the bookmark destination that the link
is trying to find, the link text, the link tag, and other information. Also, you can open the file where
the broken link is located so that you can fix it.

How to View and Fix Broken Bookmarks

1. Open a content file (e.g., topic).
2. Select Analysis > Links > Broken Bookmarks.

The Broken Bookmarks window pane opens. The area at the bottom of the window pane
displays all files that contain bookmark links to the open file that are broken.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

® File Displays the name of the file where the broken link occurs.

® Folder Displays the folder where the file is found.

® | ink Displays the link that is broken (e.g., the path and name of the topic in question).
® Type Displays the type of broken link (e.g., missing file).

® Link Text Displays the text in the source topic that is being used as the link.

® Link Tag Displays the style used for the link. For example, if a regular text hyperlink is

(]

used, you will see "a" in this column.
® Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or
dialog. For example, if the link appears in a topic, the XML Editor opens with the broken link
highlighted.

6. Redirect the link as necessary (e.g., right-click on the link and select Edit Hyperlink or Edit
Cross-Reference).

CHAPTER 21 387



CHAPTER 22

Link Features Per Output Type

Following are link features supported in each output type.

Clean Eclipse HTML
HTML5  PDF Word  XHTML  Help EPUB  Help PPTX

Cross- v vy v v v v v v
References
Supported

Cross- X v v X X v X v
References

(Context-

Sensitive)

Drop-Down v p 4 X X v X v v
Text

Expanding v p 4 X X v X v v
Text

Text v v v/ v/ v v v/ v
Hyperlinks
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Clean Eclipse HTML
HTMLS  PDF Word XHTML  Help EPUB Help PPTX

Text v H X X v X v X
Popups

Togglers v p 4 X X v X v v
Topic v X X X v X v X
Popups

Topic v p 4 X X p 4 p 4 v 4 p 4
Toolbars

Web V1 H X X X X v X
Toolbars

1This is available in the Tripane output only. It is not available in Side or Top
Navigation outputs.

CHAPTER 22

389



APPENDIX

PDFs

The following PDFs are available for download from the Help system.

| Tutorials

Autonumbers Tutorial
Back-to-Top Button Tutorial
Context-Sensitive Help Tutorial
Custom Toolbar Tutorial
eLearning Tutorial—Basic
elLearning Tutorial—Advanced
Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

APPENDIX

Micro Content Tutorial—Basic
Micro Content Tutorial—Advanced
Responsive Output Tutorial
Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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| Cheat Sheets

Context-Sensitive Help Cheat Sheet
Folders and Files Cheat Sheet
Learning & Development Cheat Sheet
Lists Cheat Sheet

Micro Content Cheat Sheet
Print-Based Output Cheat Sheet
Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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| User Guides

Accessibility Guide

Analysis and Reports Guide
Architecture Guide
Autonumbers Guide
Branding Guide

Condition Tags Guide
Context-Sensitive Help Guide
Eclipse Help Guide
elLearning Guide

Flare Online Integration
Guide

Getting Started Guide
Global Project Linking Guide
HTMLS5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

APPENDIX

Meta Tags Guide

Micro Content Guide
Navigation Links Guide
Plug-In API Guide
Print-Based Output Guide
Project Creation Guide
QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide
Targets Guide

Template Pages Guide
Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide
Videos Guide

What's New Guide
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